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NOTE
For your own safety, observe the warnings and safety instructions contained in this document, if available.

Disclaimer of Liability
This document has been subjected to rigorous technical
review before being published. It is revised at regular intervals, and any modifications and amendments are included
in the subsequent issues. The content of this document has
been compiled for information purposes only. Although
Siemens AG has made best efforts to keep the document as
precise and up-to-date as possible, Siemens AG shall not
assume any liability for defects and damage which result
through use of the information contained herein.
This content does not form part of a contract or of business
relations; nor does it change these. All obligations of
Siemens AG are stated in the relevant contractual agreements.
Siemens AG reserves the right to revise this document from
time to time.
Document version: C53000-G5040-C003-7.00
Edition: 06.2016
Version of the product described: V7.30 and higher

Copyright
Copyright © Siemens AG 2016. All rights reserved.
The disclosure, duplication, distribution and editing of this
document, or utilization and communication of the content
are not permitted, unless authorized in writing. All rights,
including rights created by patent grant or registration of a
utility model or a design, are reserved.
Registered Trademarks
SIPROTEC®, DIGSI®, SIGUARD®, SIMEAS®, and SICAM® are
registered trademarks of Siemens AG. Any unauthorized
use is illegal. All other designations in this document can
be trademarks whose use by third parties for their own
purposes can infringe the rights of the owner.
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Purpose of the Manual
This manual describes the operation of the device and gives information about safety, commissioning and
operation as well as checks and tests.
Target Audience
Protection system engineers, commissioning engineers, persons entrusted with the setting, testing and maintenance of automation, selective protection and control equipment, and operational crew in electrical installations and power plants.
Scope
This manual applies to the SIPROTEC 5 device family.
Further Documentation

[dwprefom-221012-01.tif, 3, en_US]

•

Device manuals
Each Device manual describes the functions and applications of a specific SIPROTEC 5 device. The printed
manual and the online help for the device have the same informational structure.

•

Hardware manual
The Hardware manual describes the hardware building blocks and device combinations of the SIPROTEC 5
device family.

•

Operating manual
The Operating manual describes the basic principles and procedures for operating and assembling the
devices of the SIPROTEC 5 range.
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•

Communication protocol manual
The Communication protocol manual contains a description of the protocols for communication within
the SIPROTEC 5 device family and to higher-level network control centers.

•

Product information
The Product information includes general information about device installation, technical data, limiting
values for input and output modules, and conditions when preparing for operation. This document is
provided with each SIPROTEC 5 device.

•

Engineering Guide
The Engineering Guide describes the essential steps when engineering with DIGSI 5. In addition, the Engineering Guide shows you how to load a planned configuration to a SIPROTEC 5 device and update the
functionality of the SIPROTEC 5 device.

•

DIGSI 5 online help
The DIGSI 5 online help contains a help package for DIGSI 5 and CFC.
The help package for DIGSI 5 includes a description of the basic operation of software, the DIGSI principles and editors. The help package for CFC includes an introduction to CFC programming, basic examples
of working with CFC, and a reference chapter with all the CFC blocks available for the SIPROTEC 5 range.

•

SIPROTEC 5/DIGSI 5 Tutorial
The tutorial on the DVD contains brief information about important product features, more detailed information about the individual technical areas, as well as operating sequences with tasks based on practical
operation and a brief explanation.

•

SIPROTEC 5 catalog
The SIPROTEC 5 catalog describes the system features and the devices of SIPROTEC 5.

•

Selection guide for SIPROTEC and Reyrolle
The selection guide offers an overview of the device series of the Siemens protection devices, and a
device selection table.

Indication of Conformity
This product complies with the directive of the Council of the European Communities
on harmonization of the laws of the Member States relating to electromagnetic
compatibility (EMC Council Directive 2014/30/EU) and concerning electrical equipment
for use within specified voltage limits (Low Voltage Directive 2014/35/EU).
This conformity has been proved by tests performed according to the Council Directive
in accordance with the product standard EN 60255-26 (for EMC directive) and with the
product standard EN 60255-27 (for Low Voltage Directive) by Siemens AG.
The device is designed and manufactured for application in an industrial environment.
The product conforms with the international standards of IEC 60255 and the German
standard VDE 0435.
Other Standards
IEEE Std C 37.90
The technical data of the product is approved in accordance with UL.
For more information about the UL database, see www.ul.com
Select Online Certifications Directory and enter E194016 as UL File Number.
IND. CONT. EQ.
69CA

[ul_listed_c_us, 1, --_--]
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Additional Support
For questions about the system, please contact your Siemens sales partner.
Support
Our Customer Support Center provides a 24-hour service.
Phone:
Fax:
E-Mail:

+49 (180) 524-7000
+49 (180) 524-2471
support.energy@siemens.com

Training Courses
Inquiries regarding individual training courses should be addressed to our Training Center:
Siemens AG
Siemens Power Academy TD
Humboldtstraße 59
90459 Nürnberg
Germany
Phone:
Fax:
E-Mail:
Internet:

+49 (911) 433-7415
+49 (911) 433-7929
poweracademy@siemens.com
www.siemens.com/poweracademy

Notes on Safety
This document is not a complete index of all safety measures required for operation of the equipment (module
or device). However, it comprises important information that must be followed for personal safety, as well as
to avoid material damage. Information is highlighted and illustrated as follows according to the degree of
danger:

!

DANGER
DANGER means that death or severe injury will result if the measures specified are not taken.
²

!

Comply with all instructions, in order to avoid death or severe injuries.

WARNING
WARNING means that death or severe injury may result if the measures specified are not taken.
²

!

Comply with all instructions, in order to avoid death or severe injuries.

CAUTION
CAUTION means that medium-severe or slight injuries can occur if the specified measures are not taken.
²

Comply with all instructions, in order to avoid moderate or minor injuries.
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NOTICE
NOTICE means that property damage can result if the measures specified are not taken.
²

i

Comply with all instructions, in order to avoid property damage.

NOTE
Important information about the product, product handling or a certain section of the documentation
which must be given particular attention.

Qualified Electrical Engineering Personnel
Only qualified electrical engineering personnel may commission and operate the equipment (module, device)
described in this document. Qualified electrical engineering personnel in the sense of this manual are people
who can demonstrate technical qualifications as electrical technicians. These persons may commission,
isolate, ground and label devices, systems and circuits according to the standards of safety engineering.
Proper Use
The equipment (device, module) may be used only for such applications as set out in the catalogs and the
technical description, and only in combination with third-party equipment recommended and approved by
Siemens.
Problem-free and safe operation of the product depends on the following:
• Proper transport

•
•

Proper storage, setup and installation
Proper operation and maintenance

When electrical equipment is operated, hazardous voltages are inevitably present in certain parts. If proper
action is not taken, death, severe injury or property damage can result:
• The equipment must be grounded at the grounding terminal before any connections are made.

6

•
•

All circuit components connected to the power supply may be subject to dangerous voltage.

•

Operation of equipment with exposed current-transformer circuits is prohibited. Before disconnecting the
equipment, ensure that the current-transformer circuits are short-circuited.

•

The limiting values stated in the document must not be exceeded. This must also be considered during
testing and commissioning.

Hazardous voltages may be present in equipment even after the supply voltage has been disconnected
(capacitors can still be charged).
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Open Source Software
The product contains, among other things, Open Source Software developed by third parties. The Open
Source Software used in the product and the license agreements concerning this software can be found in the
Readme_OSS. These Open Source Software files are protected by copyright. Your compliance with those
license conditions will entitle you to use the Open Source Software as foreseen in the relevant license. In the
event of conflicts between Siemens license conditions and the Open Source Software license conditions, the
Open Source Software conditions shall prevail with respect to the Open Source Software portions of the software. The Open Source Software is licensed royalty-free. Insofar as the applicable Open Source Software
License Conditions provide for it you can order the source code of the Open Source Software from your
Siemens sales contact - against payment of the shipping and handling charges - for a period of at least 3 years
since purchase of the Product. We are liable for the Product including the Open Source Software contained in
it pursuant to the license conditions applicable to the Product. Any liability for the Open Source Software
beyond the program flow intended for the Product is explicitly excluded. Furthermore any liability for defects
resulting from modifications to the Open Source Software by you or third parties is excluded. We do not
provide any technical support for the Product if it has been modified.
When using DIGSI 5 in online mode, you are provided with the option to go to the main menu Show Open
source information and read and display the Readme_OSS file containing the original license text and copyright information.
To do this, the following steps are necessary:
• Switch to online mode.

•
•
•

i

Select the device.
Select online in the menu bar.
Click Show Open source information.

NOTE
To read the Readme_OSS file, a PDF viewer must be installed on the computer.
In order to operate SIPROTEC 5 devices, a valid DIGSI 5 license is required.
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First Steps
1.1 Unpacking, Repacking and Storing

1.1

Unpacking, Repacking and Storing

Unpacking a Device

i

NOTE
Devices are tested prior to delivery. The test certificate is a component of the devices and can be called up
with DIGSI.
Devices are packed on site in a way that meets the requirements of standard ISO 2248.
²

Check the packing for external transport damage. Damaged packing may indicate that the devices inside
have also sustained damage.

²

Unpack devices carefully; do not use force.

²

Visually check the devices to ensure they are in perfect mechanical condition.

²

Check the enclosed accessories against the delivery note to make sure everything is complete.

²

Keep the packing in case the devices must be stored or transported elsewhere.

²

Return damaged devices to the manufacturer, stating the defect. Use the original packaging or transport
packaging that meets the requirements of standard ISO 2248.

Repacking a Device
²

If you store devices after incoming inspection, they must be packed in appropriate storage packaging.

²

If devices are to be transported, pack them in transport packing.

²

Put the accessories supplied and the test certificate in the packing with the device.

Storing a Device

16

²

Only store devices on which you have carried out an incoming inspection, thus ensuring that the
warranty remains valid. The incoming inspection is described in the Operating manual.

²

SIPROTEC devices must be stored in rooms, which are clean and dry. Devices or associated replacement
modules must be stored at a temperature of -25 °C to +55 °C.

²

The relative humidity must be at a level where condensate and ice are prevented from forming.

²

Siemens recommends that you observe a restricted storage temperature range of +10°C to +35°C, in
order to prevent the electrolytic capacitors used in the power supply from aging prematurely.

²

If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2 days.
This will cause the electrolytic capacitors to form on the printed circuit-board assemblies again.

²

If devices are to be shipped elsewhere, you can reuse the transport packaging. When using different
packaging, you must ensure that the transport requirements according to ISO 2248 are met. Storage
packing of the individual devices is not adequate for transport purposes.

²

The lithium batteries contained in SIPROTEC devices meet all international requirements of the hazardous
goods specifications for the various carriers (Special Provision 188 of the UN Recommendations on the
Transport of Dangerous Goods, Special Provision A45 of the IATA Dangerous Goods Regulations, and the
ICAO Technical Instructions). This only applies to the original battery or genuine replacement batteries.
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Battery Disposal

NOTICE
Battery disposal
²

Batteries can only be replaced by ones of the same type or by batteries of another type recommended
by the manufacturer. Replacing with the wrong type can cause an explosion hazard. Comply with the
relevant national/international regulations when disposing of batteries.

²

The lithium battery contained in the device can only be replaced by skilled personnel.

²

Only replace the battery with VARTA or Panasonic CR 2032 or BR 2032 batteries. If you use a different
type of battery, this can cause a fire or explosion hazard. Observe the safety notes in the manual.

²

Caution: The battery used in the device can cause fire or chemical burns if handled improperly. Do not
recharge it, take it apart, or subject it to a temperature in excess of 100 °C.

²

Replace dead batteries immediately and keep them out of reach of children.
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1.2 Incoming Inspection

1.2

Incoming Inspection
Siemens recommends that you check devices which are not assembled.

Safety Notes

!

DANGER
Danger during incoming inspection
Noncompliance with the safety notes, can result in death, severe injury or considerable material
damage.
²

Comply with all given safety notes when carrying out the incoming inspection.

²

Please note that hazardous voltages are present when you perform the incoming inspection.

²

If you identify a defect during the incoming inspection, do not rectify it yourself. Repack the device and
return it to the manufacturer, stating the defect. Use the original packaging or transport packaging that
meets the requirements of standard ISO 2248.

Performing a Follow-Up Inspection on a Device
²

Visually check for external damage as soon as you have unpacked the devices; they must not show any
signs of dents or cracks.

Checking the Rated Data and Functions

18

²

Check the rated data and functions using the complete order designation/the product code. The device
manual contains all technical data and a description of the functions.

²

Check the information provided on the rating plate too. The device features a product label sticker, which
contains the Technical data.

²

Make sure that the rated data of the device properly matches the power-system data. You can find the
necessary information in the device manual.
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1.3

Electrical Inspection

Device Protection

!

DANGER
Danger when connecting the SIPROTEC 5 device
Noncompliance with the safety notes will result in death, severe injury or considerable material
damage.
²

The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This prevents condensate from forming in the device.

²

If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2
days. This will cause the electrolytic capacitors on the printed circuit-board assemblies to form again.

²

Perform the electrical inspection.

Activating the Battery

i

NOTE
The battery is covered by a protective film, which also prevents premature discharge.
The battery compartment is located on the rear of the base module. You do not have to take the battery
out of the compartment in order to remove the protective film.
²

Pull out the battery compartment including the battery.

²

Remove the protective film from the battery by simply pulling on the film tab.

²

Push the battery compartment including the battery back in again.

Grounding a Device
The SIPROTEC 5 devices are protection class I equipment must be connected with the system ground prior to
commissioning
²

Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (≥ 0.16 in2),
grounding area ≥ M4).

Connecting a Device
²

Connect all cables and lines. Use the connection diagrams in the Hardware and Device manuals.

²

Tighten the terminal screws to the prescribed torques.

Grounding an On-Site Operation Panel
²

Join several on-site operation panels to one another with firm contact.
Siemens recommends the use of contact washers on painted metal assembly walls. If the mounting wall
is not metallic, place a metal layer, for example a metal sheet between the mounting wall and the on-site
operation panels. Then connect this sheet to system ground.
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First Steps
1.3 Electrical Inspection

Safety Notes

!

DANGER
Danger during electrical inspection
Noncompliance with the safety notes will result in death, severe injury or considerable material
damage.
²

Comply with all given safety notes when carrying out the electrical inspection.

²

Please note that hazardous voltages are present when you perform the electrical inspection.

²

During the electrical inspection, check that the device becomes ready for operation once it has been
connected to the power supply.

Performing the Electrical Inspection

20

²

Connect the power supply.

²

Activate the power supply.
After (initial) activation, there is no Device Configuration File (CFG) in the device and the device is in fallback mode. The green and red LEDs light up in fallback mode.

²

Once you have loaded the CFG file into the SIPROTEC 5 device, the green RUN LED lights up continuously
and the device is ready for operation.

²

If the device does not assume the normal operating state (process mode), switch off the power supply.
Disconnect the wiring and the grounding.

²

Pack this device and return it to the manufacturer, stating the defect. Use transport packaging that meets
the requirements of standard ISO 2248.
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Flush-Mounting Devices
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2.2

Surface-Mounting Devices with Integrated On-Site Operation Panel
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2.3

Surface-Mounting Devices with Detached On-Site Operation Panel

28

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

21

Expanding Devices
2.1 Flush-Mounting Devices

2.1

Flush-Mounting Devices

2.1.1

Basic Rules for Expansion

i

NOTE
Prepare the following tools for the device expansion:
• Phillips screwdriver size PZ1 and PZ2

•
•

Screwdriver DIN 4 x 0.8
During assembly, use the prescribed torques

Comply with the following basic rules when extending devices:
² Always fit the base module on the left in the 1st device row.
²

Always fit the expansion modules from left to right.

²

Always fit the expansion module with the key switches as the 1st module next to the base module.

²

Always fit the expansion modules without LEDs last.

²

Always install a power-supply module PS203 on the left as the first unit in the 2nd device row.

²

Please note that the PS203 must always have the same rated voltage as the base module.

²

Install only I/O modules without LEDs in the 2nd device row.

[dweinzei-030211-01.tif, 1, --_--]

Figure 2-1
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Device Row of a Flush-Mounting Device
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Expanding Devices
2.1 Flush-Mounting Devices

2.1.2

Expanding 1st Device Row

Preparation

i

NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the corresponding extension in the Hardware and Protocols Editor.
Carry out the steps described in this chapter if you wish to expand an installed device later on with expansion modules.
²

Shut down the device.

²

Use the screwdriver to carefully bend the left and right spring clips on the rear plate terminals outwards.

²

Completely detach the wired current and voltage terminal blocks from the device.

²

Remove all communication lines.

²

Remove the plastic screw covers.

²

Remove the device.

²

Expand the cut-out in the control cabinet.

²

Then continue with assembly.

Assembling Devices
²

Remove the bus cover from the extreme right-hand module of the device to be extended.

²

Remove the plastic screw covers from the expansion module.

²

Remove the right sealing strips from the base device.

²

Place the expansion module on the right next to the device. Insert the 2 hinged angle clips of the expansion module in the cut-outs of the device.

²

Slip ring the expansion module in the direction of the device so that the bottom snap-in spring engages.

²

Bolt the 2 on-site operation panels of the module to one another through the contact tab.

²

Check that the bus connection is screwed on at the extreme right of the expansion module.

Installation and Commissioning
²

Reinstall the device.

²

Reinstall the plastic screw covers.

²

Refasten the terminal blocks and the necessary communication lines.

²

Connect the current and voltage blocks of the expansion module.

²

Connect any available plug-in modules.

²

Use the supplied grounding cable to connect the expansion module with the device and reconnect the
device to service ground.

²

Extend the device configuration in DIGSI and load this configuration to the device.

²

Resume operation of the device.
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Expanding Devices
2.2 Surface-Mounting Devices with Integrated On-Site Operation Panel

2.2

Surface-Mounting Devices with Integrated On-Site Operation
Panel

2.2.1

Basic Rules for Expansion

i

NOTE
Prepare the following tools for the device expansion:
Phillips screwdriver size PZ1 and PZ2

•
•
•

Screwdriver DIN 4 x 0.8
During assembly, use the prescribed torques

Comply with the following basic rules when extending devices:
• Always fit the base module on the right in the 1st device row.

•
•
•
•
•
•
•
•
•

i
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Always fit the expansion modules from right to left.
Always fit the on-site operation panel of the base module on the left.
Always fit the on-site operation panels of the expansion modules from left to right.
Always fit the on-site operation panel of the expansion module with the key switches in the 1st place
next to the on-site operation panel of the base module.
Always fit the on-site operation panels without LEDs last.
Join the on-site operation panels to one another with 2 mounting brackets.
Always install a power-supply module PS203 on the right as the first unit in the 2nd device row.
Please note that the PS203 must always have the same rated voltage as the base module.
In the 2nd device row, you do not need any on-site operation panels, mounting brackets, or distance
frames.

NOTE
When expanding a device in the 1st device row, order 2 mounting brackets that match the width of the
expanded device.
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Expanding Devices
2.2 Surface-Mounting Devices with Integrated On-Site Operation Panel

[dwauize1-040211-01.tif, 1, --_--]

Figure 2-2
(1)
(2)
(3)

2.2.2

Device Row
Distance frame
Mounting bracket
Distance frame on base module rotated by 180o

Expanding 1st Device Row

Preparation

i

i

NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the corresponding extension in the Hardware and Protocols Editor.
Carry out the steps described in this chapter if you wish to expand an installed device later on with expansion modules.
²

Shut down the device.

²

Detach all on-site operation panels from the distance frames.

²

Remove the mounting brackets.

NOTE
If the device is an expanded device, then detach the 2 mounting brackets. You must replace these
mounting brackets with 2 new mounting brackets that match the width of the device.
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Expanding Devices
2.2 Surface-Mounting Devices with Integrated On-Site Operation Panel

²

Use a screwdriver to carefully bend the left and right spring clips on the terminals outwards.

²

Completely detach the wired current and voltage terminal blocks from the device.

²

Remove all communication lines.

²

Remove the device completely.

Assembling the On-Site Operation Panel Into One Block

[dwaublo1-040211-01.tif, 1, --_--]

Figure 2-3

On-Site Operation Panel Fitted on Mounting Bracket

²

Place the 2 mounting brackets intended for expansion in parallel to one another on a flat surface.

²

Bolt the 1st (left-hand) on-site operation panel to the 2 mounting brackets. Do not firmly tighten the
screws.

²

Place the 2nd on-site operation panel on the right of the 1st one and bolt these panels onto the 2
mounting brackets. Do not firmly tighten the screws. Make sure that the snap-in spring is engaged!

²

Bolt the 2 operation panels to one another through the contact tab. Do not firmly tighten the screws.

²

Repeat the last 2 steps for the remaining operation panels. Leave all screws loose.

Assembling Devices
²

Remove the distance frame from the expansion module.

²

Remove the bus cover from the extreme left-hand module.

²

Remove the plastic screw covers from the extreme left-hand module and from the expansion module.

²

Place the expansion module on the left next to the device. Insert the 2 hinged angle clips of the expansion module in the cut-outs of the device.

²

Swivel the expansion module in the direction of the device so that the bottom snap-in spring engages.

²

Bolt the contact tab to the 2 modules.

Installation and Commissioning
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²

Install the distance frame intended for expansion.

²

Wire and, if required, fasten the current and voltage terminal blocks.
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Expanding Devices
2.2 Surface-Mounting Devices with Integrated On-Site Operation Panel

²

Fit the device back onto the wall without fastened on-site operation panels.

²

Use the supplied grounding cable to connect the expansion module with the device and reconnect the
device to service ground.

²

Fasten the connecting cable for the on-site operation panel on the extreme left-hand operation panel of
those on-site operation panels assembled beforehand into a block.

²

Place the block of assembled operation panels on the distance frames of the device. In doing so, guide
the connecting cable for the on-site operation panel through the cut-outs of the distance frame to the
terminal of the basic module.

²

Fasten the connecting cable for the on-site operation panel to the basic module.

²

Bolt the operation panels to the distance frames and firmly tighten the screws.

²

Tighten all loose screws on the contact tabs and on the mounting brackets.

²

Reinstall all plastic screw covers.

²

Extend the device configuration in DIGSI and load this configuration to the device.

²

Resume operation of the device.
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Expanding Devices
2.3 Surface-Mounting Devices with Detached On-Site Operation Panel

2.3

Surface-Mounting Devices with Detached On-Site Operation Panel

2.3.1

Basic Rules for Expansion

i

NOTE
Prepare the following tools for the device expansion:
• Phillips screwdriver size PZ1 and PZ2

•
•

Screwdriver DIN 4 x 0.8
During assembly, use the prescribed torques

Comply with the following basic rules when extending devices:
• Always fit the base module on the right in the 1st device row.

•
•
•
•
•
•

Always fit the expansion modules from right to left.
Always fit the on-site operation panel of the base module on the left.
Always fit the on-site operation panels of the expansion modules from left to right.
Always install a power-supply module PS203 on the right as the first unit in the 2nd device row.
Note that the PS203 must always have the same rated voltage as the base module.
The distance between the device and the on-site operation panel is limited to not more than 5 m
(196.85 in) by the length of the connecting cable.

[dwauizei-040211-01.tif, 1, --_--]

Figure 2-4
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Device Row
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Expanding Devices
2.3 Surface-Mounting Devices with Detached On-Site Operation Panel

[dwabosop-040211-01.vsd, 1, en_US]

Figure 2-5

2.3.2

Detached On-Site Operation Panel

Expanding 1st Device Row

Preparation

i

i

NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the corresponding extension in the Hardware and Protocols Editor.
Carry out the steps described in this chapter if you wish to expand an installed device later on with expansion modules.
²

Shut down the device.

²

Use a screwdriver to carefully bend the left and right spring clips outwards.

²

Completely detach the wired current and voltage terminal blocks from the device.

²

Remove all communication lines.

²

If you want to expand the device, then detach it completely.

²

If you want to expand the on-site operation panel, then remove the on-site operation panel from the
installation space.

NOTE
The device and the on-site operation panel can be expand independently of one another. Therefore, you
need only detach those components that are to be expanded.

Installing the Devices (with View to the Installation Plane)
²

Remove the bus cover from the extreme left-hand module of the device to be expanded.

²

Remove the plastic screw covers from the extreme right-hand module and from the expansion module.

²

Place the expansion module on the left next to the device. Insert the 2 hinged angle clips of the expansion module in the cut-out of the device.

²

Swivel the expansion module in the direction of the device so that the bottom snap-in spring engages.
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Expanding Devices
2.3 Surface-Mounting Devices with Detached On-Site Operation Panel

²

Bolt the on-site operation panels of the 2 modules to one another through the contact tab.

²

Check that the bus connection is screwed on at the extreme left of the expansion module.

Assembly and Commissioning

30

²

Reinstall the plastic screw covers.

²

Use the supplied grounding cable to connect the expansion module with the device and reconnect the
device to service ground.

²

Fit the device back onto the wall.

²

Expand the on-site operation panel with the on-site operation panel of the expansion modules. Make
sure that the bus connection is plugged in reliably and that the snap-in springs have engaged.

²

Bolt the on-site operation panels to one another through the contact tab.

²

Check that the bus connection on the expansion module on the extreme right is covered.

²

Connect all communication lines again.

²

Extend the device configuration in DIGSI and load this configuration to the device.

²

Resume operation of the device.
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3.2

Surface-Mounting Devices with Integrated On-Site Operation Panel
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3.3

Surface-Mounting Devices with Detached On-Site Operation Panel
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Fitting the Devices
3.1 Flush-Mounting Devices

3.1

Flush-Mounting Devices

3.1.1

Assembly Dimensions

[dweinboh-060812-01.tif, 2, en_US]

Figure 3-1

Cut-Out Widths and Drilling Pattern

Table 3-1

Cut-Out Widths
Width of the Assembly Opening in
mm (in Inches)

1/3 device (base module)

146+2 mm (5.75+0.08)

1/2 device (base module with one expansion module)

221+2 mm (8.7+0.08)

2/3 device (base module with 2 expansion modules)

296+2 mm(11.65+0.08)

5/6 device (base module with 3 expansion modules)

371+2 mm (14.61+0.08)

1/1 device (base module with 4 expansion modules)

446+2 mm (17.56+0.08)

Table 3-2

Variable Housing Widths
Dimension a
Housing widths in mm (in Inches)

32

1/3 device

145 (5.71)

1/2 device

220 (8.66)

2/3 device

295 (11.61)

5/6 device

370 (14.57)

1/1 device

445 (17.52)
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Fitting the Devices
3.1 Flush-Mounting Devices

[dweinbpr-070211-01.tif, 1, en_US]

Figure 3-2

Flush-Mounting Devices, Dimensions from the Side and Front Views

Refer to Table 3-2 for the variable dimension a.

3.1.2

Fitting Devices

Preparations

i

NOTE

i

NOTE

!

The installation depth for 1 device is at least 275 mm (11.83 in). This dimension includes the necessary
bending radius for the various connectors of the plug-in modules.
The M4 holes are the holes for the fastening screws of the device. The Ø 6 holes are the openings for the
fastening screws of the on-site operation panels on the device.

Use a PZ2-size Phillips screwdriver.
For each module, you need 4 fastening screws with a shank diameter of 4 mm (0.16 in).

WARNING
Danger due to device being improperly screw-fastened
Incomplete and careless screw-fastening can lead to death, severe injury, and considerable material
damage.
²

²

Ensure that screw-fastening is complete at all intended bolting points. Tighten the screws to a torque
of 1.2 Nm.
If no assembly opening is prepared, then cut out the required assembly opening.
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Fitting the Devices
3.1 Flush-Mounting Devices

²

Produce the holes as shown in the drilling plan.

Fitting Devices

3.1.3

²

Detach the top and bottom plastic screw covers of each on-site operation panel.

²

Insert the device in the installation opening. Make sure that the fastening screws of the on-site operation
panels also protrude exactly into the openings (6-mm diameter (0.24-in diameter)).

²

With the M4 oval head cap screws, bolt down the device at the top and bottom at all 4 bolting points of
each module.

²

Check for secure attachment.

²

Fit the top and bottom plastic screw covers again.

Activating the Battery

Removing the Protective Film

i

3.1.4

NOTE
The battery is covered with a protective film to protect it from mechanical damage and against premature
discharge.
The battery need not be removed from the battery compartment for activation.
²

Pull out the battery compartment.

²

Remove the protective film from the battery by simply pulling on the film tab.

²

Push the battery compartment back in again.

Grounding and Connecting Devices

Grounding the Devices
The SIPROTEC 5 devices are protection class I equipment must be connected with the system ground before
commissioning.

!

DANGER
Danger due to device being improperly grounded
Incomplete and careless grounding leads to death, severe injury, and considerable material damage!
²

The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This method prevents condensation of water in the device.

²

If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2
days. This will cause the electrolytic capacitors to form on the printed circuit board assemblies again.

²

Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (0.16 in2),
grounding area ≥ M4).

Connecting Devices
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²

Connect all cables and leads. Use the connection diagrams in the Hardware and Device manuals.

²

Tighten the terminal screws to the prescribed torques.
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3.1 Flush-Mounting Devices

Grounding an On-Site Operation Panel
²

3.1.5

Join several on-site operation panels to one another with firm contact.
Siemens recommends the use of contact washers on painted metal assembly walls. If the assembly wall is
not metallic, place a metal layer, for example a metal sheet, between the assembly wall and the on-site
operation panels. Then connect this sheet to the system ground.

Tightening Torques of Fastening Screws

Tightening Torques for Terminal Screws
Type of Line

Current
Terminal

Voltage Terminal with
Voltage Terminal with
Spring-Loaded Terminals Screw Connection

Litz wire with ring-type lug

2.7 Nm

No ring-type lug

No ring-type lug

Stranded wires with bootlace ferrules 2.7 Nm
or pin-type lugs

1.0 Nm

0.6 Nm

2.0 Nm

1.0 Nm

–

Solid conductor, bare (2 mm2)

i

NOTE
Make sure that the cables and lines of extra-low voltage circuits are laid sufficiently far away from power
network circuits.

Torques for Other Screw Types
Screw Type

Torque

M4 x 20

1.2 Nm

M4 x 8

1.2 Nm

M2.5 x 6

0.39 Nm

Countersunk screw, M2.5 x 6

0.39 Nm

Countersunk screw, M2.5 x 8

0.39 Nm

Collar screw, M4 x 20

0.7 Nm
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Fitting the Devices
3.2 Surface-Mounting Devices with Integrated On-Site Operation Panel

3.2

Surface-Mounting Devices with Integrated On-Site Operation
Panel

3.2.1

Assembly Dimensions

[dwmoinab-040211-01.tif, 1, en_US]

Figure 3-3
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Device Drilling Pattern
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Fitting the Devices
3.2 Surface-Mounting Devices with Integrated On-Site Operation Panel

[dwosopin-070211-01.tif, 2, en_US]

Figure 3-4

Devices with Integrated On-Site Operation Panel, Dimensions from the Side and Front Views

Refer to Table 3-2 for the variable dimension a.

3.2.2

Fitting Devices

Preparations

i

NOTE

i

NOTE

!

Siemens recommends detaching the on-site operation panels before fitting the device. Fit the on-site operation panels after completing wiring and checks.

Use a PZ2-size Phillips screwdriver.
For each module, you need 4 fastening screws with a shank diameter of 6 mm (0.16 in).

DANGER
Danger due to device being improperly screw-fastened
Incomplete and careless screw fitting results in death, severe injury, or considerable material
damage!
²

²

Ensure that screw-fastening is complete at all intended bolting points. Tighten the screws to a torque
of 1.2 Nm.
Produce the holes as shown in the drilling plan.
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Fitting the Devices
3.2 Surface-Mounting Devices with Integrated On-Site Operation Panel

Fitting Devices

3.2.3

²

First bolt the bottom fastening screws into the wall.

²

Lower the bottom mounting bracket of the device onto the bottom fastening screws.

²

Align the device in the oblong holes. Ensure that screw-fastening is complete at all intended bolting
points.

²

Screw the device onto the top mounting bracket with the fastening screws.

²

Check for secure attachment of the device on the wall.

Activating the Battery

Removing the Protective Film

i

3.2.4

NOTE
The battery is covered with a protective film to protect it from mechanical damage and against premature
discharge.
The battery need not be removed from the battery compartment for activation.
²

Pull out the battery compartment.

²

Remove the protective film from the battery by simply pulling on the film tab.

²

Push the battery compartment back in again.

Grounding and Connecting Devices

Grounding Devices

!

DANGER
Danger due to device being improperly grounded
Incomplete and careless grounding leads to death, severe injury, and considerable material damage!
²

The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This method prevents condensation of water in the device.

²

If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2
days. This will cause the electrolytic capacitors to form on the printed circuit-board assemblies again.

²

Ground each module with solid low-impedance system grounding (cross-section ≥ 4.0 mm2 (≥ 0.16 in2),
grounding area ≥ M4).

Connecting Devices
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²

Connect all cables and leads. Use the connection diagrams in the Hardware and Device manuals.

²

Tighten the terminal screws to the prescribed torques.
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3.2.5

Tightening Torques of Fastening Screws

Tightening Torques for Terminal Screws
Type of Line

Current
Terminal

Voltage Terminal with
Voltage Terminal with
Spring-Loaded Terminals Screw Connection

Litz wire with ring-type lug

2.7 Nm

No ring-type lug

No ring-type lug

Stranded wires with bootlace ferrules 2.7 Nm
or pin-type lugs

1.0 Nm

0.6 Nm

2.0 Nm

1.0 Nm

–

Solid conductor, bare (2 mm2)

i

NOTE
Make sure that the cables and lines of extra-low voltage circuits are laid sufficiently far away from power
network circuits.

Torques for Other Screw Types
Screw Type

Torque

M4 x 20

1.2 Nm

M4 x 8

1.2 Nm

M2.5 x 6

0.39 Nm

Countersunk screw, M2.5 x 6

0.39 Nm

Countersunk screw, M2.5 x 8

0.39 Nm

Collar screw, M4 x 20

0.7 Nm
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Fitting the Devices
3.3 Surface-Mounting Devices with Detached On-Site Operation Panel

3.3

Surface-Mounting Devices with Detached On-Site Operation Panel

3.3.1

Assembly Dimensions

[dwmoinab-040211-01.tif, 1, en_US]

Figure 3-5
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Device Drilling Pattern
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[dwbploso-070211-01.tif, 1, en_US]

Figure 3-6

On-Site Operation Panel Drilling Pattern
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Fitting the Devices
3.3 Surface-Mounting Devices with Detached On-Site Operation Panel

[dwosopab-070211-01.tif, 2, en_US]

Figure 3-7

Devices with Detached On-site Operation Panel, Dimensions in the Side and Front Views

Refer to Table 3-2 for the variable dimension a.

3.3.2

Fitting Devices

Preparations

i

i

42

NOTE
The distance between the installation location of the device and that of the on-site operation panel must
not exceed 2.5 m (98.43 in).
Join the on-site operation panels to one another with firm contact. Siemens recommends the use of
contact washers on painted metal assembly walls. If the assembly wall is not metallic, place a metal layer,
for example a metal sheet, between the assembly wall and the on-site operation panel; then connect this
sheet to system ground.
NOTE
Use a PZ2-size Phillips screwdriver.
For each base module you need 4 fastening screws with a shank diameter of 6 mm (0.24 in). For each onsite operation panel you need 4 M4 fastening screws, minimum screw length M4x8 plus contact washer
thickness.
For each on-site operation panel you also need 2 contact washers, manufacturer Böllhoff.
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!

DANGER
Danger due to device being improperly screw-fastened
Incomplete and careless screw fitting results in death, severe injury, or considerable material
damage!
²

Ensure that screw-fastening is complete at all intended bolting points. Tighten the screws to a torque
of 1.2 Nm.

²

Produce the holes in the wall to fit the device. The drill holes must be so large that they can accept a
screw with a shank diameter of 6 mm.

²

Produce the holes in the wall to fit the on-site operation panel.

²

Cut a recess into the wall for the connecting cable. The connecting cable links the on-site operation
panels to the device.

²

Place a metallic layer such as a metal plate on the wall if it is not metallic.

Fitting the Device
²

First bolt the bottom fastening screws into the wall.

²

Hook the bottom mounting bracket onto the bottom fastening screws.

²

Align the device in the oblong holes.

²

Screw the device onto the top mounting bracket with the fastening screws.

²

Check for secure attachment of the device on the wall.

Installing On-Site Operation Panels

i

3.3.3

NOTE
Join several on-site operation panels to one another with firm contact. Siemens recommends the use of
contact washers on painted metal assembly walls. If the assembly wall is not metallic, place a metal layer,
for example a metal sheet, between the assembly wall and the on-site operation panel; then connect this
sheet to system ground.
²

Plug the connecting cable into the on-site operation panel of the basic module.

²

Guide the connecting cable through the cut-out in the wall.

²

Place the 2 contact washers on the top fastening holes.

²

Bolt down the on-site operation panels connected to one another on the wall.

²

Check for secure attachment of the on-site operation panels on the wall.

Activating the Battery

Removing the Protective Film

i

NOTE
The battery is covered with a protective film to protect it from mechanical damage and against premature
discharge.
The battery need not be removed from the battery compartment for activation.
²

Pull out the battery compartment.
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3.3.4

²

Remove the protective film from the battery by simply pulling on the film tab.

²

Push the battery compartment back in again.

Grounding and Connecting Devices

Grounding Devices

!

DANGER
Danger due to device being improperly grounded
Incomplete and careless grounding leads to death, severe injury, and considerable material damage!
²

The device must be situated in the operating area for at least 2 hours before you connect it to the
power supply for the first time. This method prevents condensation of water in the device.

²

If the device has been in storage for more than 2 years, connect it to an auxiliary voltage for 1 to 2
days. This will cause the electrolytic capacitors to form on the printed circuit board assemblies again.

²

Ground each module with solid low-impedance system grounding (cross-section ≥ 2.5 mm2 (≥ 0.1 in 2),
grounding area ≥ M4).

Connecting Devices

3.3.5

²

Connect all cables and leads. Use the connection diagrams in the Hardware and Device manuals.

²

Tighten the terminal screws to the prescribed torques.

Tightening Torques of Fastening Screws

Tightening Torques for Terminal Screws
Type of Line

Current
Terminal

Voltage Terminal with
Voltage Terminal with
Spring-Loaded Terminals Screw Connection

Litz wire with ring-type lug

2.7 Nm

No ring-type lug

No ring-type lug

Stranded wires with bootlace ferrules 2.7 Nm
or pin-type lugs

1.0 Nm

0.6 Nm

2.0 Nm

1.0 Nm

–

Solid conductor, bare (2 mm2)

i

NOTE
Make sure that the cables and lines of extra-low voltage circuits are laid sufficiently far away from power
network circuits.

Torques for Other Screw Types

44

Screw Type

Torque

M4 x 20

1.2 Nm

M4 x 8

1.2 Nm

M2.5 x 6

0.39 Nm

Countersunk screw, M2.5 x 6

0.39 Nm

Countersunk screw, M2.5 x 8

0.39 Nm

Collar screw, M4 x 20

0.7 Nm
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Handling of Plug-In Modules
4.1 Installation, Removal, Replacement

4.1

Installation, Removal, Replacement

4.1.1

Fasteners
The fasteners of the plug-in modules are shown in the following figure regarding the example of an installed
module and an empty, covered slot.

[le_fxing_elements, 1, --_--]

Figure 4-1
(1)
(2)
(3)
(4)
(5)
(6)

4.1.2

i

Fasteners
EMC spring contact
Fastening screw
Cut-out for prying out the modules
Plug-in module
Fastening screw
Cover plate

Installation
NOTE
Reordered modules are not contained in the original device configuration. Use DIGSI to perform the corresponding extension in the Hardware and Protocols Editor.

Preparing Installation

!

DANGER
Danger due to live voltage when installing the plug-in modules.
Noncompliance with the safety notes will result in death or severe injuries.
²

46

Install plug-in modules on the electrically deactivated device only.
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!

CAUTION
Exercise caution with laser beams of the optical plug-in modules.
Noncompliance with the safety notes can result in medium-severe or slight injuries.
²

²

Do not look directly into the optical fiber terminals of the active optical plug-in modules, not even with
optical devices. The laser beams can damage the eyes.
De-energize the device.

NOTE

i

When using optical communication modules, Laser class 1 is maintained in compliance with EN 60825-1
and EN 60825-2 when using optical fibers ≤ 62.5 μm/125 μm.
When using the ARC-CD-3FO module, Laser class 1 is maintained in compliance with EN 60825-1 and
EN 60825-2 when using 1 mm polymer optical fibers.
²

In the case of a surface-mounted device with integrated on-site operation panel, remove the entire onsite operation panel.

²

Undo the fastening screw and remove the cover plate from the plug-in module position.

Installing the Plug-In Module
²

Push in the plug-in module on the inner guide as far as it will go.

²

Ensure that the EMC contact spring is seated correctly.

²

Bolt down the plug-in module on the assembly frame to a torque of 0.4 Nm.

²

Connect the lines to the terminals.

²

Then check for secure attachment of the connectors.

²

If necessary, fit the on-site operation panel again.

Completing Installation
²

4.1.3

Resume operation of the device.

Removing

Accessories

i

NOTE
Seal an unused plug-in module position with a cover plate.
²

Order the module cover plate set of parts to cover the unused plug-in module position.
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Preparing Removal

!

DANGER
Risk of live voltage when removing the plug-in modules.
Noncompliance with the safety notes will result death or severe injuries.
²

!

Remove plug-in modules on the electrically deactivated device only.

CAUTION
Exercise caution with laser beams of the optical plug-in modules.
Noncompliance with the safety notes can result in medium-severe or slight injuries.
²

²

i

Do not look directly into the optical fiber terminals of the active optical plug-in modules, not even with
optical devices. The laser beams can damage the eyes.
De-energize the device.

NOTE
Laser class 1 is adhered to in compliance with EN 60825-1 and EN 60825-2, in the case of ≤ 62.5 μm/
125 μm optical fibers.
²

In the case of a surface mounting device with integrated on-site operation panel, remove the on-site
operation panel before the base module.

Removing the Plug-In Module
²

Remove all connecting lines.

²

Undo the fastening screw with which the plug-in module is fixed on the device.

²

Insert a screwdriver (DIN 4 x 0.8) in the cut-out underneath the oblong hole.

²

Carefully pull out the plug-in module.

Fastening the Cover Plate
²

Fasten the cover plate with the fixing screw to a torque of 0.4 Nm. The fixing screw is included in the set
of parts.

Completing Removal
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²

In the case of a surface mounting device with integrated local operation panel, fit the on-site operation
panel of the base module again.

²

Resume operation of the device.
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4.1.4

Replacement

Preparing for Replacement

!

DANGER
Danger due to live voltage when replacing the plug-in modules.
Noncompliance with the safety notes will result in death or severe injuries.
²

!

Install plug-in modules on the electrically deactivated device only.

CAUTION
Exercise caution with laser beams of the optical plug-in modules.
Noncompliance with the safety notes can result in medium-severe or slight injuries.
²

²

i

Do not look directly into the optical fiber terminals of the active optical plug-in modules, not even with
optical devices. The laser beams can damage the eyes.
De-energize the device.

NOTE
Laser class 1 is adhered to in compliance with EN 60825-1 and EN 60825-2, in the case of ≤ 62.5 μm/
125 μm optical fibers.
When using the ARC-CD-3FO module, Laser class 1 is maintained in compliance with EN 60825-1 and
EN 60825-2 when using 1-mm plastic optical fibers.
²

In the case of a surface-mounted device with integrated on-site operation panel, remove the on-site operation panel before the base module.

²

Remove all communication lines.

²

Undo the fastening screw with which the plug-in module is fixed on the device.

²

Insert a screwdriver (DIN 4 x 0.8) in the cut-out underneath the elongated hole in the assembly frame
and disengage the plug-in module.

²

Carefully pull out the plug-in module.

Fastening the Plug-In Module
²

Push in the new plug-in module on the inner guide of the plug-in module position until it moves no
further.

²

Bolt down the plug-in module on the assembly frame to a torque of 0.4 Nm.

²

Connect the lines to the terminals.

²

Then check for secure attachment of the connectors.

²

If necessary, fit the on-site operation panel again.

Completing Replacement
²

Place the device is service again and perform a firmware update of the communication modules.
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i

50

NOTE
If you have not cabled the optical fiber plug-in modules, then seal the terminals with protective covers. This
prevents soiling of the terminals.
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Using On-Site Operation Panel
5.1 General

5.1

General
All SIPROTEC 5 devices can be operated via the DIGSI 5 interface of your PC and via the on-site operation
panel. This is available optionally as an integrated and detached on-site operation panel. The on-site operation
panel is characterized by a flat, compact design.

Variants
The on-site operation panel is composed of different modules depending on the hardware configuration of
the device. Operation is via the membrane keypad and the key switches. LEDs and displays in 2 different sizes
are available as elements of the display.

[dwosopva-040211-01.tif, 2, en_US]

Figure 5-1

Variants

Operating Concept
The operating concept allows you to do the following on-site operator control actions:
Navigation in the menu tree

•
•
•
•
•
•
•
•

52

Modification of settings
Resetting saved information
Showing default and control displays, measured values and logs
Executing switching operations
Initiating configured actions via function keys
Executing test and diagnostic functions
Status display with LED
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5.2

Overview of Operator Elements and Display Elements

On-Site Operation Panel of the Base and the 1/3 Module

[le_base_module, 1, --_--]

Figure 5-2
(1)
(2)
(3)
(4)
(5)
(6)
(7)
(8)
(9)
(10)

Base and 1/3 Module in Standard, US and China Design
Operating state display
Display in 2 design versions
Keypad with navigation keys
Softkey
Keypad with numerical keys and shiftable function keys
Keypad of control keys
USB port cover
Labeling strips
Reset and LED test key
16 2-colored LEDs

The following table gives you a detailed explanation of the function of the operator and display elements.
Operator Element/Display
Element

Function
Display
Small display
Resolution: 192 x 128 pixels
Display: Alphanumeric characters
Large graphical display
Resolution: 240 x 320 pixels
Display: Alphanumeric characters as well as graphical display of default and
control displays
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Operator Element/Display
Element

Function
Display of operability
Green LED (Run)
The device is switched on. The presence of the external auxiliary voltage is
indicated to you.
Red LED (Error)
The device is not ready to run or a fault is present. The life contact is open.
After successful start of the device, the LED goes out, indicating to you that
the device is ready for operation.
Navigation keys
By pressing or holding down the navigation keys, you can navigate in the
menus, lists and the graphical images (default display, control display).
Menus and lists (press key):
• Top
–
Display entry above
• Bottom
–
Display entry below
• Right
–
Display level below
• Left
–
Display level above
Menus and lists (hold key):
• Top
–
Move forward by one display length
Bottom
•
–
Backward by a display length
• Right
–
Display level below
• Left
–
Back to the default display
Control displays (press/hold key):
Control displays are available only on the large display. Navigation between
pages and switching objects is done according to the sequences defined in
the DIGSI 5 Display editor.
• Top
–
To the previous switching object
• Bottom
–
To the next switching object
• Right
–
To the next page
• Left
–
To the previous page
Default displays (press/hold key):
Navigation between the default displays (pages) is done according to the
sequences defined in the DIGSI 5 Display editor.
• Right
–
To the next page
• Left
–
To the previous page (sequence as laid down in DIGSI 5)
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Operator Element/Display
Element

Function
Navigational aid
The footer of the display shows you the authorized navigation directions
depending on current display level.
Selection dialogs:
In selection dialogs you are offered selection options one below the other.
Example parameter Mode (Off/On/Test).

•

•

Top
–
Select top entry
Automatic line break from the first to the last entry
Bottom
–
Select bottom entry
Automatic line break from the last to the first entry

Numerical input dialog:
In a numerical command prompt (for example, confirmation ID) the cursor
appears right-aligned.
• Left
–
Backspace key which puts the cursor back by one position. You
must re-enter all skipped places by using the numerical keys.
Contrast setting:
The contrast setting is done only via the navigation keys.
• Left and right simultaneously
–
Jump to the Contrast menu
Right
•
–
More contrast
• Left
–
Less contrast
• Top and bottom simultaneously
–
Restoring default setting
Softkeys
The softkeys are located on the left and right below the display. They are
used to confirm command prompts in the display. Context-sensitive actions
can always be triggered with the softkeys.
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Operator Element/Display
Element

Function
Numerical keys and convertible function keys
This keypad is used for entering numerical values (with or without decimal
point). You can activate actions of function keys using these keys. The keys
<1> to <9> are double reserved for number entry and the functionality of
function keys. To activate the function keys, press the <Fn> key (<F1> to
<F9> in blue font).
Numerical keys
These keys are used for entering values and for navigation in menus.
According to the numbering on the right display edge, you can jump
directly into submenus or carry out settings.

Function keys <F1> to <F9>
You can execute configured actions with DIGSI 5 using the function keys.
For standard actions (for example, reading of the operational log on site)
this means a simplification. The following configurations for the function
keys are possible:
• Jump into a specific menu
• Jump into a specific log
• Activation of a binary input indication (for example, start fault record,
testing binary inputs)
• An adjustable function key mode is offered by the Toggle (edge-triggered activation and termination) and Pulse (with activation time)
modes and the On and Off mode.
Note on the Toggle function key mode:
The default setting of the value of information in startup is Off, each
key press switches between the states ON and OFF.
In the routing to switching objects (information type SPC or DPC), the
current switch position is not considered. This means that a toggle
command is not executed if the switching object is already in this
switch position.
• <F9> cannot be configured and is always assigned to switching
between languages
Activating function keys:
There are several methods available to you to activate function keys
• <Fn> key + NUM LOCKkey (simultaneously)
Example: <F1> = <Fn> key + <1> key
<Fn>
key alone → jump to the function key menu, selection of
•
function key via navigation keys and confirmation with OK or directly
by numeric input
Function keys menu
The configured assignment of function keys is visible in the function key
menu. The assignment of function keys <F1> to <F8> is defined in DIGSI 5.
They have different defaults depending on application template. A default
assignment exists for:
• <F9>
Language change: Jump to the selection menu for languages
<F9> cannot be configured via DIGSI 5
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Operator Element/Display
Element

Function
Control key for activating standard control display
If no control display is available (not configured or device with small
display), you are taken directly to the standard default display.
If it has not already been selected, and depending on device configuration,
pressing the <CTRL> key jumps directly to:
• Large Display → Default display
• Large display/at least one control display → Standardcontrol display
• Small Display → Default display
Control key for switching on a selected switching object
Select the switching object either in the Control menu or in the control
display (only in devices with large display).
Control key for switching off a selected switching object
Select the switching object either in the Control menu or in the control
display (only in devices with large display).
USB ports
There are 2 USB ports with plastic cover available to you:
• Top USB port (host)
Connection for a DIGSI PC
• Bottom USB port
Reserved for the future applications
16 parameterizable LEDs
• Dual-colored configurable (red and green)

Key for resetting saved displays and contacts
With this key you can reset stored information that is configured on the
LEDs, on the display or on output contacts. The initial state is then restored.
When the key is pressed, all LEDs are activated simultaneously, allowing
you to execute a test of the LEDs.

i

NOTE
Note that terminating the contacts of saved output indications can lead to reactions in the device environment.
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On-Site Operation Panel of the Base Modules

[dwerwmod-040211-01.tif, 2, --_--]

Figure 5-3
(1)
(2)
(3)
(4)
(5)

Expansion module
16 monochrome LEDs
Labeling strips
2 key switches
8 monochrome LEDs
8 push-buttons

The following table gives you a detailed explanation of the function of the operator and display elements.
Operator Element/Display Element

Meaning
16 parameterizable LEDs
• Monochrome (red)
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Operator Element/Display Element

Meaning
8 parameterizable LEDs
• Monochrome (red)
Keypad
• Keypad with programmable function keys to perform
actions quickly. Next to the keypad there are labeling strips
for user-defined labels.

Besides the base module, you can fit an expansion module with key switches. The following table explains the
meanings of the switch positions.
Operator Element/Display Element

Meaning
Key switch for on-site switching authority
• Local position
Switching commands for configured equipment are
possible only on site with the control keys or in the control
menu. You cannot execute switching commands remotely
(or from DIGSI).
• Remote position
Switching commands for configured equipment are
possible on site as well as remotely.
In devices with an expansion module with key switches the
corresponding options are static in the control menu.
Key switch for on-site switching mode
• OFF position
Unlocked switching of configured equipment allowed
• Normal position
Switching of configured equipment only with the designed
interlocking conditions
In devices with an expansion module with key switches the
corresponding options are static in the control menu.
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5.3

Displays for Indication and Control

Displays
Displays for indication and control offer you the possibility of quickly obtaining an overview of important operating modes. You can configure a total of up to 10 displays in DIGSI 5 using the display editor. The following
contents are available here:
• Dynamically updated measured values

•
•
•
•

i

Status of indications
Switch positions of switching objects
Texts
Graphical elements

NOTE
The displays and controls are displays created in DIGSI 5.

Default Displays
In the idle state, that is, provided there is no fault, the display with DIGSI 5 can show configurable operating
information (for example, operational measured values). If preconfigured in DIGSI 5, display images can be
suppressed by spontaneous displays in the event of a fault.
A device ready for operation will show you the following display image after booting. This presupposes you
have not parameterized a display image with DIGSI 5. The standard display image (default display) is parameterized and defined in DIGSI 5. If a parameterized and defined display image exists, it is displayed after
booting.

[scligrdi-080413-01.tif, 1, en_US]

Figure 5-4

Standard Display Diagram

You reach the standard display diagram at any time (exception: in case of fault) by holding down the left navigation key.
If several display images are available, you can select them in order of parameterized sequence by pressing the
right and the left navigation keys.
Control Displays
In devices with large graphic display, entire control displays can also be graphically depicted. The control
displays can graphically and dynamically update the switch position of switching objects. In addition, control
displays offer you the possibility of selecting individual switching objects and activating them according to
switching authority and switching mode.
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[scabzstb-100211-01.tif, 1, en_US]

Figure 5-5

Control Display

A ready-to-run device with large graphic display shows you the control display defined as the standard after
booting. By pressing and holding down the left navigation key, you get to the control display defined as
standard. By pressing the control key, you get to the control mode of the currently displayed control display.
If several displays are present, you can select them in order of parameterized sequence by pressing the right
and the left navigation keys.
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5.4

Structure of the Menu

[scmnuebr-030914-01, 2, en_US]

Figure 5-6
(1)
(2)
(3)
(4)
(5)
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Example Main Menu
Title bar with name of menu
Position display and total number of available menu items
List of menu items with numbering on the right edge (shortcut)
Base bar with the display of permissible navigation directions and assignment of softkeys
The current position in the menu is marked with brighter font on a dark background.
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5.5

Menu Tree
The menu tree consists of the main menu and several levels of submenus. To navigate in the menu use the
keys on the operation panel of the base module.

Main Menu
The main menu structure is firmly set and is not changeable. The submenus
depend on the hardware configuration and the configuration of functions.

Logs Menu
In the Logs menu, the available logs recording events in the operating state
of the device are offered.
You will find information about reading and deleting logs in chapter
8.4.1 General .

Measurements Menu
In the Measurements menu, you can display various measured values.
Assignment to existing function groups (for example, line 1) is done in the
corresponding submenus.

Control Menu

i

NOTE
The Switching mode and Switching authority submenus are not offered if the device has key switches to
the on-site control.
The Control menu offers all mechanisms for on-site control. Access to individual equipment (for example, circuit breakers) and the settings with
respect to interlocking mechanisms, switching authority and switching
mode is via submenus.
You will find information about controlling equipment and resetting saved
binary outputs and LEDs in chapter 8.4.1 General .

Settings Menu
The Settings menu is used for changing and adapting protection settings in the device. The menu follows a
usability (for example, request for acceptance after leaving certain menu levels).

i

NOTE
All visible settings are assigned to a certain adjustable settings group. You can view the number of settings
groups and set the activation of one of the settings groups in the General submenu.
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The settings are grouped in corresponding submenus according to their
assignment to existing function groups (for example, line 1).
You will find information about viewing and changing settings in chapter
8.4.1 General .

Binary I/O Menu
Selecting the Binary I/O menu provides you with the option to see the
routing to the binary inputs, binary outputs and signals displayed.
You can find more information in chapter 5.8 Display of Routings and
Status .
Communication Menu
The Communication menu is used for changing and adapting communication settings for the mainboard and
the communication modules in the device. The menu follows a usability (for example, request for acceptance
after leaving certain menu levels).

i

NOTE
Enter settings for communication modules only through DIGSI 5.

The Communication menu notifies you about the status of configured
communication modules (module type, slot, port and IP address). Furthermore, you can, for example, also change the IP address of your device.
Device Functions Menu
Via the Device functions menu, you can set the operating modes of the
device or of individual functions (for example, test), initiate resetting of
stored LEDs and binary outputs, change passwords and make regional
settings (date and time, display formats).

Test & Diagnosis Menu
The Test & Diagnosis menu offers you support during commissioning and
testing. If you wish to test systems and equipment on site, you can read all
necessary information from the corresponding submenus and start actions
such as device reset.
You can find more information on this in chapter 9.5 Test and Diagnostics .
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5.6

Notification Windows and Dialogs

Notification Windows
The notification windows appear briefly in the base bar to give you important information during on-site operation and close automatically. For example, they contain the following information:

[scmitfen-080413-01.tif, 1, en_US]

Figure 5-7

Examples of Notification Windows

Dialogs
Dialogs are interactive notification windows in the base bar. In the dialogs, you are prompted to actively carry
out actions. A dialog consists of the following elements:
• Dialog designation

•
•

Two softkeys (bottom left and right)
Text information with interactive text box or list boxes

You confirm the context-dependent command prompts offered here by pressing the softkeys below the
prompts.

[scdialpa-080413-01.tif, 1, en_US]

Figure 5-8

Dialog for Entering the Confirmation ID

[scdiawrt-080413-01.tif, 1, en_US]

Figure 5-9

Dialog for Entering a Value

If a command prompt is shown in the dialog, then you can activate the functions in the following list by
pressing the softkeys below each function.

i

Softkey
Left

Function

Softkey
Right

Function

Delete

Delete log

Enter

Confirm value

Escape

Cancel current action

OK

Confirm action

Log off

Log off

Log in

Log in

Start/Test

Start an action

Menu

Main Menu

Switch

Switch equipment

Change

Change value

NOTE
If you do not confirm the dialog with a softkey, the action you wish to achieve is canceled after a previously
set time. The prior state is restored.
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5.7

Displaying Device Mode

Not Initialized Device (As-Delivered Condition)
SIPROTEC 5 devices are not initialized in the as-delivered condition. If a non-initialized device is connected to
the auxiliary voltage and started, then the following information is shown on the display:
• Device variant

•
•
•

i

Firmware version
Serial number
Prompt Initialize device

NOTE
You may only initialize the device via DIGSI 5 and only then via the USB connection of your SIPROTEC 5
device.
See chapter 7 Commissioning for more information on initializing and commissioning.

Initialized Device
The device can be in the following modes:
• Commissioning mode

•
•
•

Simulation mode
Process mode
Fallback mode

In normal operation (process mode), the device is presented as described in chapter 5.4 Structure of the Menu

i

NOTE
The device can change mode during commissioning, testing or in the event of a device failure. The mode
deviating from normal operation is shown respectively in the title bar of the device display. The name of
the mode is shown flashing in the top line of the device display (except in fallback and process mode):
• Commissioning mode

•

Simulation mode

Take note of the information about these modes in chapter 7 Commissioning and chapter 9 Maintenance,
On-the-Spot Assistance and Test.
Commissioning Mode
The commissioning mode of the SIPROTEC 5 device allows you to check the existing wiring without affecting
or blocking the protection functions or other functions of the device. You can select the commissioning mode
manually.
You can find more information in Chapter 7.2.2 Testing Current and Voltage Inputs.
In commissioning mode, you can also check the communication with system-control technology. You can
generate test signals with the communication test in DIGSI by setting signals to be transmitted systematically
in the transmitter and checking their receipt.
You can find more information in chapter 7.4.3 Testing Interfaces in the Compound System.
Simulation Mode
In the simulation mode of the device, you can check the correct setting of protection functions and the
routing of signals. You can perform simple checks without wiring or using DIGSI. To do so, connect the device
to DIGSI and generate test sequences. You can perform the tests on the device without external test equipment. The DIGSI test sequences simulate the change of values at the inputs to the device.
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You can also feed in the test signals using a digital test equipment. Digital test equipment offers you multiple
test programs and test sequences.
Process Mode
The process mode is the normal operation of the device.
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5.8

Display of Routings and Status
You can route logic information from the SIPROTEC 5 device to binary inputs, binary outputs and LEDs. With
the menu item Binary I/O of the device you can display the routing of the logical signals and their status.
In order to display the routings in the SIPROTEC 5 device, proceed as follows:
• In order to access the Binary I/Os from the main menu, use the navigation keys of the on-site operation
panel:
Main menu → Binary I/O

•

Use the navigation keys of the on-site operation panel to navigate within the displayed list and select one
of the 3 following menu entries:
–
Binary inputs
–

Binary outputs

–

LEDs

[scbinipt4-260814-01, 1, en_US]

Figure 5-10

Binary I/O Menu Item

The following examples show how to proceed when reading the on-site operation panel and how to set the
DIGSI for the binary input in the information routing.
• Select the menu item Binary inputs.
All available binary inputs of the SIPROTEC 5 device will be displayed. Furthermore, following the equal
sign, the current status of the binary input is displayed (see Figure 5-11).
The following table shows the meaning of the status of the individual menu entries Binary inputs, Binary
outputs and LEDs.
Menu Item

Status

Description

Binary input

X

Input is active

-

Input is not active

X

Output is active (contact is closed)

-

Output is not active (contact is open)

X

LED is switched on

-

LED is switched off

Binary output
LED

The status of the respective binary inputs, binary outputs or the LEDs is updated automatically by the actual
state in the device.
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[scbinipt5-260814-01, 1, en_US]

Figure 5-11

•

List of Binary Inputs

Use the navigation keys to select the binary input, for example, Binaryinput1.1.

All signals routed to Binaryinput1.1 are displayed as a list (see Figure 5-13).
Example of a Signal

•

Go to the information routing in DIGSI 5 and select the properties H or L for the input >Ext. trip
initiation off.

This status will also be displayed on the on-site operation panel of the SIPROTEC 5 device. Figure 5-12 and
Figure 5-13 shows you the routing of the signal >Ext. trip initiation, for stage 1.
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[scranma1-260814-01, 1, en_US]

Figure 5-12

Entry in the Information Routing

Figure 5-13 shows that [L] active without voltage for the signal >Ext. trip initiation was
parameterized. In the Line function group, the Overvoltage protection (ANSI 59) is also operated. In addition, the Binaryinput1.1 can also block this protection function. The blocking function will become active with
[H] active with voltage.

[scbinipt1-260814-01, 1, en_US]

Figure 5-13
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Status of Binaryinput1.1
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Example of a Circuit Breaker
A circuit breaker can have the status open or closed. Figure 5-14 displays the various properties of the circuit
breaker in the information routing of DIGSI 5.

[scranma2-260814-01, 1, en_US]

Figure 5-14

Properties of the Circuit Breaker

The following figure shows an example of the routing of the circuit-breaker switch position. Here, the Binaryinput1.1 shows the closed circuit-breaker switch position 1. [GH] indicates that the voltage on binary input
1.1 is active and signals a closed circuit breaker.

[scbinipt2-260814-01, 1, en_US]

Figure 5-15

Circuit-Breaker Status on the On-Site Operation Panel
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Example of a Transformer Tap Changer
You can also use a binary input to display the tap position of the transformer tap changer. In this case, you
must set the X (routed) property in the DIGSI 5 Information routing (see figure below). X (routed) means that
the binary input was routed.

[scranma3-260814-01, 1, en_US]

Figure 5-16

Example for Transformer Tap Changer 1:

The figure below indicates that Binaryinput1.1 displays the position of the transformer tap changer 1.

[scbinipt3-260814-01, 1, en_US]

Figure 5-17
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Position of the Transformer Tap Changer 1
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6.1

General
DIGSI 5 is the engineering and operating tool for all SIPROTEC 5 devices. With DIGSI 5, you create system
topologies, configure hardware and communication networks and perform many other tasks.
You carry out all engineering tasks offline from your PC without needing a SIPROTEC 5 device. You transfer all
data online to the device later – for example, directly via a communication network or the USB interface. For
communication between DIGSI 5 and the SIPROTEC 5 device, secure TCP-IP connections are used.
Operation of DIGSI in version 5 is even more user-friendly. Project tree, editors, libraries and property window
are integrated smoothly into a common interface. You can adjust this interface to your operation.

Project, Project View and Project Navigation
After starting DIGSI 5; you are shown the project view. It is initially empty and fills up with content as soon as
you create a new project or open an existing one.

[scproans-110413-01.tif, 1, en_US]

Figure 6-1

Example of a Project View

DIGSI 5 manages all components of a system and all associated data depending on the project. The following
values are summarized under one project name (extract):
• Topology

•
•
•
•

Devices
Setting values
Communication settings
Process data

That means you must open a project file and thus have all data available. Vice versa you save all changes of
any type with only one mouse click.
On the interface you see a project with symbols that are integrated into a hierarchical project structure. These
symbols represent:
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•
•
•
•
•
•

Individual devices
Editors
Setting sheets
Tables
Actions
Folder

You have access to all data and tools via the individual symbols. A double-click is enough and the symbols will
show setting values of protection functions, start actions such as loading of parameter values or open one of
the editors.
DIGSI 5 is available in 3 variants. Please refer to the order catalog and the DIGSI 5 online help for the exact
functional scope. DIGSI 5 Premium offers, among others, the following possibilities:
• Managing all SIPROTEC 5 devices of a system in a project

•
•
•
•
•
•
•

Defining the primary topology in a Single-Line Editor
Simple setting of protection settings and control of setting values via zone diagrams
Creation and testing of logic symbols in CFC plans
Creation of device displays for the different device display variants
Control of devices and management of process data
Communication with one or more devices via direct communication connections
Testing of parameterization of a protection device using the DIGSI 5 Test Suite
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6.2

Operator Actions in the Offline and Online Area
You can execute operator actions in the offline configurations or online on the device.

i

NOTE
To avoid unintentional changes and switching operations during operation, some operator actions are
protected by a confirmation ID.
Protect access to your protection devices using a secure connection password. This will prevent undesirable
changes by third parties.

Offline Area (Project View)
The offline configurations indicated offline in a project include all data to be edited of a protection device on
the engineering PC. There is no connection to a physically existing device. You can execute the following
actions in the offline area:
• Creating a topology as a single-line diagram

•
•
•
•
•
•
•
•
•
•
•

Adding SIPROTEC devices to the topology
Configuring hardware of a SIPROTEC device
Defining functional scope of a SIPROTEC device
Entering individual function settings and displaying characteristic curves graphically
Routing information
Editing display diagrams
Designing logic functions such as interlocking mechanisms
Configuring the communication network and setting communication parameters
Displaying save measured values and indications
Displaying saved fault records and evaluating them with SIGRA
Exporting and printing data

Devices Available Online (Online Mode)
In online mode there is a connection between a PC and a device. In this mode you can carry out the following
actions:
• Transferring setting values from the PC to the SIPROTEC device

•
•
•
•
•
•
•
•
•
•

76

Transferring setting values from the SIPROTEC device to the PC and saving in files
Transferring indications, measured values and fault records from the SIPROTEC device to the PC and
saving in files
Setting limiting values
Executing test functions
Controlling equipment, placing markers and canceling blocks
Executing initial start or restart of the SIPROTEC device
Setting date and time
Changing confirmation IDs and passwords
Adding devices to projects
Complete processing of devices
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i

NOTE
If you change setting values or routings in online devices, you must activate them in the device. This
ensures consistent acceptance of data.
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6.3

Initializing a Device

i

NOTE

i

NOTE

Initialization is possible, for example, via the USB interface or port J of the device.

The physical connection between PC and SIPROTEC 5 device may be done only 1 to 1. If your PC has several
free USB interfaces, you can connect only one single SIPROTEC 5 device. Otherwise, no connection to the
devices is established. If you set up a hub between PC and the SIPROTEC 5 devices, no connection to the
devices is established either.
Connect the top USB port on the front panel of the on-site operation panel of the base module of SIPROTEC 5
devices to the engineering PC using a suitable USB cable. If you have connected the protection device to your
PC, you can initialize the device with the help of DIGSI 5.
• Select the relevant offline configuration in a DIGSI 5 project by selecting the device name.

•
•
•

Open the context menu by right-clicking.
Select Initialize Device.
The offline configuration is thereby transferred to the device and the offline configuration in the DIGSI 5
project connected via the serial number of the device.

Check whether there is a connection between your DIGSI 5 project and your device. If you wish to compare
the serial number in the editor and the device information with the label of the device, proceed as follows:
² Double-click in the project tree the Device information tab under the device. You will find the serial
number in the General section.
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i

Transferring Device Data from the PC to the Device
NOTE
If the protection devices are connected to the engineering PC, the transfer of device data to one or more
devices is possible. For this purpose, you must initialize the devices once with DIGSI 5.
If you would like to transfer device data from the PC to the device, then connect the device to the PC. You can
use the following terminals for this purpose:
• USB port on the on-site operation panel of the base module

•

Any Ethernet interfaces of the device

²

Check whether there is a connection between your DIGSI 5 project and your device.

²

Compare the serial number in the editor and the device information to the label of the device.

²

To do this, double-click in the project tree the Device information menu item under the device. You will
find the serial number in the General section.

Establishing a Connection Via USB
²

Connect the top USB port on the front panel of the on-site operation panel of the base module of
SIPROTEC 5 devices to the engineering PC using a suitable USB cable.

²

In the project tree of your DIGSI 5 project, double-click the Load configuration to the device menu item
in the corresponding offline configuration of the device.

²

Enter the confirmation ID for the user.

DIGSI 5 recognizes automatically that the device is connected via USB and the loading of configuration from
the DIGSI 5 project to the device is initiated.
Establishing a Connection Via Ethernet

[scipadrs-080413-01.tif, 1, en_US]

Figure 6-2

Setting the IP address

²

Connect, for example, the Ethernet port J on the rear of the SIPROTEC 5 base module to the engineering
PC using a suitable Ethernet cable.

²

In the project tree of your DIGSI 5 project, double-click the Devices and networks menu item.

²

In the network view, you will find all devices of your project with the offline configurations. Select the
device with which you would like to connect and click the green-edged field of the displayed device (see
Figure 6-2).

²

Enter the IP address, subnet mask and optionally the IP address of a router (standard gateway).

²

In the project tree of your DIGSI 5 project, double-click the Load configuration in devices menu item.
Execute this in the corresponding offline configuration of the device.

DIGSI 5 recognizes automatically that the device is connected via Ethernet. The loading of the configuration
from the DIGSI 5 project to the device is then initiated.
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i

NOTE
If you wish to use another Ethernet interface port other than port J, in Device Information select the interface with which DIGSI 5 should communicate with your SIPROTEC 5 device.
Alternatively, you can select the following path for the setting of the Ethernet address.

[scipruec-030311-01.tif, 1, en_US]

Figure 6-3

Rear panel of a SIPROTEC 5 device

²

Connect, for example, the Ethernet port J on the rear of the SIPROTEC 5 base module to the engineering
PC using a suitable Ethernet cable.

²

In the project tree of your DIGSI 5 project, double-click the Devices and networks menu item.

²

You will find all devices of your project with the offline configurations in the Device view tab. Select the
device with which you would like to connect and click the Ethernet port of the displayed device (see
Figure 6-3).

²

Enter the IP address, subnet mask and optionally the IP address of a router (standard gateway).

²

In the project tree of your DIGSI 5 project, double-click the Load configuration in devices menu item.
Execute this in the corresponding offline configuration of the device.

DIGSI 5 recognizes automatically that the device is connected via Ethernet. The loading of the configuration
from the DIGSI 5 project to the device is then initiated.

i
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NOTE
If you wish to use another Ethernet interface port other than port J, in Device information select the interface with which DIGSI 5 should communicate with your SIPROTEC 5 device.
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6.5

Changing Data on the Online Device
Always execute changes in the project tree of the selected device and load the changes to the device. Proceed
as follows:
² In your project, click the node of the selected device.
²

Execute the desired changes, for example, in the settings.

²

Select the device again and right-click the device.

²

In the menu, select the item Load configuration to device.

DIGSI transfers the changed configuration data to the device. After a successful transfer, the device restarts.
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6.6

Retrieving Fault Records and Log Contents
Proceed in online mode as described in chapter 6.4 Transferring Device Data from the PC to the Device Load
the parameterization and read process data from the device.
² Link the matching offline configuration in your project to your online device.
²

To do this, drag the online device in the project tree onto the matching offline configuration via Drag &
Drop.

You will recognize the connection by the change in name of the online device, which has now assumed the
name of the offline configuration with the remark assigned in brackets.
² Open the display of the logs by double-clicking in the tree the Indications node.
²

To open the log content, click in the toolbar of the Operational log or Fault log on Read log entries.

²

To display the fault records available in the device, open the node of the logs and click the Read records
button.

When reading fault records, fault indications are automatically retrieved as well and become available to you.
The log content as well as fault records are thus saved simultaneously as well in the linked offline configuration. You can also archive all entries as files which you can further edit in Microsoft Excel for example.
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7.1 Overview

7.1

Overview
This chapter contains information about the commissioning of the SIPROTEC 5 device. Test functions integrated in the device support you during testing, simplify testing processes and reduce testing times. You will
get an overview of the numerous possibilities of initial startup in chapter 7.3 Initial Startup.
The secondary test described in chapter 7.4 Secondary Tests is used for checking:
• Correct setting of functions

•
•

Routing of logical signals to the binary inputs and outputs
Interfaces and many more

Chapter 7.5 Primary Tests deals with the primary test and contains information about the test method. Information specific to protection functions can be found in the device manual.
The following chapter gives you an overview of the test functions integrated in the device. You can find the
offline testing options during engineering in the DIGSI 5 online help.
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7.2

Test Suite Integrated in the Device

7.2.1

Test Functions
After you complete the initial startup (see chapter 7.3 Initial Startup), you can access the test functions integrated in the device. To do this, establish connection to the online device. In the project tree, open the Folder
Test Suite. Underneath you will find the individual test points that are explained to you in the following chapters. The following figure shows the project tree.

[scproans-110413-01.tif, 1, en_US]

Figure 7-1

Project Tree

If you have activated a connection password for the device, you must enter it in the corresponding dialog.
After correct password entry, the connection between DIGSI 5 and device is established. In case of wrong
entry, the connection is not established.
If you have configured a confirmation ID with DIGSI 5, this is queried when you access the individual test functions. Enter here the corresponding 6-digit number.
You will find details for configuring the password and the confirmation ID in chapter 10.5 Authentication,
Connection Password, and Confirmation ID During Operation of this manual.
If the connection between DIGSI 5 and the device is interrupted during a test function, re-establish the
connection to the device. Then do a reset on the device with DIGSI 5. If no connection can be established,
then do the reset directly on the device through the on-site operation panel. After successful reset, the device
is now in a normal operating state 7.3.3 Initializing Device and Verifying Basic Status.

i

NOTE
The device must be set in another mode for most tests. If the tests occur in a system in operation, ensure
that the running operation is interrupted.
After successful tests, bring the device back to the previous mode in the following manner:
• Confirm the link Show device mode in the upper right of the work window.

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

85

Commissioning
7.2 Test Suite Integrated in the Device

[scgemoaz-210611-01.tif, 1, en_US]

Figure 7-2

•
•
7.2.2

Project Navigation

Select the previous mode in the working area Device information under Device mode.
Click the Restart button.

Testing Current and Voltage Inputs
If you click in the project tree according to Figure 7-1 on the menu item Analog inputs , a representation visualizing for you the current values of the measuring points existing in the device appears in an editor. On the
left side you will see the phasor diagram for 3-phase analog inputs (absolute value and phase). To the right
the measured values are displayed as numerical values. The primarily measured values for voltage and current
are shown as indicators of absolute value and phase. The reference is the voltage in phase A of measuring
point 1. If no voltage is connected, the current in phase A of measuring point 1 is the reference. All indicated
phasor values refer to the reference quantities.
You can identify and verify the following errors with measured-value control:
• Turner in the analog wiring

•
•

Vector group
Direction between current and voltage

Devices connected via effective connections can also represent analog measuring points of remote ends as
phasors. In this case, the phasors of measuring points of up to 6 remote ends are shown. For example, the
stability of a line differential protection can thus be verified.

[sctstane-140211-01.tif, 1, en_US]

Figure 7-3

Example of a Check of Analog Inputs

Test procedure:
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•

Feed the test quantities to the terminals (for example, exchange terminals in the control cabinet) using
multiphase test equipment. Siemens recommends a test with the rated values and the infeed of current
and voltage in phase. The test functions from 10 % of the rated quantity.

•

Check the measuring result in the DIGSI 5 operating program (absolute value and phase). Make use of
the phasor diagram as well as the indicated measured values. Check phase displacement between
voltage and current as well.

•

In the event of implausibility, first check the proper connection of the test equipment and the angle
between voltage and current set in it. Then check the wiring to the device as well as the settings (for
examle, under Power-system data).

Figure 7-3 shows you the result of a successful test on a device which has 4 voltage and current inputs.

i

NOTE

i

NOTE

7.2.3

To check the wiring between device and connected transformers, Siemens recommends that this test be
done on the system with primary measured signals. This allows you to check the correct connection of
secondary circuit completely.

The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.

Testing Protection Functions
The purpose of this test is to verify the correct setting of protection functions and the routing of signals. To do
this, you can feed the test signals with test equipment. Digital test equipment offers you multiple test
programs and test sequences.

i

NOTE

i

NOTE

Simulation mode is indicated by flashing of the top line of the device display.

If you only want to select a graphical representation of a protection function, all available and active
protection functions of your SIPROTEC 5 device are checked.
Simple tests can also be done via simulation mode on the device and DIGSI 5 interaction. To do this, use
DIGSI 5 to generate test sequences which are then executed in the device without the need for external test
equipment and which simulate the change in values on the inputs.
• Click the Test sequences folder in the project tree.

•

Open this folder by double-clicking.

Under the Create test sequence menu item create your test sequence which, for example, consists of 3 steps:
the pre-fault, the short circuit and the post-fault. You can save the created sequence and use it for other tests.
You will also find the stored sequence under the Test sequences folder. Sequences can be copied between
devices that have the same measuring points.
Figure 7-4 shows you the editor for creating test sequences. You can enter a name (for example, pre-fault,
post-fault) for every test step. You can set the duration of the current test sequence, as well as the duration of
a ramp. You can define amount and phase angle for each phase of a measuring point. You can select the
frequency in 3 phases for each measuring point.
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Additionally you can define a ramp for each phase via amplitude, phase or frequency via the ramp functions.
You can still define 3 various harmonic superimpositions per phase. This allows the setting of ramps within
one test step. If additional binary inputs are effective, you can adjust that in the section below. Using a hook
tag which binary input is active during the test step. If a voltage (corresponds logically to 1) is present, the
binary input is active.

[scprfsqu-150211-01.tif, 1, en_US]

Figure 7-4

Creating a Test Sequence

You can a use created test sequence, for example, for a protection function test. Start a test sequence in the
protection function test editor in DIGSI 5. You can also start a test sequence through a binary input of the
device. By starting through a binary input you can play back test sequences in several devices simultaneously.
You lay down the start criterion for the device using DIGSI 5 Figure 7-5. The test quantities are fed as sampled
values directly into the functions of the device by bypassing the analog and binary inputs. Before starting a
sequence DIGSI 5 switches the device to a simulation mode that activates the internal signal generator.
To check a protection function systematically, click again in the project tree the Test button and open the
Protection function test menu item. You are offered the existing protection functions and you can select
which protection function is tested. The characteristic curve of the protection function appears in the operating range (see Figure 7-5). The measured values are displayed in color in the characteristic curve and the list
of spontaneous indications is updated simultaneously. Feeding through a test sequence is done in this simulation mode where the protection functions work with the calculated sampled values of the sequence.
Switching to an internal sequence is done in DIGSI 5. The designated sequence is selected (it must first have
been configured offline), loaded into the device and its progress activated.
A SIPROTEC 5 device has numerous protection and supervision functions that work in parallel. For the tests
switch some or only the function to be tested. For this purpose, a test aid that greatly simplifies the test for
you was set up in SIPROTEC 5.
The protection functions have indirectly the same setting as when you switch the mode to Test in the function. In this state, the protection function is active. In addition, a test bit is generated and transmitted with
every indication. In the Test setting the routed relay in the device is not activated and the circuit breaker is
thereby not actuated.
Upon exiting of the test mode, the execution of an authorized test period or the conscious switching to the
normal operating state (Process mode) leads to the deactivation of the temporary settings. The original
setting then becomes active. You can also make us of this test menu to have a quick overview of available and
enabled protection functions.
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[scprscfk-160413-01.tif, 1, en_US]

Figure 7-5

i
7.2.4

Testing a Protection Function (Example, Overvoltage Protection)

NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.

Creating Signals for Communication Interfaces
The test editor serves to set signals or states in the device that are then output via the communication interfaces.

7.2.5

Testing Switching Devices
During a primary test the device in combination with DIGSI 5 offers the possibility of checking switching
devices. Click again the Test button and open the Control functions menu item. The existing switching
devices appear in the operating range. You can set the switching state and read in the status again. To do this,
activate the respective switching device and execute the desired actions. The spontaneous indications log the
behavior of the switching device (see Figure 7-6). You can verify the interlocking conditions by opening or
closing disconnectors or grounding switches. This takes place via the binary feedbacks on the device. Induce
unauthorized circuit states and check whether the interlocking logic stored in a CFC plan works correctly in the
device.
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!

WARNING
Warning of danger due to unauthorized switching states
Noncompliance with safety notes means that death, serious injuries, or considerable material
damage can occur.
²

Primary tests may be done only by personnel who are skilled electricians and who are familiar with the
startup of protection systems, with the operation of the system and with safety regulations and provisions (switching, grounding, etc.).

Apart from circuit breakers and disconnectors, you can also increment transformer tap switch higher or lower
and check arc-suppression coils.

i

NOTE
This switching function is used exclusively for testing. Operational switching operations are performed with
the on-site device control or with a connected substation automation technology.

[scschver-150211-01.tif, 1, en_US]

Figure 7-6
²

i
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Checking Switching Devices and Interlocking Conditions

If special confirmation IDs are activated for this test, these must be entered prior to the test. This applies,
in particular, to non-interlocked switching. For this purpose, the switching authority must be on Remote
and DIGSI 5 must be authorized to carry out switching operations.

NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.
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7.2.6

Circuit-Breaker Test
²

To test circuit breakers, go to Test suite and open the Circuit-breaker test menu item. The existing
circuit breakers then appear in the operating range (see Figure 7-7).

²

You can bypass the interlock of the circuit breaker. You can activate the circuit breaker 3-pole or every
circuit-breaker pole separately depending on the type of the circuit breaker. The feedbacks from the
circuit breaker are shown to you in the bottom part of the window. DIGSI 5 shows you the available test
sequences. Before execution of the test, a confirmation ID is queried.

[sclsscpr-110413-01.tif, 1, en_US]

Figure 7-7

i
7.2.7

Circuit-Breaker Test

NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.

Device Information and Diagnosis
In online operation, if you open the Device information table in the project tree, you get a lot of information
about the device. The table appearing in the operating range shows different tabs with corresponding information about the device. Figure 7-8 gives you an overview of the numerous possibilities.
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[scgerinf-100413-01.tif, 1, en_US]

Figure 7-8

•

Device information:
General information about the device such as device name, product code and serial number is indicated
here. If the device uses Ethernet, you can select at this point the IP address of the device through which
DIGSI 5 communicates with the device (port J, this setting only available in offline mode). You can
furthermore set the device language here, as well as the operating modes (process mode, commissioning
mode).

•

Resource consumption:
The first area shows you the state of the device load offline. If it is green, the parameterization can be
loaded into the device and real-time behavior ensured. If the lamp is red, functionality must be reduced.
The number of used function points is shown to you in the second area. If the allowed number is
exceeded, replacements must be bought for device-related function points. To reorder, use the configurator and follow the menu instructions there.
In the 3rd area you are shown the capacity utilization of the operational diagram (Continuous function
chart, or CFC in short).

•

Log
–
Device diagnosis log:
Monitoring indications are entered in this buffer. If, for example, a device fault is present, the
required information is entered in plain text. Every result is time-stamped. Plain text means that you
receive the necessary information about, say, erroneous modules and the type of error. At the same
time, an operation recommendation such as replacement of the expansion module is given.
–

•
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Device-Information Worksheet

Safety indications:
In this buffer logs, entries are time-stamped when access was carried out on the device using
DIGSI 5. Rejected access, for example, if you entered the password incorrectly 3 times, is registered.
You cannot delete this buffer. This buffer is organized as a ring buffer. Selected indications can be
transmitted to a systems control and can be archived there. This guarantees a long-term buffer for
accessing the device as it is required in cyber-security recommendations such as NERC-CIP (see
chapter10.1 Security Design).

Time information:
In this setting sheet you can open diagnoses for the first and second clock and query their synchronization status. In addition, it gives information about the internal device time. This can also be set via this
menu for test purposes. If a high-precision second pulse is available, its status is also shown here
8.7.3 Setting Time Keeping Parameters .
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•

i

Diagnostic information:
Here detailed information on the individual hardware and software components are stored.

NOTE
The device remains in commissioning mode until you set the device in the process mode consciously or
until the internal monitoring time (statement of time) has expired. You reach the process mode by clicking
the link in the upper right of the working area. The settings sheet Device information opens. Go to Device
mode to set the device in process mode.
You can execute more tests in this mode.
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7.3

Initial Startup

7.3.1

Establishing Readiness for Operation State
It is assumed that you have gone through steps in chapters 1 to 4. Check the connection of the auxiliary
power supply. SIPROTEC 5 devices have 2 power-supply unit designs (type 1: DC 24 V to DC 48 V and type 2:
DC 60 V to DC 250 V as well as AC 110 V to AC 250 V). You can also read the rated voltage range from the
name plate. After successful testing of your voltage source, switch it on. The device is now in startup mode.
The LEDs RUN (green) and ERROR (red) light up simultaneously. In addition, some LEDs on the base module
start flashing. When the RUN LED is permanently On and the ERROR LED is permanently Off the device has
started up. Figure 7-9 and Figure 7-10 show the basic status of the device display using the example of transformer differential protection.

Figure 7-10

Figure 7-9

Factory Setting of Small Display

Factory Setting of Large Display

Afterwards you can initialize the device by loading the parameterization. Before going to the
chapter 7.3.3 Initializing Device and Verifying Basic Status , read the information in the chapter 7.3.2 Using a
Project with DIGSI 5.

i
7.3.2

NOTE
If you find another default display after device startup, then someone before you has initialized the device.
You can now load your parameterization to the device. In the DIGSI 5 project tree, use the Load Configuration in Device menu item.

Using a Project with DIGSI 5
All settings of the device are created with the DIGSI 5 operating program. The engineering department is
responsible for editing. In the respective project (see chapter 6 Using DIGSI 5 ) you will find the devices with
the project-specific settings. Familiarize yourself with the project and the device settings before you execute
the next steps.
Take the following procedure as your guide:
² Install the DIGSI 5 operating program on your PC/laptop. For commissioning, Siemens recommends the
DIGSI 5 variant Premium.
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²

Accept the project from the engineering department and save it.

²

Open the project and the devices in it.

²

Check whether inconsistencies are shown. DIGSI 5 constantly performs a consistency check. If inconsistencies are detected, the corresponding position in the operating program is marked. If this is the case,
clarify the cause.

²

Look into device-specific parameterization. Use the sequence described below as your guide.
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Procedure for checking device parameterization:
² Check whether the parameterized hardware coincides with the existing devices. In the project, click
Devices and networks.

7.3.3

²

If you communicate via Ethernet, check the correct setting of the IP addresses simultaneously. You can
also do these checks under Device.

²

If the project is an IEC 61850 system, go to menu item IEC 61850 GOOSE Communication to familiarize
yourself with the respective circuitry. If you use circuiting you can view the static reports on the systems
control.

²

Create an overview of the settings or the routing in the individual menu items. Siemens recommends
doing this when opening the device in DIGSI.

Initializing Device and Verifying Basic Status
SIPROTEC 5 devices are initialized via the front USB interface. Alternatively, you can initialize the devices via
port J. If you connect port J to a system, you must change the previous IP address.
² Connect the device to the corresponding USB interface of your computer.
²

In the DIGSI 5 operating program right-click the device to be initialized.

²

Click the Load Configuration in Device menu item.

DIGSI 5 then accepts the connection to the device and loads the complete parameterization into the device.
This process takes some time.

[scstartsc-270814-01, 1, --_--]

Figure 7-11

Display during Transfer

Once the transfer is completed, the device executes a reset and is in the startup mode. Once this status is
finished, the display image appears and the green LED (Run) lights up. The red LED (Error) must be off.
The display image contains information about the basic device type, for example, transformer protection, the
firmware version (FW), and the loaded parameterization version. In SIPROTEC 5, this is called Configuration
(CFG).
If a display image is adjusted in the parameterization, then the device switches to this display state after
several seconds. The set display image, for example, the measured-value display, should appear.
If you wish verify the loaded parameterization randomly, you can execute a check through the on-site operation panel. Log in and follow the menu. Read the user instructions in chapter 5 Using On-Site Operation Panel.
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Alternatively, you can also verify the parameterization with DIGSI 5. To do this, activate the online mode and
establish connection to the device. Then open the settings comparison between the online device and the
offline device in the project.
During the initialization, the serial number of the device is transferred to the offline project. Alternatively you
can also enter the serial number by hand in the offline device.

7.3.4

Testing Readiness for Operation
With the execution of the points in chapter 7.3.3 Initializing Device and Verifying Basic Status, the device is
ready for operation. If devices are built into cabinets, additional wiring and communication connections are
necessary. Subsequent checks can be made in preparation for the secondary test. To do this, you can make
use of numerous test aids available in the device, which are described in chapter 7.2 Test Suite Integrated in
the Device.
Siemens recommends the following procedure in the order:
² Testing binary inputs and outputs
Check the correct connection from the transmission terminal to the device and the binary inputs and
outputs as well.
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²

Testing voltage and current inputs
Using multi-phase test equipment, apply the corresponding test quantities and check the results. To do
this, make use of the testing options in the device (see chapter 7.2.2 Testing Current and Voltage Inputs).
In addition, you can verify the measured values directly on the device by going to the respective function
group for the operational measured values. You will find a more clearly arranged description in the DIGSI
5 operating software. You are connected online with the device and open the menu item Measurement.

²

Checking communication interfaces
You can set the state of signals transferred via communication interfaces. This allows you to check, for
example, the connection to systems control. In the communication diagnosis you will find helpful information, for example, about data traffic on a communication interface.

²

Checking time synchronization
The device is synchronized by a maximum of 2 independent time sources. In online operation, under
Device information, click the diagnosis page for time synchronization. The delivered specific values
(UTC) of the 1st and 2nd time source (if available) are shown. The internal time of the device which
results from the time information of the active time source is likewise shown.
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7.4

Secondary Tests

7.4.1

Scope of Inspection and Methodology
The secondary test objectives are:
• Checking the transformer burdens, checking the transformer data of the main current and voltage transformer

•

Checking the routing of signals to the most varied targets (binary inputs (BI), binary outputs (BO), LEDs,
and interfaces)

•
•

Checking function charts (CFC) in the device
Checking the interactions between devices, for example, exchange of information or measured values via
interface

•

Checking the correct setting of protection functions and the interaction of protection functions (for
example, circuit-breaker failure protection, automatic reclosing)

•

Checking communication with a systems control

You can proceed in different ways depending on problem definition and test objective. To simplify the inspection effort, the application of test programs of digital test equipment is recommended. During a secondary
test, you do not have to go through all characteristic-curve points. That is the subject matter of an acceptance
test. Focus on characteristic values. These are pickup values, operate times, and the interaction between functions as well as devices.
In this test you can also make use of integrated test functions and hence reduce the expense on test technology. Pickup values and the reaction of the protection function can be checked easily with the sequencer
(see chapter 7.2.3 Testing Protection Functions).

!

WARNING
Warning of danger from secondary tests
Noncompliance with safety notes can result in death, serious injuries, or considerable material
damage.
²

Secondary tests must only be carried out by personnel who are qualified electricians and are familiar
with the commissioning of protection systems, the operation of the system, and with safety regulations and provisions (switching, grounding, etc.).

²

Make sure that there are no connections to the primary system during the secondary test.

In the secondary test it is assumed that there are still no connections to the primary system. But if you do this
in the primary system, special safety conditions must be followed.
² Consider that no other measurands are locked in, unless otherwise indicated.

7.4.2

²

Consider that the trip and close commands to the circuit breakers are interrupted, unless otherwise indicated.

²

Take note of the general instructions in chapter 7.5 Primary Tests.

Recommendation for Testing of Functions
Only general recommendations are given in this manual. Please refer to the respective Device manual for the
function-specific instructions to be followed. Remember also that a deviation from the expected functionality
can have its cause in an erroneous test sequence.

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

97

Commissioning
7.4 Secondary Tests

Testing of Protection Functions

•

Before checking, familiarize yourself first with the measuring principle of the protection function in the
Device manual and consider the test recommendations given in the Device manual.

•

Perform the tests using multi-phase test equipment since numerous protection functions require a 3phase system.

•

You can test most protection functions using stationary signals. Some protection functions require transient signals. Typical examples are the testing of protection reaction on power swings (power-swing
blocking in distance protection and out-of-step protection) and the transient effect on transformers. They
generate transient test files with a dynamic network calculation program or these test files are provided
by special test programs.

•

If setting values are offered only in percent or per unit, remember that the setting values refer only to
rated quantities of the protected object. Secondary test quantities must be converted using the transformer ratio.

•

Perform the tests successively. Activate only the function that you wish to test. Make use of DIGSI 5
support (see chapter 7.2.3 Testing Protection Functions).

•

Since protection functions can be assigned to different protection function groups, check the interaction
between function groups as well. If you have created your own application template or modified the
delivered template, Siemens recommends that you check the interaction. The application templates
provided with the device have been tested.

•

Check the reaction of the protection functions via the indications in the corresponding logs. The indications in the spontaneous indication log (available in online mode), which are shown at the moment of
occurrence, are a good tool. Testing using the fault record (binary signal traces in relation to the input
variables) is also advisable for transient processes.

•
•

Check the correct routing of signals of the protection function.
Check individual protection functions in the test editor using signals from test equipment or the internal
signal generator (sequences). Examine the test sequence in the characteristic curve of the protection
function and its spontaneous indications.

Checking Function Charts (CFC)

•

Created logics (function charts) must be tested. A working relationship with the engineering department
is necessary for this purpose. Familiarize yourself first with the objective of the function chart. DIGSI 5
offers you a tracing function during offline operation. This allows you to verify the correct logical
sequence by loading the function chart with test sequences and following the reaction in the function
chart. Switchgear interlockings and other logic can be tested easily with it.

•

If the logic reacts to transient changes, you must perform dynamic tests. To do this, generate the necessary test sequences and load them into the device. You can then provide inputs or outputs for tracing in
the function chart. The exact temporal sequence of signals is then logged in a fault record during the
progress of the test sequence. This can be analyzed, for example, using SIGRA and the runtimes and time
differences analyzed. This is a very good way of checking and simultaneously documenting behavior over
time (file export in PDF format).

Checking Control Functions
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•

Switching of switching devices requires that the switchgear interlockings are properly executed and that
the correct signals are fed to the logic. Perform the corresponding tests. Check the switchgear interlocking by simulating the corresponding input variables and checking the reaction on the output.

•

If you perform on-site control with the device, check the on-site control diagram in devices with large
display. Select the respective switching device and check the different switching operations. Check the
reaction on the outputs.

•

In devices with small display, select the switching device (selection via text) and execute the switching
operation as well.
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7.4.3

•

Since measured values are also displayed apart from switching devices in the display diagram, check the
proper assignment of measured values by feeding and changing the test quantities.

•

Tap changer position commands and control commands for arc-suppression coils can be checked via
DIGSI 5. Check the corresponding relay outputs and feedbacks via binary inputs or communication interfaces.

Testing Interfaces in the Compound System
Besides binary inputs and outputs, communication between devices occurs via serial communication interfaces. Test instructions are hereinafter given for the following applications:

Protection Communication Between Devices
A typical application is communication between line differential protection devices. The main protection function is differential protection which requires a functioning data connection between devices. Please refer to
the Device manual for checking the Differential protection function.
A 2nd application is communication between devices by transferring binary signal and measured values (for
example, remotely from the opposite end). You generate test signals with the communication test by setting
signals to be transmitted systematically in the transmitter and checking their receipt. Please refer to the
chapter Protection Interface in the Device manual for the necessary test items.
GOOSE Communication Between Devices
GOOSE communication is possible only with the IEC 61850 protocol. Check whether the interfaces and
switches are parameterized properly. Familiarize yourself with the information that is to be transmitted via
GOOSE (Generic Object Oriented Substation Event). Using external test programs such as the GOOSE
Inspector, you can automatically check all GOOSE connections configured in the SCD file. In the event of
missing connections, check the GOOSE parameterization of the transmitting device.
Communication Between Device and Control Center
Various protocols are available to you for communicating with a control center (station or network control
center). Besides DNP3 and IEC 60870-5-103, the IEC 61850 protocol has emerged as the leading protocol. The
test requires the exchange of parameterizations between the protection device and the systems and control
device. Test telegrams for the communication interfaces can be created using the editor described in
7.2.4 Creating Signals for Communication Interfaces. When setting states in the device, the corresponding
telegrams are sent via all existing systems and control protocols.
The test sequencer can be another test source (see chapter 7.2.3 Testing Protection Functions). You can bring
a protection function systematically towards pickup and release using the test sequencer. A fault record is also
simultaneously created during the process. In the systems control, check, for example, that the correct indications are coming and the fault record was correctly received. In case of a longer sequence you can also verify
the measured values. In addition, check communication in the direction of the device. If switching commands
are controlled by the systems control, check proper execution.
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7.5

Primary Tests

7.5.1

Testing System Integration
A requirement for the primary test is that prior tests (chapter 7.3 Initial Startup and 7.4 Secondary Tests) were
completed successfully. Take note of the following before starting the test:

General Notes

!

DANGER
Danger due to hazardous voltages during the operation of electric devices
Noncompliance with the safety notes will result in death or severe injuries.
²

!

Only electrically qualified personnel may work on these devices. The electrically qualified personnel
must be thoroughly familiar with pertinent safety regulations and precautionary measures as well as
the warnings in this manual.

WARNING
Warning of hazards due to improper primary trials
Noncompliance with safety notes can result in death, serious injuries, or considerable material
damage.
²

Primary trials may be performed only by personnel who are skilled electricians and who are familiar
with the startup of protection systems, with the operation of the system and with safety regulations
and provisions (switching, grounding, etc.).

You must perform switching operations for the commissioning. The described tests require that they can be
done without danger. They were not conceived for operational checks.
You must follow pertinent safety regulations (VDE 105-100/A1, BGV A3/VBG 4).
Before starting work you must take note of 5 safety regulations:
• Isolate from the power supply

•
•
•
•

100

Safeguard against reclosing
Establish zero potential
Ground and short-circuit
Cover or cordon off neighboring live parts
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!

CAUTION
You must ground the device at the grounding terminal before making the connections. There may be
hazardous voltages in all switching components linked to the power supply and to measurands or test
quantities. There may be hazardous voltages in the device (capacitor storage of the current supply) even
after disconnecting the supply voltage.
Noncompliance with the safety notes will result in death or severe injuries.

!

²

To reach the defined initial conditions after switching off the auxiliary voltage, wait at least 10 s
before restarting the auxiliary voltage.

²

Do not exceed the limiting values indicated under Technical Data of the Device manuals, even during
testing and commissioning.

DANGER
Hazardous voltages during breaks in current transformer secondary circuits
Noncompliance with the safety notes will result in death or severe injuries.
²

Short-circuit the secondary connections of the current transformer before the electrical lines to the
device are disconnected.

²

In the presence of a test switch which shorts the current transformer secondary line automatically, it is
sufficient to bring this switch to the Test position, provided you checked the short-circuiting device
beforehand.

NOTICE
Pay attention when wiring the safety cabinet to the system
Noncompliance with the safety notes will result in material damage.
²

Before the 1st test, wire the safety cabinet to the system. You must check the wiring of the connections to the primary system.

²

Test all connections, including polarity of transformers. In voltage transformers with broken-delta
winding make sure that they are not short-circuited.

²

Place the device under auxiliary voltage.

²

Establish an online connection to the device. You can verify the signals at the binary inputs under the
Test suite → Wiring menu item.

²

Compare the entries under the binary inputs/outputs and LEDs with the system status.

²

Check whether signaling contacts are connected to the correct binary input.

²

Check the proper functioning of the voltage-transformer circuit breaker and the wiring on the corresponding binary input.

²

Check the correct wiring of blocking and release inputs.

²

Click the Binary output menu item and check the status. Apart from those in closed circuits, the contacts
are open.

²

To check the connection to the switching device, activate a specific binary output. Proceed very carefully
here.
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i

i
7.5.2

NOTE
Before you perform this test, make sure that the respective system part is isolated and a switching operation can be executed safely.
²

Once you have activated the switching device, check the feedbacks.

²

In the menu, go to Test suite → Analog inputs and check the voltage and current inputs. The relevant
measurands must have the value 0 in the de-energized switch position.

²

Using test equipment parallel to the transformers, feed stationary test quantities and check the measured
values. Take note of the absolute value and phase as well as the correct phase sequence.

NOTE
If additional signals such as from a substation automation technology are coupled, perform the corresponding tests (see chapter 7.4 Secondary Tests).

Methodical Procedure for Primary Tests of Functions
The scope of primary tests depends on the type of system. To check proper system integration, various
primary tests are performed in power plant systems. The generator delivers the necessary test quantities
based on the operating mode. Please refer to the Device manual for multifunctional machine protection for
details.
The scope of inspection is much smaller in power system protection applications. It boils down to a direction
check in the broadest sense. Differential protection tends towards overfunction in the case of sensitive setting
and a wiring error. Every function can be switched in a special mode to avoid unnecessary activation of the
circuit breakers. It is ready to function but the trip command is not switched further (see Function descriptions
in the Device manual). In the desired function, switch the Mode parameter to Test. The trip signal is supplied
with a test bit. The tripping contacts in the device are not activated and hence the circuit breaker is not actuated by the protection.
If you enter these settings for the differential protection, make sure that at least one overcurrent protection is
active as backup protection. Once all preliminary measures are complete, you can begin with the actual
primary test.
² First check that you can produce a non-critical switch position and that you have a specific power flow.
The possible load current must be greater than 10 % of the rated load. Avoid a maximum load.
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²

Switch on the circuit breaker (for example, with synchrocheck) and check the measured values.

²

In the online mode open the editor Test suite → Analog inputs and check whether the phasor values of
the measuring points are plausible (absolute value, phase, phase sequence).

²

Check the phase displacement of the current and voltage phasors with each other.

²

Check the operational measured values per function group.

²

In the Operational indications tab, check the direction indirectly via the measured values for active and
reactive power. If the power flow is to the protected object (for example, line) and an ohmic inductive
load is assumed, the active and reactive power must assume positive values. The order of magnitude of
the measured values determines the current load. If 2 protection devices are connected, both must show
the same value.

²

Click the Fund. comp./sym.comp. tab. You can verify the direction of rotation using positive-sequence
and negative-sequence system quantities. The negative-sequence system quantities must be 0.

²

If deviations arise during the tests, check the selected settings (for example, current transformer neutral
point, phase sequence, etc.) and the interface in a 2nd step.
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i

NOTE
Using wiring modifications switch the primary system to the de-energized state.
You can do tests specific to protection functions via the operational measured values. To do this, click the
Function meas. values tab. In a differential protection function, the differential currents must be 0 and the
corresponding restraint current available.
You get a graphical visualization if you click Test → Protection function. Apart from the set characteristics,
you see the functions relevant to protection.
² To be 100 % sure about the direction setting in a directional overcurrent protection, make use of the test
functionality integrated in the protection function.

7.5.3

²

Place the protection function in test mode by activating the binary input signal (>Test of the
direction).

²

Analyze the indication behavior of the protection function according to the selected setting.

²

Deactivate the test mode by terminating the binary signal again.

²

With active protection you can continue the testing of the switching devices. Check the on and off
switching of the circuit breaker.

²

With the circuit breaker switched off, check the activation of disconnectors and the corresponding interlocking mechanisms.

Testing Measured Values During Operation
Checking the operational measured values for plausibility is a simplified test of components of the primary
system (transformer, wiring) and of secondary equipment (measured-value acquisition including measuredvalue processing). You can set a default display in the device display that also contains the measured values.
Several measured-value windows are preadjustable and can be further switched if needed. Check these measured values for plausibility.
² If you wish to check measured values more precisely, follow the device menu and navigate to the corresponding measured values.
²

Alternatively, you can set parameters for a function key so that directly jumping to the desired menu is
possible.

Online operation with DIGSI 5 provides a good complete overview. You will find the relevant measured values
in Measurements for the respective function group. If there is a communication connection to systems
control, measured values that the operational crew can verify are also transmitted here.
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8.1 Overview

8.1

Overview
This chapter describes the handling of a SIPROTEC 5 device in the operating state. It contains the following
information:
• Reading information from the device

•
•

Affecting the functions of the device in the operating state
Controlling your system via the device

More detailed information about the function of the device is not needed. You must with be familiar with the
principles of operation according to chapter 5 Using On-Site Operation Panel and chapter 6 Using DIGSI 5.
Take note that the examples shown are general examples and in terms of wording and detail can vary on the
given device depending on variant and configured functional scope. Please refer to the respective device
manual for the process data that your device can process.
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8.2

Safety Notes and Access Rights

8.2.1

Safety Notes

Authorized Operational Crew

!

DANGER
Danger due to inadmissible or improper operator control actions
Noncompliance with the safety notes will result in death or severe injuries.
²

²

i

Only personnel who are skilled electricians with precise knowledge of the system may operate devices
during operation.
Please carry out all operator control actions in the indicated sequence.

NOTE
Operator control actions are password-protected (see chapter 10 Security Settings in the Device). This
ensures that only operational crew members with access rights can use the device during operation.
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8.3

Operation Options

8.3.1

General
The device is operated via a DIGSI 5 PC or directly on the on-site operation panel. You have the following operating options during operation:
• Readout of indications

•
•
•
•
•
•
•

Readout, backup, and deletion of indication memories and records
Setting and resetting event counters
Changing device settings such as date, time, display contrast (only on site on the device) and interface
language
Changing passwords (only with DIGSI 5)
Changing function parameters and switching settings groups
Switching operating modes (for example, test mode)
Controlling equipment

i

NOTE

i

NOTE

DIGSI 5 Communication
Operation using a DIGSI 5 PC requires a functioning communication connection from the DIGSI 5 PC to the
device. For this purpose, you can use the USB interface of the on-site operation panel, the integrated or
other Ethernet interfaces.

Protection from Operating Errors and Unauthorized Access
• Changes to device settings and the deletion of process data can be saved by entering confirmation
IDs. If no action takes place within certain times (device: 3 minutes, DIGSI 5: 10 minutes), an open
confirmation query is automatically terminated. Every action carried out within these times restarts
the time. After a confirmation query has ended you must confirm changes in device settings again by
entering confirmation IDs.

•

8.3.2

Before modified settings or the activation of control commands is accepted, there will be additional
requests to enter the confirmation ID. You acknowledge these requests directly on the on-site operation panel by pressing the softkey buttons. You confirm the interactive dialog in DIGSI 5 by mouse
click.

Online Operation Using DIGSI 5
During online operation, you establish a direct connection to the device to be operated. You use this method
for:
• Commissioning

•
•

Test and diagnostics
Changing settings in the operating state

Online operation with DIGSI 5 is beneficial in these operating modes because you do not first have to create a
device in a project. As soon as you have created the corresponding device in a project, however, you should
only operate the device from there. Your settings are then saved on your PC and are available for offline
configuration and parameterization tasks.
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Procedure
²

First, identify all devices reachable via the PC communication interfaces. You can identify your device via
the DIGSI 5 project tree.

²

Establish a connection to a selected device.

²

If needed, you can assign a selected device to an existing project.

Device Identification via the DIGSI 5 Project Tree
²

Select the utilized PC interface from Online access (a).

²

Click the Update accessible devices button (b).

The accessible users (devices) are displayed to you (c).

[scgerinf-220211-01.tif, 1, en_US]

Figure 8-1

Device Identification via the DIGSI 5 Project Tree

Establishing Connection to Selected Devices
After device identification, the accessible devices are displayed in the project tree under the respective
communication interfaces of the PC. You can now establish a connection to the devices.

[scwalger-110413-01.tif, 1, en_US]

Figure 8-2

Device Identification via the DIGSI 5 Project Tree

²

Open the designated device (a) under Online access → Interface.

²

The basic information will be displayed below the device.

²

You will find the product code, performance data, log, time settings and hardware information under
Device Information .

²

If you click Read process data, you can read the parameter set and process data of the device. The
device data is loaded and the view completed.

²

You can fully operate and set the connected devices under Online access in the DIGSI 5 project tree.
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Adding a Selected Device to a Project
You can accept devices identified online into an existing project. The devices are also available for possible
offline operation. You can accept the devices in 2 ways:
² Use Drag & Drop to assign the online device to the corresponding device created in a project.

i

NOTE
Make sure that the created device coincides with the device identified online. Otherwise, it is not accepted
into the project.
²

If you have not done so yet, add the online device to the opened project (see following image) via the
context menu (right mouse-click).

[scprohin-210211-01.tif, 1, en_US]

Figure 8-3

8.3.3

Adding Selected Device to a Project

Offline Operation Using DIGSI 5
Offline operation offers you the ability to carry out complete configurations and extensive parameterization of
a device. Once you have finished all settings, you can load the complete parameter set from the DIGSI 5 PC to
the device. If the loading operation was successful, the device restarts automatically.

Typical Applications of Offline Configuration

i

²

Creating a parameter set by selecting a suitable application template and subsequently adjusting the
settings to the individual conditions

²

Reusing a standardized parameter set in several devices

²

Extensive changes in configurations and setting parameters

NOTE
For a device to be editable offline, you must first have created it in a project. After successful loading of the
parameter set, the device restarts automatically.

Procedure
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²

From the project tree, select the project where the device to be controlled was created.

²

Select the respective device within the project.
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²

Open the device.

²

You can now carry out configurations and settings in offline mode.

All the corresponding submenus are listed in the project tree under the device name.

[scproans-110413-01.tif, 1, en_US]

Figure 8-4

Offline Operation of the Device

²

Once you have finished making changes in the device, you can load the complete parameter set from
your DIGSI 5 PC to the device.

²

To start a connection to the device, right-click the device and from the context menu that appears select
Connect to device (Figure 8-5 a).

²

To load the parameter set to the device, tag the device with the mouse. Right-click with the mouse and in
the context menu that appears, select Load configuration in device (Figure 8-5 b).

The parameter set is transferred and the device restarts automatically after successful transfer.
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[scladpar-020211-01.tif, 1, en_US]

Figure 8-5

8.3.4

Connecting to the Device and Loading the Parameter Set in Offline Mode

Using the On-Site Operation Panel
You can operate the device directly on the on-site operation panel even without a DIGSI 5 PC. A numerical
keypad, navigation and function keys are available to you for this purpose. You have the option between a
small or large display.
LEDs allow the display of binary output signals. Key switches offer you optional additional safety for switching
operations. You will find detailed descriptions of components of the on-site operation panel and of navigation
in the device menu tree in chapter 5 Using On-Site Operation Panel.
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8.4

Indications

8.4.1

General
During operation, indications deliver information about operational states. These include:
• Measured data

•
•
•
•

Power-system data
Device supervisions
Device functions
Function procedures during testing and commissioning of the device

In addition, indications give an overview of important fault events after a failure in the system. All indications
are furnished with a time stamp at the time of their occurrence.
Indications are saved in logs inside the device and are available for later analyses. The following number of
indications are saved at least in the respective buffer (depending on the scope of the indications):
• Ground-fault log 100 indications

•
•
•

Fault log 1000 indications
User-defined log 200 indications
Operational log 2000 indications

If the maximum capacity of the user-defined log or of the operational is exhausted, the oldest entries disappear before the newest entries. If the maximum capacity of the fault log or of the ground-fault log is reached,
the number of the last fault is issued via the signal Fault log is full. During a supply-voltage failure, recorded
data are securely held by means of battery buffering or storage in the flash memory. You can read and analyze
the log from the device with DIGSI 5. The device display and navigation using keys allow you to read and
analyze the logs on site.
Indications can be output spontaneously via the communication interfaces of the device and through external
demand via general interrogation. In DIGSI 5 indications can be tracked spontaneously in online operation in a
special indication window. Indications can be made accessible to higher-level control systems through
mapping on various communication protocols.

i

NOTE
All indications are assigned to certain device functions. The text of each indication contains the corresponding function designation. You will find explanations of the meaning of indications in the corresponding device functions. However, you can also define indications yourself and group them into your
own function blocks. These can be set by binary inputs or CFC logic.

Reading Indications
To read the indications of your SIPROTEC 5 device you can use the on-site operation panel of the device or a PC
on which you have installed DIGSI 5. The subsequent section describes the general procedure.

8.4.2

Reading Indications on the On-Site Operation Panel

Procedure
The menus of the logs begin with a header and 2 numbers at the top right corner of the display. The number
after the slash signifies the number of indications that are available. The number before the slash indicates
how many indications have just been selected or shown. The end of the indication list is closed with the entry
***END***.

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

113

Operation in the Operating State
8.4 Indications

[scoprlog-090413-01.tif, 1, en_US]

Figure 8-6

i
8.4.3

On-Site Display of an Indication List (Example: Operational Indications)

Menu Path

Log

Main menu → Indications →

Operational log
Fault log
Ground-fault log
Setting changes
User indications 1
User indications 2

Main menu → Test & Diagnosis → Indications →

Security indications
Device diagnosis
Communication indications

²

To reach the desired log from the main menu, use the navigation keys of the on-site operation panel.

²

Navigate inside the log using the navigation keys (top/bottom). You will find the most current indication
at the top of the list. The selected indication is shown with a dark background.

²

Which indications can be shown in the selected log depends on the assignments in the DIGSI 5 information routing matrix or is pre-defined. You will find information about this in chapter 8.4.5.1 General.

²

Every indication contains date, time and its state as additional information.

²

In some logs you are given the option of deleting the entire indication list by softkey in the footer of the
display. To know more about this, read chapter 8.4.6 Saving and Deleting the Logs.

NOTE
No password entry is necessary to read indications from the device.

Reading Indications from the PC with DIGSI 5

Procedure
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Menu Path (Project)

Log

Project → Device → Process data → Log →

Operational log
Fault log
Ground-fault log
Setting changes
User indications 1
User indications 2
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Menu Path (Project)

Log

Project → Device → Device information → Log →

Security indication
Device diagnosis
Communication indications

²

To read the indications with DIGSI 5 your PC must be connected via the USB user interface of the on-site
operation panel or via an Ethernet interface of the device. A direct connection to your PC can be established via the Ethernet interfaces. It is also possible to access all connected SIPROTEC 5 devices via a data
network from your DIGSI 5 PC.

²

To reach the desired logs of the SIPROTEC 5 device, use the project-tree window. If you have not set up
the device within a project, you can also attain this via Online access.

²

After selecting the desired log, you are shown the last state of the log loaded from the device. To update,
it is necessary to synchronize with the log in the device.

²

To execute a synchronization with the logs, click the respective button in the headline of the log (see
example of ground-fault log in Figure 8-7 a)).

[scgrflmd-191012-01, 1, en_US]

Figure 8-7

DIGSI 5 Display of an Indication List (Example of Ground-Fault Log)

²

You will find additional information about the deletion and saving of logs in chapter 8.4.6 Saving and
Deleting the Logs.

²

To determine a relative time for all other indications, you can reference the display of log entries, if
needed, to the real time of a certain entry. The real-time stamps of events remain unaffected.

²

For this purpose click the respective button in the headline of the log (see example of ground-fault log in
Figure 8-7 a)).

Setting Relative Time Reference
²

8.4.4

Which indications in the selected log can be displayed depends on the assignments in the DIGSI 5 information routing matrix or is predefined. You will find information about this in chapter 8.4.5.1 General.

Displaying Indications
Displayed indications in DIGSI 5 and on the on-site operation panel are supplemented with the following information:
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Table 8-1

Overview of Additional Information

Indications in

DIGSI 5 Information

Device Display Information

Log for operational indications
and log for user-defined indications

Time stamp (date and time),
Relative time,
Increasing entry number,
Value,
Indication number,
Quality,
Cause

Time stamp (date and time),

log for fault indications

Time stamp (date and time),
Relative time,
Error number,
Increasing entry number,
Value,
Indication number,
Quality,
Cause

Time stamp (date and time),

Time stamp (date and time),
Relative time,
Error number,
Increasing entry number,
Value,
Indication number,
Quality,
Cause

Time stamp (date and time),

Time stamp (date and time),
Error number,
Increasing entry number,
Value,
Indication number,
Quality,
Cause

Time stamp (date and time),
Error number,

Log for ground-fault indications

Spontaneous indication window
(DIGSI 5)

Value

Error number,
Value

Error number,
Value

Value

DIGSI 5: Quality Indication Column
Quality

Meaning

Good

Indication is valid

Invalid

Indication is invalid

DIGSI 5: Additional Information Indication Column
The entries in the column for additional information are in the format Cause/Originator/Additional Cause:
• Cause → What was the cause?

•
•

116

Originator → Who was the originator?
Additional cause → Supplementary notes

Cause

Meaning

Data change

Value change in an indication

Data update

Update of notification value

General interrogation

General interrogation
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Cause

Meaning

Cyclic

Cyclical general inquiry

Quality change

Change of the notification quality

Initiator

Meaning

Bay

Control local

Substation

Control via the substation

Remote control

Control via the network control center

Field (auto)

Control local via automatic function

Station (auto)

Control via the station via automatic function

Distance (auto)

Control via the network control center via automatic
function

Maintenance

Maintenance

Process

Device operation (normal)

Additional Cause

Meaning

Switching authority test failed

Switching authority check failed

Selection failed

Selection failed

invalid position

invalid position

Position attained

Position attained

Settings change running

Settings change running

Final position attained

Final position attained

Impermissible mode

Impermissible mode

Blocking through process

Blocking by the process

Interlocked

Interlocked

Synchrocheck failed

Synchrocheck failed

Command already running

Command already running

Not ready

Not ready

1 out of N control failed

1 out of N control failed

Command cancellation

Command cancellation

Monitoring time expired

Monitoring time expired

Cancellation due to trip command Cancellation due to trip command
Object not selected

Object not selected

No access right.

No access right

Final position exceeded

Final position exceeded

Target value not attained

Target value not attained

Loss of connection

Loss of connection

Unknown

Unknown

Blocking through command

Blocking through command

Object already selected

Object already selected

Inconsistent parameter(s)

Inconsistent parameter(s)

Blocked by foreign access

Blocked by foreign access

Select time-out

Select time-out

CB not open

Circuit breaker not open

Communication is interrupted

Communication is interrupted

Topology not stable

Topology not stable

FLO in process

Fault locator in processing

Trigger command active

Trigger command active

Close command active

Close command active
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Additional Cause

Meaning

Blocked through protection

Blocked through protection

Fault occurred

Fault occurred

CB not closed

Circuit breaker not closed

CB not ready

Circuit breaker not ready

CB not open

Circuit breaker not open

Close command active

Close command active

CB check running

Circuit breaker check running

8.4.5

Logs

8.4.5.1

General
Indications are saved in logs inside the device and are available for later analyses. Different logs allow categorization of indication logging based on operating states (for example, operational and fault logs) and based on
fields of application.
Table 8-2

Log Overview

Log

Logging

Operational log

Operational indications

Fault log

Fault indications

Ground-fault log

Ground-fault indications

Setting-history log

Setting changes

User-defined log

User-defined indication scope

Security log

Access with safety relevance

Device-diagnosis log

Error of the device (software, hardware) and the connection circuits

Communication log

Status of communication interfaces

Motor-startup log

Information on the motor startup

Managing Logs
Logs have a ring structure and are automatically managed. If the maximum capacity of a log is exhausted, the
oldest entries disappear before the newest entries. If the maximum capacity of the fault or ground-fault log is
reached, the number of the last fault is generated via the signal Fault log is full. You can route this signal in
the information routing. If indications in the information routing of DIGSI 5 are routed to a log, then they are
also saved. During a supply-voltage failure, recorded data are securely held by means of battery buffering or
storage in the flash memory. You can read and analyze the log from the device with DIGSI 5. The device
display and the navigation allow you to read and evaluate the logs on site using keys.
Configurability of Logs
The indication capacity to be recorded in configurable logs (for example, ground-fault log) is laid down in
columns of the information routing (matrix) of DIGSI 5 specifically defined for this purpose.
Procedure
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•

To reach the information routing of your SIPROTEC 5 device, use the project-tree window. Access is only
through the project:
Project → Device → Information routing

•

Select the associated routing column in the matrix from:
Target → Log → Column ground-fault log
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•

The routing of the selected indication is done via right click. Select one of the options in the list box
shown:
–
Routed (X)
–

Unrouted

[scinfpuf-191012-01, 1, en_US]

Figure 8-8

Indication Configuration in DIGSI 5 (Example: Ground-Fault Log)

For non-configurable logs (for example, setting-history logs) scope and type of logged indications are
described separately (see following chapter about logs).
8.4.5.2

Operational Log
Operational indications are information that the device generates during operation. This includes information
about:
• State of device functions

•
•

Measured data
Power-system data

Exceeding or dropping below limiting values is output as an operational indication. Short circuits in the
network are indicated as an operational indication Fault with sequential fault number. For detailed information about the recording of system incidents, please refer to the description of the fault log (chapter
8.4.5.3 Fault Log ). Up to 2000 indications can be stored in the log.
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Reading from the PC with DIGSI 5

•

To reach the operational log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process Data → Log → Operational log

•

The status of the operational log last loaded from the device is shown to you. To update (synchronization
with the device) click the button Read log entries in the headline of the indication list ( Figure 8-9 a)).

[scbetrmd-030211-01, 1, en_US]

Figure 8-9

Reading the Operational Log with DIGSI 5

Reading on the Device Through the On-Site Operation Panel

120

•

To reach the operational log via the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Indications → Operational log

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.
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[scoprlog-090413-01.tif, 1, en_US]

Figure 8-10

On-Site Display of an Indication List (Example: Operational Indications)

Deletability
The operational log of your SIPROTEC 5 device can be deleted. This is done usually after testing or commissioning the device. To know more about this, read chapter 8.4.6 Saving and Deleting the Logs .
Configurability
The indication scope of the operational log is configured in a specifically defined column of the information
routing (matrix) of DIGSI 5:
Target → Log → Operational log column
Selected application templates and functions from the library bring with them a predefined set of operational
indications which you can adjust individually at any time.
8.4.5.3

Fault Log
Fault indications are events which arise during a fault. They are logged in the fault log with real-time stamp
and relative-time stamp (reference point: fault occurrence) . Faults are numbered consecutively in rising order.
With fault recording engaged, a corresponding fault record with the same number exists for every fault logged
in the fault log. A maximum of 128 fault logs can be stored. A maximum of 1000 indications can be recorded
in each fault log.

Fault Definition
In general, a fault is started by the raising pickup of a protection function and ends with the cleared pickup
after the trip command.
When using an automatic reclosing function, the complete reclosing cycle (successful or unsuccessful) is preferably integrated into the fault. If evolving faults appear within reclosing cycles, the entire clearing process is
logged under one fault number even in multiple pickup cycles. Without automatic reclosing function every
pickup is also recorded as its own fault.
User-defined configuration of a fault is also possible.

i

NOTE
The definition of the fault is done through settings of the fault recording (see Device manual). Events are
logged in the fault log even when fault recording is switched off.
Apart from the recording of fault indications in the fault log, spontaneous display of fault indications of the
last fault on the device display is also done. You will find details about this in chapter 8.4.8 Spontaneous Fault
Display on the On-Site Operation Panel.
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Reading from the PC with DIGSI 5

•

To reach the fault log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process Data → Log → Fault logs

The status of the fault log last loaded from the device is shown to you.
• To update (synchronization with the device) click the button Read log entries in the headline of the indication list.

[scstflmd-030211-01, 1, en_US]

Figure 8-11

Reading the Fault Log with DIGSI 5

Deletability
The fault log of your SIPROTEC 5 device can be deleted. Read about it in chapter 8.4.6 Saving and Deleting the
Logs.
Reading on the Device through the On-Site Operation Panel
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•

To reach the fault log from the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Indications → Fault logs

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.
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[scfaullg-090413-01.tif, 1, en_US]

Figure 8-12

Reading the Fault Log on the On-Site Operation Panel of the Device

Configurability
The indication scope of the fault log is configured in a specifically defined column of the information routing
(matrix) of DIGSI 5:
Target → Log → Fault log column
Selected application templates and functions from the library already bring a predefined set of operational
indications with them which you can adjust individually at any time.
The operational measured values and the measured values of the fundamental components and symmetrical
components (see Equipment Manual) are calculated every 9 cycles (at 50 Hz, this is every 180 ms). However,
this can mean that the data are not synchronized with the sampled values of the analog channels. The
recording of these measured values can be used to analyze the slowly changing processes.
8.4.5.4

Ground-Fault Log
Ground-fault indications are events which arise during a ground fault. They are logged in the ground-fault log
with real-time stamp and relative-time stamp (reference point: ground-fault occurrence) . Ground faults are
numbered consecutively in rising order. A maximum of 10 ground-fault logs are stored and for each groundfault log, it is guaranteed that at least 100 indications are recorded.
The following functions can start the logging of a ground fault with the raising ground-fault indication:
• Directional sensitive ground-fault protection for deleted and isolated systems (67Ns)

•
•

Sensitive ground current protection with I0 (50Ns/51Ns)
Intermittent ground-fault protection

The logging ends with the going ground-fault indication.
Reading from the PC with DIGSI 5

•

To reach the ground-fault log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process data → Logs → Ground-fault log

The status of the device-diagnosis log last loaded from the ground-fault log is shown to you.
• To update (synchronization with the device) click the button Read log entries in the headline of the indication list (Figure 8-13 a)).
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[scgrflmd-191012-01, 1, en_US]

Figure 8-13

Reading the Ground-Fault Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

•

To reach the ground-fault log from the main menu, use the navigation keys of the on-site operation
panel.
Main Menu → Indications → Ground-fault indication

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[scgfllg1-191012-01.tif, 1, en_US]

Figure 8-14

Reading the Ground-Fault Log on the On-Site Operation Panel of the Device

Deletability
The ground-fault log of your SIPROTEC 5 device can be deleted. Read about it in chapter 8.4.6 Saving and
Deleting the Logs.
Configurability
The indication scope of the ground-fault log is configured in a specifically defined column of the information
routing (matrix) of DIGSI 5:
Target → Log → Column Ground-fault log
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Selected application templates and functions from the library already bring a predefined set of operational
indications with them which you can adjust individually at any time.
8.4.5.5

Setting-History Log
All individual setting changes and the downloaded files of entire parameter sets are recorded in the log for
setting changes. This enables you to determine setting changes made are associated with events logged (for
example, faults). On the other hand, it is possible to prove with fault analyses, for example, that the current
status of all settings truly corresponds to their status at the time of the fault. Up to 200 indications can be
stored in the setting-history log.

Reading from the PC with DIGSI 5

•

To reach the log for setting changes of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process Data → Log → Setting changes

The status of the setting-history log last loaded from the device is shown to you.
• To update (synchronization with the device), click the Read log entries button in the headline of the
indication list (Figure 8-15).

[scparamd-030211-01, 1, en_US]

Figure 8-15

Reading the Setting-History Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

•

To reach the setting-history log from the main menu, use the navigation keys of the on-site operation
panel.
Menu → Indications → Setting changes

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[schislog-090413-01.tif, 1, en_US]

Figure 8-16

Reading the Setting-History Log on the On-Site Operation Panel of the Device
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Indication Categories in the Setting-History Log
For this log, there is selected information that is stored in case of successful as well as unsuccessful setting
changes. The following list gives you an overview of this information.
Table 8-3

Overview of Indication Types

Displayed Information

Explanation

Selection editing+

Selection of settings group to be edited

Reject+

Rejection of all changes successful

PG activation+

PG activation via command successful

PG activation-

PG activation via command failed

set+

Parameter value was changed

Acceptance+

Acceptance of change successful

Acceptance-

Acceptance of change failed

DCF loaded

DCF loaded into device

SG 1

Settings group 1

SG 2

Settings group 2

SG 3

Settings group 3

SG 4

Settings group 4

SG 5

Settings group 5

SG 6

Settings group 6

SG 7

Settings group 7

SG 8

Settings group 8

Example of Logging in Setting-History Log
For this log, there is selected information that is stored in case of successful as well as unsuccessful setting
changes. The following list gives you an overview of this information.
From top downward:
• In the example at the left, a device has started with
the active settings group 1.
Then
the settings group 1 is selected for changes.
•
• The individual parameter for phase-rotation
reversal was changed.
• The changes were successfully accepted.

i
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NOTE

•
•
•

The logged indications are preconfigured and cannot be changed!

•

You cannot route additional indication objects to the setting-history log.

This log, which is organized as a ring buffer. cannot be deleted by the user!
If you want to archive security-relevant information without loss of information, you must regularly
read this log.
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8.4.5.6

User Log
With the user-defined log (up to 2), you have the possibility of individual indication logging parallel to the
operational log. This is helpful, for example, in special monitoring tasks but also in the classification into
different areas of responsibility of the logs. Up to 200 indications can be stored in the user-defined log.

Reading from the PC with DIGSI 5

•

To reach the user-defined log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Process Data → Log → User log 1/2

The status of the user-defined log last loaded from the device is shown to you.
• To update (synchronization with the device) click the button Read log entries in the headline of the indication list (Figure 8-17 a)).

[scanwnmd-030211-01, 1, en_US]

Figure 8-17

Reading the User-Defined Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

•

To reach user-specific logs from the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Indications → User-defined log 1/2

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site operation panel.
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[scuserlg-090413-01.tif, 1, en_US]

Figure 8-18

Reading the User-Defined Log on the On-Site Operation Panel of the Device

Deletability
The user-defined log of your SIPROTEC 5 device can be deleted. Read about it in chapter 8.4.6 Saving and
Deleting the Logs.
Configuration of a User-Defined Log
The indication capacity of a created user-defined log can be configured freely in the associated column of the
information routing (matrix) of DIGSI 5:
Target → Log → U1 or U2

[scdiu1u2-280415-01, 1, en_US]

Figure 8-19
8.4.5.7

Indication Configuration in DIGSI 5 (Example: User-Defined Log U1/2)

Security Log
Access to areas of the device with restricted access right is recorded in the security log. Unsuccessful and
unauthorized access attempts are also recorded. Up to 500 indications can be stored in the security log.
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Reading from the PC with DIGSI 5

•

To reach the security log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Device Information → Log → Security log

The status of the security log last loaded from the device is shown to you.
To update (synchronization with the device) click the button Update in the headline of the indication list.

•

[scsecmld-140912-01, 1, en_US]

Figure 8-20

Reading the Communication Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

•

To reach the security log from the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Test & Diagnosis → Indications → Security log

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[scseclog-090413-01.tif, 1, en_US]

Figure 8-21

i

Reading the Security Log on the On-Site Operation Panel of the Device

NOTE

•
•
•

The logged indications are preconfigured and cannot be changed!
This log, which is organized as a ring buffer. cannot be deleted by the user!
If you want to archive security-relevant information without loss of information, you must regularly
read this log.
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8.4.5.8

Device-Diagnosis Log
The logging and the display of concrete instructions are done in the device-diagnosis log during
• Required maintenance (for example, battery supervision)

•
•

Identified hardware defects
Compatibility problems

Up to 500 indications can be stored in the device-diagnosis log. In normal operation of the device, it is sufficient for diagnostic purposes to follow the entries of the operational log. This specific significance is assumed
by the device-diagnosis log when the device is no longer ready for operation due to hardware defect or
compatibility problems and the fallback system is active.
Reading from the PC with DIGSI 5 in Normal Operation

•

To reach the device-diagnosis log of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Device Information → Log → Device-diagnosis log

The status of the device-diagnosis log last loaded from the device is shown to you.
• To update (synchronization with the device) click the button Update in the headline of the indication list.

[scdevdia-140912-01, 1, en_US]

Figure 8-22

Reading the Device-Diagnosis Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel in Normal Operation
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•

To reach the diagnosis log from the main menu, use the navigation keys of the on-site operation panel.
Main Menu → Test & Diagnosis → Indications → Device diagnosis

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

Operation in the Operating State
8.4 Indications

[scdevdia-090413-01.tif, 1, en_US]

Figure 8-23

i
8.4.5.9

Reading the Device-Diagnosis Log on the On-Site Operation Panel of the Device

NOTE

•
•

The device-diagnosis log cannot be deleted!
The logged indications are preconfigured and cannot be changed!

Communication Log
The logging of the respective status such as ensuing faults, test and diagnosis operation, and communication
capacity utilizations is done for all hardware-based configured communication interfaces. Up to 500 indications can be stored in the communication log. Logging occurs separately for each communication port of the
configured communication modules.

Reading from the PC with DIGSI 5

•

Use the project-tree window to reach the communication logs of your SIPROTEC 5 device.
Online access → USB → Project → Test suite → Communication module

•

Then select:
J:Onboard Ethernet → Communication log

The status of the communication log last loaded from the device is shown to you under the Time stamp item.
• To update (synchronization with the device) click the button Update in the headline of the indication list.
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[sccompuf-140912-01, 1, en_US]

Figure 8-24

Reading the Communication Log with DIGSI 5

Reading on the Device through the On-Site Operation Panel

•

To reach the communication log from the main menu, use the navigation keys on the on-site operation
panel.
Main Menu → Test & Diagnosis → Indications → Communication log

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[sccommlg-090413-01.tif, 1, en_US]

Figure 8-25

Reading the Communication Log on the On-Site Operation Panel of the Device

Deletability
The communication logs of your SIPROTEC 5 device can be deleted. Read details about this in chapter
8.4.6 Saving and Deleting the Logs.
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Configurability
The communication logs are not freely configurable. The entries are preconfigured.
8.4.5.10

Motor-Starting Log
The motor-starting log records the starting current, starting voltage and the start duration each time a motor
starts. The motor-starting current and the motor-starting voltage are displayed as primary values. Up to 200
indications can be stored in the motor-starting log.
Measurement of the motor statistics starts when the motor state changes to Start. Measurement of the
motor starting time ends as soon as the motor state changes to Standstill or Running. The motor state is
obtained from the Motor-state detection function.
No entry is recorded in the motor-starting log if the motor state changes to Start and the current drops
below the motor starting current within 500 ms.
Table 8-4

Motor-Starting Log

Measured Values

Primary

Start duration

Motor starting time

s

Starting current

Motor-starting current (primary)

A (or kA)

Starting voltage

Motor-starting voltage (primary)

V (or kV)

Reading from the PC with DIGSI 5

•

Use the project-tree window to reach the motor-starting log of your SIPROTEC 5 device.
Project → Device → Device Information → Log → Motor-starting log

The state of the motor-starting log last loaded from the device is shown to you.
• To update (synchronization with the device) click the button Update in the headline of the indication list.

[scmotmlp-160713-01, 1, en_US]

Figure 8-26

Reading the Motor-Starting Log with DIGSI 5
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Reading on the Device through the On-Site Operation Panel

•

To reach the motor-starting log from the main menu, use the navigation keys of the on-site operation
panel.
Main Menu → Indications → Motor-starting log

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

[scmotlog-160713-01.tif, 1, en_US]

Figure 8-27

Reading the Motor-Starting Log on the On-Site Operation Panel of the Device

Deletability
The motor-starting log of your SIPROTEC 5 device can be deleted. Read details about this in chapter
8.4.6 Saving and Deleting the Logs.
Configurability
The motor-starting log is only present in the Motor function group. There is no column for the motor-starting
log in the DIGSI information matrix. The entries in the motor-starting log are preconfigured and cannot be
changed.

8.4.6

Saving and Deleting the Logs
Deleting the logs of the device in the operating state is unnecessary. If storage capacity is no longer sufficient
for new indications, the oldest indications are automatically overwritten with new incoming events. In order
for the memory to contain information about the new faults in the future, for example, after an inspection of
the system, a deletion of the log makes sense. Resetting the logs is done separately for the various logs.
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i

NOTE

i

NOTE

i

NOTE

Before you delete the content of a log on your SIPROTEC 5 device, save the log with DIGSI 5 on the hard
disk drive of your PC.

Not all logs of your SIPROTEC 5 device can be deleted. These limitations apply especially to logs with relevance for security and after-sales (security log, device-diagnosis log, setting-history log).

Upon deletion of the fault log, the associated fault records are also deleted. In addition, the meters for fault
number and fault-record number are reset to 0. In contrast, if you delete fault records, the content of the
fault log, including the allocated fault numbers, remains.
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i

NOTE
If the device executes an initial start, for example, after an update of the device software, the following
logs are automatically deleted:
• Operational log

•
•
•
•
•

Fault log
Ground-fault log
Setting-history log
User log
Motor-startup log

Back up the deletable logs using DIGSI 5.

i

NOTE
If a ground fault is currently active, the ground-fault log cannot be deleted.

Deleting Logs on the On-Site Operation Panel

•

To reach the selected log from the main menu, use the navigation keys of the on-site operation panel
(example operational log):
Main Menu → Indications → Operational log

[scoprlog-090413-01.tif, 1, en_US]

Figure 8-28

Deleting the Operational Log on the On-Site Operation Panel

•

You can navigate within the displayed indication list using the navigation keys (up/down) on the on-site
operation panel.

•

The option to delete the entire log is offered to you in the footer of the display at the bottom left. Use the
softkeys below under the display to activate the command prompts. Confirm the request to Delete.

•
•

After being prompted, enter the password and confirm with Enter.
After being prompted, confirm the Deletion of all entries with Ok.

Deleting Logs from the PC with DIGSI 5

•

To reach the selected log of your SIPROTEC 5 device, use the project-tree window (for example, operational log).
Project → Device → Process data → Logs → Operational log
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8.4.7

Spontaneous Indication Display in DIGSI 5
With DIGSI 5 you have the possibility of displaying all currently transmitted indications of the selected device
in a special indication window.

Procedure

•

Call up the spontaneous indications of your selected device in the navigation window under Online
access.

•

Click Indications in the path:
Online access → Interface → Device → Indications

•

The raising indications appear immediately without you having to wait for a cyclical update or initiate the
manual update.

[scspnmld-230211-01, 1, en_US]

Figure 8-29

8.4.8

Displaying Spontaneous Device Indications in DIGSI 5

Spontaneous Fault Display on the On-Site Operation Panel
After a fault, the most important data of the last fault can be displayed automatically on the device display
without further operational measures. In SIPROTEC 5 devices, protected objects and even circuit breakers can
be freely created and configured depending on the application (even several instances). In DIGSI 5, several
spontaneous fault displays can be configured, depending on the application, with each individual one being
assigned a particular circuit breaker. These displays remain stored in the device until they are manually
confirmed or reset by LED reset.

Configuration of a Spontaneous Fault Display with DIGSI 5

•

136

To reach the Fault-display configuration of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Display pages → Fault-display configuration
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•

In the main window, all configured circuit breakers are displayed. A list of a maximum of 6 configurable
display lines is offered for each circuit breaker. The activation of a spontaneous fault display occurs for
each circuit breaker by selection via checkmark in the column Display.

•

With the parameter (_:139) Fault-display (under Device → Parameter → Device settings) you
determine whether spontaneous fault displays should be displayed for each pickup or only pickups with
the off command.

Figure 8-30

Configuration of the Spontaneous Fault Display
on the Device

For every display line the following display options can be selected:
Table 8-5

Overview of Display Options

Displayed Information

Explanation

Pickup indication

Display of the first function stage picked up in a fault, as
needed with additional information (phases, ground, direction).

PU time

Display of the entire pickup duration of the fault.

Operate indication

Display of the first function stage triggered in a fault, as
needed with additional information (phases).

Trip time

Display of the operate time related to the beginning of the
fault (pickup start).

Fault distance

Display of the measured fault-location distance.

Acknowledgement of the Spontaneous Fault Display on the Device
After faults, the last occurred fault is always displayed to you. In cases where more than one circuit breaker is
configured, several stored fault displays can be present after faults, with the latest being displayed. These
displays remain stored in the device until they are manually acknowledged or reset by LED reset.

[scstfanz-090413-01.tif, 1, en_US]

Figure 8-31

Spontaneous Fault Display on the Device

Method 1: Manual acknowledgement
• Press the softkey button Quit in the base bar of the display. The display is irretrievably closed. Repeat this
step until no spontaneous fault display appears anymore.

•

After completion of all confirmations the last display view is showed before the faults.

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

137

Operation in the Operating State
8.4 Indications

Method 2: Acknowledgement via LED reset
An LED reset (device) causes the reset of all stored LEDs and binary output contacts of the device and also
to the confirmation of all fault displays stored in the display.

•

You can find more details on the topic of LED reset in chapter 8.4.9 Stored Indications in the SIPROTEC 5
Device.

8.4.9

Stored Indications in the SIPROTEC 5 Device
In your SIPROTEC 5 device, you can also configure indications as stored. This type of configuration can be
used for LEDs as well as for output contacts. The configured output (LED or contact) is activated until it is
acknowledged. Acknowledgment occurs via:
• On-site operation panel

•
•
•

DIGSI 5
Binary input
Protocol of substation automation technology

Configuration of Stored Indications with DIGSI 5

•

In the Information Routing of each device set up in DIGSI 5, you can route binary signals, among others,
to LEDs and output contacts. For this, go to the project tree.
Project → Device → Information routing

•

Right-click the routing field of your binary indication in the desired LED or binary output column in the
routing range of the targets.

You are offered the following options:
Table 8-6

Overview of Routing Options

Routing Options

LEDs

BOs

BIs

Description

H

(active)

X

The signal is routed as active with voltage.

L

(active)

X

The signal is routed as active without voltage.

V

(unlatched)

X

X

The signal is routed as unlatched. Activation and reset of
the output (LED, BA) occurs automatically via the binarysignal value.

L

(latched)

X

X

The binary signal is latched when the output (LED) is activated. To reset, a targeted confirmation must occur.

NT

(stored only with tripping)

X
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Fault indications are stored when the output (LED) is activated. If the fault is ended via a trip command from the
device, the stored state is maintained. In case of dropout of
the pickup without trip command from the device (for
example, external fault), the state displayed before the
fault is restored.
Note:
Observe here the parameter (_:91:139)Faultdisplay with the setting options with trip or with
pickup. For this routing option, select the setting with
trip.
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Routing Options
TL

LEDs

(stored only with tripping)

BOs

BIs

X

Description
Routing option TL (tripping stored) is only possible for the
switching object circuit breaker.
The output is saved with protection tripping. The contact
remains activated until acknowledged.
Control commands are not affected. A control command is
pending above the parameterized command period until
feedback has been successfully received.
Note:
You can realize the functionality of the Lockout (ANSI 86)
by storing the output relay with the routing option TL.

Acknowledgment of Stored Indications on the On-Site Operation Panel
Acknowledgment via LED Reset
Operating the button first causes the activation of all LEDs (LED test) when pressed, and when released the
resetting of all stored indications. Stored LEDs, output contacts and spontaneous fault displays are reset.
Acknowledgment via the operating menu
Use the navigation buttons of the on-site operation panel, in order to reach the reset functions from the main
menu.
• Select: Main menu → Device functions → Reset functions
You are offered different reset options.

•

Open the corresponding submenu.

Figure 8-32

•
•
•
•
•
•

Reset Functions on the On-Site Operation Panel

Use Res. binary outputs to reset stored output contacts.
Actuate the softkey Start in the base bar.
As needed, enter the confirmation ID when requested and then confirm with the softkey Enter.
Use Reset LEDs not in FG to reset stored LEDs that are not assigned to a special function group.
Actuate the softkey Start in the base bar.
As needed, enter the confirmation ID when requested and then confirm with the softkey Enter.

Depending on device configuration, the protection function group(s) are displayed to you as submenus for
which separately corresponding, stored LEDs can be reset.
• Go to the submenu of the selected function group (example Line 1).

•
•
•

Use Reset LEDs to reset stored LEDs in the selected function group.
Actuate the softkey Start in the base bar.
As needed, enter the confirmation ID when requested and then confirm with the softkey Enter.

Figure 8-33

Reset Functions on the On-Site Operation Panel (for Example, Line FG)
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Acknowledgment of Stored Indications via Binary Inputs
Acknowledgment via entry >LED Reset
Acknowledgment via binary input >LED-Reset brings about the activation of all LEDs (LED test) and, in case of
dropout of signal, the resetting of all stored indications. Stored LEDs, output contacts and spontaneous fault
displays are reset.
Acknowledgment of Stored Indications with DIGSI 5
You can acknowledge stored indications via DIGSI 5 in online mode. For this, go to the project tree.
• Select Online access → Interface → Device → Device information

[scquiled-140912-01, 1, en_US]

Figure 8-34

•
•
•

LED Reset via DIGSI 5

Click the LED reset button.
Enter the confirmation ID.
Confirm the process with OK.

Stored LEDs, output contacts and spontaneous fault displays are reset on the assigned device.
Acknowledgment of Stored Indications via Log
Initiation of acknowledgment of stored indications can also occur through communication via a connected
substation automation technology. This can occur in conformance to standards (IEC 61850, IEC 60870-5-103)
or via configuration (mapping) of the LED reset input signal for any protocol. Stored LEDs, output contacts,
and spontaneous fault displays are reset.

i

NOTE
The acknowledgment of stored indications then leads to the resetting of configured LEDs and output
contacts, as long as these active unstored indications are not present in parallel. That is, indications configured as unstored are not affected by the acknowledgment process.

8.4.10 Test Mode and Influence of Indications on Substation Automation Technology
If the test mode of the device or of individual functions is switched on, the SIPROTEC 5 device marks indications sent to substation automation technology station control system with an additional test bit. This test bit
makes it possible to determine that an indication was set during a test. Necessary reactions in normal operation on the basis of an indication can thus be suppressed.
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8.5

Edit Measured and Metered Values

8.5.1

Overview of Measured and Metered Values
The SIPROTEC 5 devices have numerous measured and metered values. The following Table 8-7 gives you an
overview of the scope and sequencing principle. Measured and metered values will be referred to hereafter as
measured values.
Please refer to the Device manual of your SIPROTEC 5 device for detailed information and setting instructions.
Table 8-7

Overview of Measured Values

Measured / Metered
Values

Description

Operational measured
values

RMS value calculation and power calculation by definition, convertible to
primary, secondary or percentage values
• Phase currents IA, IB, IC
• Ground current IN, INS (sensitive)
• Phase-to-ground voltages VA, VB, VC
• Phase-to-phase voltages VAB, VBC, VCA
• Residual voltage VNG
• Frequency f
• Powers P, Q, S (3-phase and phase-specific)
• Power factor λ

Fundamental and symmet- Calculation of indicator quantities via Fourier filter or according to the transrical components
formation rule
• Phase currents IA, IB, IC
• Ground current IN, INS (sensitive)
• Phase-to-ground voltages VA, VB, VC
• Phase-to-phase voltages VAB, VBC, VCA
• Residual voltage VNG
• Symmetrical components 3I0, I1, I2, V0, V1, V2
Protection-specific Measured values

Average values

Minimum and maximum
values
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Measured values that are especially calculated for individual protection functions such as
• Distance protection (reactances and resistances of conductor loops)
• Differential protection (differential and restraint current conductor)
• etc.
Average values can be formed on the following basis:
Operational measured values
Symmetrical components
The time slot for average-value generation and the output interval are parameterizable.

•
•

The minimum and maximum values can be formed on the following basis:
Operational measured values
Symmetrical components
Selected measured values (for example of average values)
The display of minimum and maximum values contains the time of their
occurrence. The calculation is stabilized against smaller value fluctuations in
currents and voltages.

•
•
•
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8.5.2

Measured / Metered
Values

Description

Energy values

These metered values are determined for active and reactive energy. Restore
time, restore interval and counting mode are adjustable. Restoration can be
initiated via a binary input.
The following metered values are available:
• Active energy Wp+ (export), Wp- (import)
• Reactive energy Wq+ (export), Wq- (import)

Statistical values

The following statistical values are formed:
• Number of initiated switching operations of the circuit breaker (operation counter); the contactor trips and switch actuations by the control
are counted.
• Number of initiated switching operations of the circuit breaker, separated by circuit-breaker pole
• Sum of total primary breaking currents
• Sum of the primary breaking currents, separately for each breaker pole

User-defined measured
values

These metered values can be determined for any metered amounts received
via a binary input.
• The unit and significance of a pulse, restore time, restore interval, and
meter mode can be set.
• Restoration can be initiated via a binary input

Reading Measured Values and Metered Values
You can read measured and metered values on the device display or with DIGSI 5. You find these values in the
respective function groups such as the Line function group. Take note that the scope of measured values is
determined by the type and number of assigned measuring points. If only one measuring point, for example,
3-phase current, is assigned to the function group, then all measured values linked to the voltage (voltage,
power, energy) are omitted. These measured values are hidden automatically.
It is then explained later by example how you reach the individual measured values.
a) Reading Measured Values on the Device
Main menu → Measured values
• Line 1 (function group)
–
Operational Measured Values
–
Displaying available measured values (see Table 8-7)
–

Fundamental component/symmetrical components
–
Displaying available measured values (see Table 8-7)

–

Function measured values (protection-specific measured values)
–
Displaying available measured values (see Table 8-7)

–

Minimum/maximum/average values
–
Displaying available measured values (see Table 8-7)

–

Energy
–
Displaying available metered values (see Table 8-7)

–

User-defined measured values
–
Displaying metered values (see Table 8-7)
–
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•

Circuit breaker (function group)
–
Fundamental component/symmetrical components
–
Displaying available measured values (reduced scope against Table 8-7)
–

Function measured values (protection-specific measured values)
–
Displaying available measured values (reduced scope, for example measured values of the
synchro-check function)

–

Statistical values

–

User-defined measured values

b) Reading Measured Values with DIGSI 5
• Establish an online connection to the device.

•
•
•

In the online menu (bottom left in the project tree), open Measured values.
Double-click the respective function group and the measured value view appears in the operating range.
Select the respective tab of the desired measured value group.

Arrangement of the groups follows the ordering principle in the Table 8-7. Figure 8-35 shows an example of a
measured-value view. You can further select whether the measured values are shown to you as primary,
secondary or percentage values. Furthermore, you have the possibility of saving the measured values.
• If you wish to save the measured values, click the Snapshot button in the menu bar.
You can read the saved measured values of the device in offline mode in the Process data folder, Measuredvalue snapshots menu.

[scmswesi-080413-01.tif, 1, en_US]

Figure 8-35

8.5.3

Example of Measured-Value View in DIGSI 5

Setting and Resetting Energy Values
Setting and resetting energy values on the device:
² To set and reset on the device use the Measured values menu.
²

In the corresponding function group, mark the Energy measured values.

²

You can reset the energy values using the right context-sensitive Reset key on the display.
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²

When you open the energy values, you see the current values displayed as primary values.

²

You can set each measured value to the desired value via the right context-sensitive Change key. The
input value is converted to the data format according to IEC 61850. Because of the associated quantization, the resulting display value can differ from the input. In addition, the input value is rounded to 6
digits. The display is limited to 6 digits. Therefore please note that, in case of small pulse weighting,
minor changes to large metered values can not be reflected in the display.

²

Set the new value and activate acceptance with Enter.

Setting and resetting energy values with DIGSI 5:
² Start the online mode with DIGSI 5.
²

Click (in the project-tree bottom left) the Measured values menu item.

²

Double-click the Line function group and the measured-value window appears in the operating range.

²

If you open the Energy tab in the measured-value window, you are shown the current meter readings of
the four-quadrant meter (see Figure 8-36).

²

If you click the Reset button, you can reset the current meter readings to 0.

Alternatively, you can set the meter to a value:
² Enter the desired value in the Current value column. The input value is converted to the data format
according to IEC 61850. Because of the associated quantization, the resulting display value can differ
from the input. In addition, the input value is rounded to 6 digits. The display is limited to 6 digits. Therefore please note that, in case of small pulse weighting, minor changes to large metered values can not be
reflected in the display.
²

To transfer the value to the device, click the Set button.

[scnrgwer-080413-01.tif, 1, en_US]

Figure 8-36

8.5.4

Overview of Energy Values

Setting and Resetting User-Defined Metered Values
Setting and resetting metered values on the device:
² To set and reset, open the Measured values menu on the device.

144

²

Switch to the corresponding function group (for example, Line) in the User-defined values menu in
which the metered values have been arranged.

²

Select the metered value.

²

Reset the metered values if needed. Use the context-sensitive Reset key on the on-site operation panel.

²

If you select one level lower, you are brought to the metered values.
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²

You can set the metered value to the desired value via the context-sensitive Change key. The input value
is converted to the data format according to IEC 61850. Because of the associated quantization, the
resulting display value can differ from the input. In addition, the input value is rounded to 6 digits. The
display is limited to 6 digits. Therefore please note that, in case of small pulse weighting, minor changes
to large metered values can not be reflected in the display.

²

Set the new value and activate acceptance with Enter.

Setting and resetting metered values with DIGSI 5:
² Start the online mode with DIGSI 5.
²

Click (in the project tree bottom left) the Measured values menu item.

²

Double-click the function group (for example, Line) and the measured-value window appears in the operating range.

²

If you open the User-def. values tab in the measured-values window, the corresponding values can be
viewed.

²

If you click the Reset button, you can reset the current meter readings to 0.

Alternatively, you can set the meter to a value.
² Enter the desired value in the Current value column. The input value is converted to the data format
according to IEC 61850. Because of the associated quantization, the resulting display value can differ
from the input. In addition, the input value is rounded to 6 digits. The display is limited to 6 digits. Therefore please note that, in case of small pulse weighting, minor changes to large metered values can not be
reflected in the display.
²

8.5.5

To transfer the value to the device, click the Set button.

Resetting Min./Max./Average Values
Resetting minimum/maximum/average values on the device:
² To reset, open the Measured values menu on the device.
²

Switch to the corresponding function group and to the Minimum/maximum/average values.

²

You can reset the minimum/maximum/average values using the context-sensitive right Reset key.

Resetting minimum/maximum/average values with DIGSI 5:
² Start the online mode with DIGSI 5.

8.5.6

²

Click (in the project tree bottom left) the Measured values menu item.

²

Double-click the selected function group and the measured-value window appears in the operating
range.

²

If you open the Min/Max/Average values tab in the measured-value window, you are shown the current
minimum/maximum/average values.

²

If you click the Reset button, you can reset the current values to 0.

Setting and Resetting Statistical Values
Setting and resetting statistical values on the device:
² To set and reset, open the Measured Values menu on the device.
²

Switch to the Circuit Breaker function group.

²

You can reset the values if you select Statistical Values on the display via the context-sensitive Reset
key.

²

If you select one level lower, you are brought to the statistical values. The measured values are displayed
in primary values.
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²

You can set the statistical values to the desired value via the right context-sensitive Change key. The
input value is converted to the data format according to IEC 61850. In addition, the input value is
rounded to 6 digits. The display is limited to 6 digits. Therefore please note that, in case of small pulse
weighting, minor changes to large metered values can not be reflected in the display.

²

Set the new value and activate acceptance with Enter.

Setting and resetting statistical values with DIGSI 5:
² Start the online mode with DIGSI 5.
²

Click (in the project tree bottom left) the Measured values menu item.

²

Double-click the Circuit breaker function group and the measured-value window appears in the operating range.

²

If you open the Statistics tab in the measured-values window, you are shown the current statistical
values (see Figure 8-37).

²

You can reset the current values to 0 by clicking the Reset button.

Alternatively, you can set a value:
² Enter the desired value in the Current value column. The input value is converted to the data format
according to IEC 61850. In addition, the input value is rounded to 6 digits. The display is limited to 6
digits. Therefore please note that, in case of small pulse weighting, minor changes to large metered
values can not be reflected in the display.
²

To transfer the value to the device, click the Set button.

[scubstwe-080413-01.tif, 1, en_US]

Figure 8-37
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8.6

Fault Recording

8.6.1

General
Fault data relates to events or records that are recorded during a device fault. Sampled values of analog measurement inputs and calculated measured values of the device are recorded in the fault recording. A fault
record can also used for recording binary events as traces. Fault events are logged with time stamp in the fault
log. A corresponding fault exists in the fault log for each recorded fault record. The unique assignment is
formed by the time stamp and the fault defined with an automatically incrementing number.
After a fault, the most important data of the fault is spontaneously shown on your device display. You can
select whether the spontaneous fault display is updated with each fault or only in case of faults with tripping
(No Trip – No Flag). Spontaneous fault displays such as LEDs fall back again in case of pickup without tripping.

i

NOTE
Events are always logged in the fault log.
The control settings of the fault recording are described in the Device manual. The starting condition,
recording length, and the storage criterion are selected with these settings. The following chapter describes
the reading and editing of fault records.

Fault Definition
A fault is started by the incoming pickup of a protection function and ends after the trip command with the
cleared pickup.
When using an automatic reclosing function, the full reclosing cycle (successful or not) is integrated in the
fault. If evolving faults appear within reclosing cycles, the entire clearing process is logged under one fault
number even in multiple pickup cycles. Without automatic reclosing function every pickup is also recorded as
its own fault.
User-defined fault configuration and initiation by an external start signal are also possible.

i
8.6.2

NOTE

•
•

Define the extent of the fault recordings using the control settings of the Fault recording function.
Logging of events in the fault log always occurs.

Reading Fault Records
You can read out the fault record recorded in the device via the communication interfaces. You can do this
from a PC with DIGSI 5 or by way of standard (IEC 61850, IEC 60870-5-103) from a central controller upon
request. The fault records read out via DIGSI 5 are saved on the PC in the COMTRADE format. You can analyze
the fault records with the analytical software SIGRA.

Procedure

•

Use the project-tree window to reach the fault records of your SIPROTEC 5 device.
Project → Device → Records

The fault records that have been loaded from the device to date are displayed with time stamps and fault
numbers.
• To read all fault records stored in the device, click the Read records button in the headline of the indication list.
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i

NOTE

•

Take note that when accessing via online access points the fault records read replace all fault records
previously shown in the window. If you wish to save special fault records, then export the fault
records (see chapter 8.4.6 Saving and Deleting the Logs).

•

When accessing via a device created in the project, older fault records no longer in the device remain
kept. If you wish to delete no longer needed fault records, read chapter 8.4.6 Saving and Deleting the
Logs).

[scaslstr-080413-01.tif, 1, en_US]

Figure 8-38

8.6.3

Reading Fault Records with DIGSI 5

Display of Fault Records

Procedure

•

To be able to display and analyze a fault record, you must open the fault record of your choice in the list
of read fault records by double-clicking.

After opening, the fault record is automatically displayed on the COMTRADE Viewer. If you wish to do
expanded analyses of fault records using the options of the COMTRADE viewer, you can optionally press the
Open record with SIGRA button to start the analytical software SIGRA. You must have the analytical software
SIGRA installed on your PC.
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[scttrecd-080211-01.tif, 2, en_US]

Figure 8-39

8.6.4

Displaying a Fault Record with the COMTRADE Viewer

Saving and Exporting Fault Records
For the analysis of important fault records you can save them as files on your DIGSI 5 PC. You have 2 export
options available in DIGSI 5.

Procedure

•

Start the standard export of the fault record in COMTRADE format (CFG file) by pressing the Export
button in the headline of the display window (Figure 8-39 a)). The fault record is now available to SIGRA
and other analytical tools.

•

Start the export of the fault record as a CSV file in tabular form by pressing the CSV button in the headline of the display window (Figure 8-39 b)). You can, for example, open this file with Excel and individually edit or analyze it.
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8.6.5

Deleting Fault Records
The recorded fault records are managed in a ring buffer in the device. So that new records can always be
created securely, the oldest records are deleted automatically when the maximum storage capacity is reached.
However, you can also delete targeted fault records. This differentiates whether you wish to delete the fault
records stored or selected in the device in a DIGSI 5 project.

Deleting Fault Records via the PC with DIGSI 5

i
8.6.6

•

To delete the fault records stored in the device, click the Delete fault records button in the headline of
the display window (Figure 8-39 c)).

•

You can delete selected fault records within a DIGSI 5 project. To do this, tag the respective fault records
and right-click with the mouse. Complete the delete action with the offered Delete option.

NOTE
Recorded events of corresponding faults in the fault log are also deleted with the fault records.

Recording a Test Fault Record
For test purposes, SIPROTEC 5 devices can record fault records of fixed length. You must manually initiate this
recording from the PC via DIGSI 5. The recording length of the test fault records is independent and is set to 1
second.

Procedure

•

8.6.7

To start a test fault record, click the Start fault record button in the headline of the display window
(Figure 8-39 d)). Then read the current fault records to view and analyze them from your SIPROTEC 5
device.

Configuration of Fault-Record Channels
While the Fault Recording function contains the control settings for recording data, you must configure the
channels to be recorded with DIGSI 5 in the configuration matrix. Every application template contains a preset
configuration of channels to be recorded that you can adjust individually.

Fault-Record Channels
The following values are available for fault-record channels:
• Sampled values of analog measuring inputs (currents and voltages)

•
•
•

Internal measured values of measured value preprocessing
Internal function and operational measured values
Binary status signals (internal or external)

Fault-record channels are configured in the information routing of DIGSI 5 (matrix). The Recorder column is
provided especially for this purpose.
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[sccnfrec-080413-01.tif, 1, en_US]

Figure 8-40

i

NOTE

i

NOTE

Configuration of Fault-Record Channels with DIGSI 5

The sampled values of analog measuring inputs (currents and voltages) are not freely configurable in the
fault record. The values are specified automatically by the routing of measuring points to the analog input
modules of the device.

The maximum recording length of an individual fault record and the sum of fault records stored in the
device are affected by the following factors:
• Sampling rate setting

•
•

Number of fault-record channels
Type of fault-record channels

The Fault Recording chapter in the device manual gives an overview of attainable recording times.

8.6.8

Configuration of the Start Criterion
The start criterion for recording a fault record and the duration of a fault record are described by the control
settings in the Fault Recording function. Please read the Fault Recording chapter in the Device manual of
your SIPROTEC 5 device.

Start Criterion

•

A start criterion is the fault which is formed by the pickups of protection functions and which also takes
account of a reclosing cycle duration during the respective parameter setting.

•

You can configure the start criterion for each parameter setting using your own user definitions. A
Recorder column especially provided for this purpose is then displayed in the information routing of
DIGSI 5 (matrix).
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Figure 8-41

User-Defined Configuration of the Start Criterion for Fault Recording

•

The start criterion can also be entered via an external start signal of the Fault recording function
(>External start). With this you can, for example, initiate recording of a fault record using an
external protection device without internal fault recording in case of pickup.

•

A test fault record can also be initiated manually via the on-site operation panel of the device (for
example, via function key) or via DIGSI 5. For this, a freely configurable start signal (>Manual Start) is
available.

[scmnstrt-080413-01.tif, 1, en_US]

Figure 8-42
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•

It was pointed out in the introduction that the trigger to record a fault record can also take place via
communication. This can happen by way of standard (IEC 61850, IEC 60870-5-103) through a connected
substation automation system.
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8.7

Change Device Settings

8.7.1

Date and Time Synchronization
The integrated date and time synchronization of your SIPROTEC 5 device allows you to assign the precise time
of events to an internally maintained device time. Events in the logs are stamped with the device time. These
time stamps are also transmitted during transmission to substation automation technology or via a protection
interface. You can synchronize the device time using external time sources. You can also take local time zones
and daylight-saving time arrangements into consideration.

8.7.2

Setting Time and Date
You can set the date and time of your SIPROTEC 5 device through the on-site operation panel as well as the
DIGSI 5.

Setting via DIGSI 5
Date and time are internal device quantities. DIGSI 5 access is via online access in the project-tree window.
Here you will see the status of configured time sources and the current device time.
Online access → Interface → Device → Device information → Time information
• To be able to enter your local device time and the date, go to the Device time section and select the Edit
time button.

[scztinfo-030311-01.tif, 1, en_US]

Figure 8-43

•
•

i

Time Information in the DIGSI 5

After finishing the input, press the Set time button to transfer it to the device.
The display for modified values for date, time, and their cyclical updates will confirm the successful
transfer.

NOTE
The Edit time button is inactive until data have been queried from the online device for the first time.

Settings on the Device Using the On-Site Operation Panel
To reach the settings for date and time from the main menu, use the navigation keys on the on-site operation
panel.
• Select Main menu → Device functions → Date & Time.
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[scdttime-080413-01.tif, 1, en_US]

Figure 8-44

•
•
•

Date and Time Setting

From the Date format menu item, select a display option.
To change the format, press the Change softkey.
Enter the change and then confirm the entry by selecting the Ok softkey.

The Date and Time menu items show you the current values with ongoing update.
• To change Date or Time, select the desired menu item and press the Change softkey.

•
8.7.3

Enter the changes and then confirm the entry by selecting the Ok softkey.

Setting Time Keeping Parameters
Input the time keeping settings of your SIPROTEC 5 device preferably using DIGSI 5. You have access here to
all possible settings. You can only access some of the settings using the on-site operation panel while the
device is being operated.

Settings Using the DIGSI 5
To reach the time settings of your SIPROTEC 5 device, use the project-tree window.
Select
Project → Device → Parameter → Time settings

•

•
•

Select the desired date format.
Configure up to 2 external timers (time source, latency, time zone) and the time by which failures should
be logged.

First decide whether your PC settings should be accepted or whether you wish to enter the settings manually.
• Enter the settings for your local time zone and daylight saving time. The settings include the local time
zone (relative to GMT) as well as the daylight saving time options (activation, start, end, and offset of
daylight saving time).
You will find application and setting information in the System Functions Device manual.
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[scztkonf-030311-01.tif, 1, en_US]

Figure 8-45

Time Settings via DIGSI 5

Settings on the Device Using the On-Site Operation Panel
You can only access some of the settings using the on-site operation panel while the device is being operated.
To reach the settings for time synchronization from the main menu, use the navigation keys on the on-site
operation panel.
• In the main menu select → Settings → General → Time sync

[sctimsyc-080413-01.tif, 1, en_US]

Figure 8-46

Time-Synchronization Settings

•

Configure up to 2 external time sources. There are port and channel numbers in communication interfaces for every configured time source. This depends on the configured hardware of your SIPROTEC 5
device.

•
•

Select the time-zone arrangement (UTC or local) for each time source.
Select the time by which time-setting failures should be logged.

For each change in the settings, select the desired menu item and press the Change softkey.
• Enter the changes and then confirm the entry by selecting the Ok softkey.
You will find application and setting information in the System Functions Device manual.
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i
8.7.4

NOTE
Make sure that the settings for the time sources coincide with the actual hardware configuration of your
SIPROTEC 5 device. In any event, incorrect settings cause the status indications of time sources to pick up.

Status and Monitoring of Time Keeping

Time Information in the DIGSI 5
The compact overview of the status of time synchronization in your SIPROTEC 5 device will give you support
information about the DIGSI 5 especially during commissioning. You reach the overview via online access in
the project-tree window.
Online access → Interface → Device → Device information → Time information

[scztinfo-030311-01.tif, 1, en_US]

Figure 8-47

Time Information in DIGSI 5

For every time source, you see the following:
• Last received time (with date)

•
•
•
•

Receipt time of the last received time telegram
Configured type of timer
Indication of timer outage or failure
Whether the device time is currently synchronized from the time source

The lower section displays the device time, which is continuously updated. If the internal device time and the
infeed time source were synchronous at the time of telegram receipt, both displayed times are identical.

i

NOTE
All indicated times (even of time sources) take account of settings for local time (zone and daylight saving
time of the device) in the form of a numeric offset to UTC (world time).

Time Information on the On-Site Operation Panel
To reach the settings for date and time from the main menu, use the navigation keys on the on-site operation
panel.
Main menu → Device functions → Date & Time
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[scdttime-080413-01.tif, 1, en_US]

Figure 8-48

Date and Time Setting

The Date & Time menu items show you the current values, which are continually updated. You can also
change entries here.
Time Synchronization Indications
Internal time synchronization is monitored cyclically. Important synchronization processes, the status of time
sources and errors detected are reported and entered in the operational log. For this purpose, see the list of
indications for internal date and time synchronization in the System Functions Device manual.

i
8.7.5

NOTE
In case of a missing or discharged battery, the device starts without active external time synchronization
with the device time 2011-01-01 00:00:00 (UTC).

Setting the Contrast of the Device Display
You can enter the contrast setting only on the device via the navigation keys on the on-site operation panel.

Procedure

•
•
•
•

Open the contrast menu by pressing the Left + Right navigation keys simultaneously.
If prompted, change the contrast intensity +/- using the Right/Left navigation keys.
You can restore the basic setting by simultaneously pressing the Up + Down navigation keys.
Then confirm the setting changes with Enter.

[sckontra-080413-01.tif, 1, en_US]

Figure 8-49

8.7.6

Contrast Setting of the Device Display

Changing the Language on the Device
If the Language of the operation panel was configured in DIGSI 5, you can select between the national
language and US English on the device at any time.
• To reach the setting dialog for the language selection, press the function key <F9>.

•
•
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Use the up/down navigation keys to select the languages.
Finally, confirm the setting changes with Ok.
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Changing the Units System on the On-Site Operation Panel

•
•
•
•

To reach the settings dialog for selecting the units, select the Localization menu in Device functions.
To select the units system, press the Change softkey.
Use the Up/Down navigation keys to select the units system.
Finally, confirm the setting changes with Ok.

[scchgun1-050413-01.tif, 1, en_US]

Figure 8-50

Units System of the Country

[scchgun2-050413-01.tif, 1, en_US]

Figure 8-51

Switching the Units System

Changing the Device Language on the PC in DIGSI 5

•

To reach device information of your SIPROTEC 5 device in the menu, use the project-tree window. You
can reach the device optionally via online access or via the project in which it must be created:
Online access → Interface → Device → Device settings
Project → Device → Settings→ Device settings

•
•

In the project-tree window, click Device settings.
Select the language via the Operation-panel language parameter.
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[scsprums-040613-01.tif, 1, en_US]

Figure 8-52

•
•

Language Change with DIGSI 5

The setting is accepted in the device through Load configuration in devices.
When prompted, enter the confirmation ID and finally click Ok.

The operation panel language changes automatically after it is downloaded from the PC to the device.

8.7.7

Changing the Confirmation ID
Authorization for security-relevant operations on the device directly via the on-site operation panel or DIGSI 5
is assured by the assignment of confirmation IDs. These are assigned exclusively using DIGSI 5 (see also
10.5 Authentication, Connection Password, and Confirmation ID During Operation).

Changing Confirmation IDs on the PC in DIGSI 5
To reach the menu for the confirmation IDs of your SIPROTEC 5 device, use the project-tree window.
Project → Device → Security
The confirmation IDs for 4 different access types appear in the main window.
• Activate or deactivate a confirmation ID by setting or removing a check mark in the Active column.

•
•

To change a confirmation ID, click the change button in the Action column. The change window opens.
Enter the new confirmation ID (comprising 6 digits between 0 and 9) twice, and then confirm it with Ok.
The confirmation IDs are set ex factory as default (see table Table 8-11).

[scaktvor-210311-01.tif, 1, en_US]

Figure 8-53

Window for Activating Confirmation IDs

[scbstcod-210311-01.tif, 1, en_US]

Figure 8-54
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Window for Changing Confirmation IDs
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Table 8-8

8.7.8

Default Setting of Confirmation IDs

Operting Range

Default Setting

Set/operate

222222

Switching (operation)

333333

Switching (unlocked)

444444

Switching authority

666666

Setting Function Settings
Enter the function settings of your SIPROTEC 5 device preferably using the DIGSI 5. You have access here to all
possible settings. Using the on-site operation panel you can make individual setting changes while the device
is in operation.

Offline Settings Using DIGSI 5
To reach the function parameter settings of your SIPROTEC 5 device, use the project-tree window.
• Select Project → Device → Parameters → Function group → Function → Function block
The settings of the selected function block are displayed in the main window.
If multiple settings groups (see chapter 8.7.9 Settings Group Switching) have been activated, first make sure
that you are making your changes in the correct settings group. You can change this in the header of the main
window if necessary. In another column of the main window, you can compare the setting values with those
in another settings group.
• To change a setting value, click the setting arrows of the parameter concerned.

•
•

For selection of settings, select a value from the displayed list of possible settings.
For decimal parameters, you can change the setting value incrementally using the setting arrows, or
enter the setting value directly via your PC keyboard. Setting values that are not permitted are indicated
by a red background color and red exclamation marks in the affected areas of the project-tree window.
DIGSI 5 cannot load invalid setting values into the device.
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[scstfugr-030311-01.tif, 1, en_US]

Figure 8-55

•
•
•

Function Settings in DIGSI 5

When you are finished changing your settings, load the entire device configuration into the device.
To do so, right-click the Load configuration in device context menu.
To load the setting changes for multiple devices via the system, press the project-specific Load configuration in devices button in the project-tree window.

[scladknf-040613-01.tif, 1, en_US]

Figure 8-56
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Loading Function Settings in the Device
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Online Settings via DIGSI 5
You should always use the online setting if you want to change individual function settings of a device in
operation. To reach the function settings of your SIPROTEC 5 device, use the project-tree window.
• Select Online access → Interface → Device → Settings
Settings on the Device Using the On-Site Operation Panel
Using the on-site operation panel you can access function settings while the device is in operation. To reach
function settings from the main menu, use the navigation keys on the on-site operation panel.
If multiple settings groups (see chap. 8.7.9 Settings Group Switching) have been activated, first make sure
that you are making your changes in the correct settings group. You can change this as necessary.
• To do this, select Settings → General → Change group settings in the main menu
When the correct settings group is selected, proceed as follows:
• In the main menu select → Settings → Function group → Function
The active settings of the selected function are displayed in the device display.
• To select the parameter to be changed use the navigation keys or the number keys for direct selection
according to the right sidebar.

[scaswfnk-080413-02.tif, 1, en_US]

Figure 8-57

•
•
•
•

Changing and Selecting Function Settings on the On-Site Operation Panel

To change a parameter setting, click Change in the base bar dialog.
If you are not yet authorized for access via LOGIN, you will be requested to input the confirmation ID.
Use the number keys to enter the confirmation ID and confirm with Ok.
For the selection of settings, use the navigation keys to select a value from the displayed list of possible
settings.

•

For decimal parameters, you can enter the setting value directly using the number keys within the
displayed setting range.

•
•

Confirm your settings with Ok or Enter. Setting values that are not permitted are declined.

•

To activate all changes made, press the left navigation key until you are prompted in the base bar to
confirm or cancel the changes.
Confirm your changes with Ok.

[scbstubn-080413-01.tif, 1, en_US]

Figure 8-58

Confirming Acceptance of Function Settings on the On-Site Operation Panel
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8.7.9

Settings Group Switching
For different applications you can save the respective function settings in so-called Settings groups, and if
necessary enable them quickly.
You can save up to 8 different settings groups in the device. In the process, only one settings group is active at
any given time. During operation, you can switch between settings groups. The source of the switchover can
be selected via a parameter.
You can switchover the settings groups via the following alternatives:
• Via the on-site operation panel directly on the device

•
•
•

Via an online DIGSI connection to the device
Via binary inputs
Via a communication connection to the substation automation technology
The communication protocols IEC 60870-5-103, IEC 60870-5-104, IEC 61850, DNP or Modbus TCP can be
used for switching the settings groups.

A settings group includes all switchable settings of the device. Except for a few exceptions (for example,
general device settings such as rated frequency), all device settings can be switched.
This section assumes multiple configured settings groups, and only describes the switching process. The function and their setting parameters are described in the chapter Settings Group Switching in the Device
manual.
Settings Group Switching via DIGSI 5
Use the project-tree window to initiate settings group switching on your SIPROTEC 5 device. Settings group
switching can be initiated both via the project (offline) and via the online access point.

i

NOTE
Bear in mind that the settings group in the project is switched by loading the DCF into the device. This
causes an automatic device restart (reset). If you make other functional changes at the same time, a device
restart may also occur in online mode or at the on-site operation panel. Switching without interrupting
device operation may be performed only with online access.
Settings group switching via the project (offline)
• Select: Project → Device → Settings → Device settings → Active settings group

•

Select the desired settings group and then load the DCF into the device.

For settings group switching via the online access point
• Select: Online access → Interface → Device → Settings → Device settings → Active settings group

•

Select the desired settings group and then load the change into the device.

Settings Group Switching at the Device Using the On-Site Operation Panel
Use the navigation keys of the on-site operation panel to initiate settings group switching on your SIPROTEC 5
device.
• Select Main menu → Settings → General → Settings group switching

164

•

Using the navigation keys, go to the Settings group activation setting and click Change in the base bar
dialog.

•
•

If you are not yet authorized for access via LOGIN, you will be requested to input the confirmation ID.
Use the number keys to enter the confirmation ID and confirm with Ok.
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Figure 8-59

Setting the Active Settings Group on the On-Site Operation Panel

•

Use the navigation keys to select the settings group to be activated from the displayed list of possible
settings.

•
•

Confirm your settings with Ok.

•

Confirm your changes with Ok.

To activate settings group switching, press the left navigation key until you are requested to confirm or
cancel in the base bar.

[scbstubn-080413-01.tif, 1, en_US]

Figure 8-60

Confirming Acceptance of Changes on the On-Site Operation Panel

Settings Group Switching via Binary Inputs
To switch a settings groups via binary inputs on your SIPROTEC 5 device, you first have to set the Settings
group activation setting to via binary input.
You must also have configured the binary input signals that are necessary for switching the settings group to
the contacts of your device. You will find these in DIGSI 5 under:
Project → Device → Information routing → General → >PG Selection Bit 3/Bit 2/Bit 1
100 ms after one of the 3 signals is changed (stabilization time), the signal image present will lead to a
switching to the corresponding settings group. The following table shows the possible binary codes (BCD) and
associated settings groups (PG). From the table you can also determine which input signals you have to route
depending on the number of settings groups.
Example: To ramp up the device, the parameters Number of settings groups = 4 (PG 4) → >PG Selection
Bit 1, and >PG Selection Bit 2 must have been routed to binary inputs.
Table 8-9

Binary Codes of the Signal Inputs and Associated Settings Groups

BCD Code via Binary
Inputs

PG 1

PG 2

PG 3

PG 4

PG 5

PG 6

PG 7

PG 8

>PG selection bit 3

0

0

0

0

1

1

1

1

>PG selection bit 2

0

0

1

1

0

0

1

1

>PG selection bit 1

0

1

0

1

0

1

0

1

Settings Group Switching via Control
When using the Control function for switching, the settings groups can be switched via a communication
connection from the substation automation technology or via a CFC chart.
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The communication protocols IEC 60870-5-103, IEC 60870-5-104, IEC 61850, DNP or Modbus TCP can be used
for switching the settings groups via a communication connection.
In order to use a CFC chart for switching, you must create a new CFC chart in DIGSI 5. Create the CFC chart in
the DIGSI 5 project tree under Name of the device → Charts → Add new chart. Link the signals that control
settings group switching in the CFC chart.

i
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NOTE
The device starts in this mode after a DCF upload (offline mode) with active settings group 1. The device is
only informed of a settings group change via the substation automation technology. As long as the substation automation technology command is pending, protection runs using the settings from active settings
group 1.
If the Control mode is changed in online mode (settings changes via DIGSI 5 or the on-site operation
panel), the device continues to run with the last active settings group. If a substation automation technology command for a settings group change is sent or the mode for settings group switching is changed,
this state ends. In the case of a device warm start, the device starts in the mode of the most recently active
settings group.
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8.8

Control System on Site

8.8.1

General
You can execute switching device control via a connected substation automation system and through DIGSI 5.
You can also control the device directly via the keyboard. The large graphic display is best suited for this
purpose but control is also possible with the small display.
Operation of switching devices is subject to different safety tests such as switching authority and switchgear
interlocking protection-function test. You will find a detailed description of these functions in the Device
manual in the chapter Control Functions. To facilitate access to on-site control only for authorized persons,
you can set parameters of a confirmation ID using DIGSI 5.

8.8.2

Menu Structure
If you go to the main menu of the device and select the Commands item, you get the following submenu:

[scstemen-090413-01.tif, 1, en_US]

Figure 8-61

Control Menu on the Device Display

The following table shows the meaning of the menu items:
Table 8-10

Subitems of the Control Menu with Meaning

Menu Item

Submenu

Meaning

Equipment

Display

Display of current state of all switching devices.

Control

Display of current state of all switching devices. You have the
possibility to transmit a switching command.

Acq.blk./man.update

Display of current state of all switching devices. If acquisition
blocking is placed for the switching device, you have the
possibility to update it manually.
Acq.blk. (appears after selecting Change): allows you to
place acquisition blocking for a switching device. Entry of the
confirmation ID is necessary.

Other

Status

You are notified about the status of the individual switching
devices with respect to acquisition blocking, manual update.

Display

As for the Equipment item, but for user-defined objects of
type DPC (double command), SPC (single command), and PLC
(marker).

Control
Acq.blk./man.update
Status
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8.8.3

Menu Item

Submenu

Meaning

Interlocking

One line for every
switching device

Display of interlocking status of the switching devices with
the letters S D P and B.
• S = Check of switching authority
• D = Check of double-activation block
• P = Check whether position is reached
• B = Check of blocking by protection

Switching
Authority

Switching authority =
Local

Display of current switching authority. If the device does not
have a key switch, a change dialog is displayed and you can
enter the change via the device keyboard. If the device has a
key switch, the Switching authority menu bar is static and a
change can be made only via the key switch.

Switching Mode

Switching mode = Interlocked

Display of current switching mode. If the device does not
have a key switch, a change dialog is displayed and you can
enter the change via the device keyboard. If the device has a
key switch, the Switching mode menu bar is static and a
change can be made only via the key switch.

Switching Authority
The switching authority ensures that simultaneous control can be done only from one command source. For
example, you must prevent a switching command from being executed by the control center during field
work. To do this, you must set the switching authority to Local. SIPROTEC 5 recognizes the following
switching authorities:
• Local

•
•

Remote/station
Remote/control center

The Remote/station switching authority level was redefined in IEC 61850. You can deactivate the switching
authority in the device. Full support for this level is ensured only in devices with the IEC 61850 protocol.
The Remote/control center switching authority is normally used as the remote switching authority. You can
change the switching authority from Local to Remote Using the top key switch. You can also set this switchover in devices without the key switch after entering the confirmation ID.

8.8.4

Switching Mode

Changing the Switching Mode

!

DANGER
Danger due to hazardous voltages during the operation of electric devices
Noncompliance with the safety notes will result in death or severe injuries.
²

Only electrically qualified personnel may work on these devices. The electrically qualified personnel
must be thoroughly familiar with pertinent safety regulations and precautionary measures as well as
the warnings in this manual.

If you perform non-interlocked switching, for example, in the commissioning phase, you can change the
switching mode during operation.
You can set the switching mode using the key switch. Non-interlocked switching is permitted in the horizontal
key position (Interlocking OFF). Only interlocked switching is allowed in the vertical key position.
Proceed as follows for devices without a key switch:
² Select the menu item Commands in the main menu.
168
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8.8.5

²

Go to the menu item Switching mode.

²

Select Interlocked or Non-interlocked and confirm with Ok.

²

You can set this switchover after entering the confirmation ID.

Control with Graphic Display
Devices with a graphic display can depict a single-line diagram of the field in the control display, see
Figure 8-62. You can create the control display with the display editor of DIGSI 5. The display becomes active
directly after activation. You can reach the display at any time by pressing the yellow <Ctrl> key.

[scabzstb-280211-01.tif, 1, en_US]

Figure 8-62

Control display

Selecting a Switching Device
From this control display you can select the individual switching devices using the navigation keys. After the
position has been switched, the feedback is shown directly in the control display. A separate default display
(single line without control capability) is not present but can be created.
Initiating command

•
•

Select the switching device to be controlled using the navigation keys.

•

Confirm the query with the softkey marked Ok in the display.

Then enter the new target position ON or OFF with the corresponding control key (green <I> for on, red
<O> for off). The switching device flashes in the target position.

If the switching operation is permissible, it is executed, otherwise you receive a notification about the cause of
rejection.

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

169

Operation in the Operating State
8.8 Control System on Site

[scauswqa-090413-01.tif, 1, en_US]

Figure 8-63

Selecting a Switching Device in the Control Diagram

You can also initiate a control action via the navigation keys after selecting a switching device.
To do so, select Open or Close in the menu and confirm with Ok.

[scsteuvo-090413-01.tif, 1, en_US]

Figure 8-64

8.8.6

Initiating Control Action

Control with Small Display
For devices with the small display, you can control from the switching device list, in the same way as for
devices with the large display. A single-line representation of the feeder is impossible here.
• Select the list of all switching devices in Commands/Equipment and then the switching device to be
controlled in the Control menu item.
The currently recorded position is shown to you.
• You now control via the right context-sensitive key (labeled Switch).

•
•

Then select the target position (off or on).
Confirm the query of the confirmation ID.

After entering the confirmation ID for on-site control, the switching command is output while considering the
interlocks (switchgear-interlocking protection conditions, switching authority, etc.).

170

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

Operation in the Operating State
8.8 Control System on Site

[scklndis-090413-01.tif, 1, en_US]

Figure 8-65

8.8.7

Control from the List on the Small Display

Acquisition Blocking and Manual Updating
During commissioning, maintenance, or testing, a brief interruption of the connection between the logical
signals and binary inputs may be useful. It allows you to manually update the status of a switching device that
is not providing feedback correctly. Before this can take place, you must first set acquisition blocking.
Set the Acquisition blocking function in the menu of the device display Commands > Equipment >Aq.blk
man. update. If several switching devices are available, select the appropriate switching device. When
pressing the Change key, the confirmation ID will be queried. After entering the confirmation ID, the acquisition blocking function is switched on when OK is pressed.

[scerfass-280513-01.tif, 1, en_US]

Figure 8-66

Activating the Acquisition Blocking

Manual updating of the switching device is possible from within the same menu. Use the menu item Change
to select the Manual updating function. Subsequently, select the updating setting of the switching device
manually and acknowledge the selection by pressing OK. The manually updated position of the switching
device will be displayed.
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[scstatus-280513-01.tif, 1, en_US]

Figure 8-67

Activate Manual Updating

[scstatu2-280513-01.tif, 1, en_US]

Figure 8-68

i

NOTE

i

NOTE

Selecting Position

For safety reasons, manual updating is possible only directly through the on-site operation panel of the
device and not through DIGSI 5.

Setting acquisition blocking and the subsequent manual updating are also possible via the IEC 61850
system interface.
Acquisition blocking can also be set via a binary input. This way, acquisition blocking can be set for an individual or several switching devices in a feeder simultaneously with an external toggle switch in order to
disable the feeder. For this purpose, every switching device in the Switch function block (circuit breaker or
disconnector switch) has the input signal >Acquisition blocking. This signal can also be set from the
CFC.
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Figure 8-69

i

Input signals >Acquisition Block and >Release Acquisition Block & Manual
Updating on the Switching Device

NOTE
Interlockings are carried out with the status changes of the switching device. Remove acquisition blocking
again manually. Otherwise, position changes of the switching device are not detected and interlockings are
ineffective.
If the acquisition blocking and the manually updated position are set using the operation panel of the device
or the system interface IEC 61850, these are retained until the acquisition blocking is manually deactivated.
When you initially start the device, the acquisition blocking is deactivated.
Except for a restart, the acquisition blocking and the manually updated position are retained.
If the acquisition blocking is activated via the input signal >Acquisition blocking, it is retained as long as
the binary input is active.
To set the acquisition blocking of a switching device, the following sources are possible:
• Operation panel of the device

•
•

System interface IEC 61850
Input signal >Acquisition blocking

All sources undergo OR operations, that is, the acquisition blocking remains set until all the sources are deactivated.
After deactivation of the acquisition blocking, the actual position of the switching device is adopted and
displayed in the operation panel of the device.

i

NOTE
When the acquisition blocking is activated or the switching device updated manually while the entire
device or the switching device is in test mode, these states are not saved. The acquisition blocking and the
manual updating are not retained after a restart.
Acquisition blocking and manual update for the circuit breaker, the disconnector and the tap changer are reset
by way of the >Reset AcqBlk&Subst binary input. Setting acquisition blocking and manual update is
blocked with the input activated.

8.8.8

Status Display
You reach the following display through the Status menu item:
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[scstatus-090413-01.tif, 1, en_US]

Figure 8-70

Status Display of Switching Devices

The meaning of the status columns is as follows:
AB = Acquisition blocking active (acquisition blocking for the switching device is set)
MU = Manual update (switching device was manually updated)
CH = Chatter blocking active (Chatter blocking has been activated and is still set)

8.8.9

Setting a Marker
In order to be able to set a marker manually with a device operation, you must activate a cross in the Control
Menu column in the DIGSI 5 information matrix (see Figure 8-71).

[scrangma-090413-01.tif, 1, en_US]

Figure 8-71

Routing of a Marker to the Operating Menu

The marker appears in a list, for example, under
Commands → Additional → Display or → Status.
At this point you can observe or vary the current status.

i

NOTE
To change the state of a marker (from On to Off or vice versa), you need to enter the confirmation ID for
control.

8.8.10 Assignment of Authorizations with Confirmation ID
Authorization for sensitive operations in the on-site operation panel is done by the assignment of confirmation
IDs (see also chapter 10.4.2 Confirmation ID).
Figure 8-72 shows an example of a device without a key switch. For devices with key switches, the confirmation IDs are not required for non-interlocked switching and for the switching authority. These are replaced by
the corresponding key switches for non-interlocked control and for local switching authority.
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[scaktvor-210311-01.tif, 1, en_US]

Figure 8-72

Assignment of Confirmation IDs

Table 8-11

Confirmation IDs

Name

Description

Seting/operate

Authorization to change settings on the device display and DIGSI 5

Switching (operation)

To prevent unintentional switching of combined protection and control
devices, this general authorization for switching on site is available.
Release for manual setting of markers

Switching (non-interlocked)

Only in devices without key switch authorization for non-interlocked
switching (only effective in devices with parameterized switchgear interlocking protection conditions)

Switching Authority

Only in devices without the key switch release of On-site switching
authority and hence of control on the device display

Switching (without synchrocheck)

Authorization for unsynchronized switching of a circuit breaker (only in
devices with activated synchrocheck)

8.8.11 Control with Function Keys
8 of 9 function keys can also be used for control. Function key <F9> is hardcoded for language switching.
Using a function key you can initiate a switching sequence, for example, to switch on a feeder.
• You reach the function keys by pressing the blue <Fn> key and the corresponding digit from <1> to <9>
in the numerical keypad.

•
•
•

Define your switching sequence using the CFC editor.
Link a single command (type SPC) in the information routing matrix with the desired function key.
Connect this single command with a SPC_INFO block that starts the switching sequence.
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9.1

Execute Checks

9.1.1

General Information
No special maintenance is required for SIPROTEC 5 devices. The only maintenance measure is to replace
batteries. All measurement- and signal-processing circuits are designed full-static. All input modules are also
static, the binary outputs are equipped with protective covers.
Since the device is mainly self-monitoring, hardware and software errors are automatically forwarded. This
minimizes any downtime of the device. It also eliminates frequent maintenance inspections.

Repeat Test
A routine test of characteristics or pickup values is unnecessary since this is part of the continuously monitored
firmware programs. As long as you make no changes in the pickup values or characteristics, a test is not
necessary.
Use the specified maintenance intervals to check and maintain the station and check the protection and
control equipment. The primary purpose of maintenance is to check the interfaces of the SIPROTEC 5 device,
that is, the coupling to the system.
If you discover a failure, follow the instructions in the corresponding chapters for failure search or call the
Siemens hotline.

9.1.2

Protection-Function Test

General

i

178

NOTE
When performing a protection-function test, make sure that it does not lead to any undesired tripping.
Likewise no information must be transmitted to a higher-level systems control where the operator may
incorrectly interpret it.
²

Make sure that the green RUN LED on the front cover lights up and not the red ERROR LED. This is how
the device indicates that it is properly functioning and that no failures have been observed during selfmonitoring.

²

Make sure that the LEDs on the front cover present a plausible image of the actual state of the device. If,
for example, the tripping of a protection function is saved as an LED display, the device has fault indications and a fault record for this purpose.

²

Press the LED test key. All LEDs apart from the red ERROR LED light up. Stored LED displays are reset and
only those states currently indicated by the device are shown.

²

Read the operational measured values and compare them to the actual measurands to control the analog
inputs. To do this, enter a reference quantity into the device using secondary test equipment. This is how
you check the proper operation of the analog section of devices.

²

Read the operational indications. You can do this directly on the device or following a clearly arranged
procedure using the DIGSI 5. Make sure that they do not contain inputs about failures of the device, of
measurands or other implausible information.

²

If the protection equipment has picked up or disabled an error, you can verify this through the fault
record and the fault log. This is how the protection equipment demonstrates its correct operation in the
operating state. Additional protection-function tests can be omitted.
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i

NOTE
The system operator is responsible for further protection-function tests within maintenance intervals.
Check protection functions using secondary test equipment or the integrated test sequencer (see chapter
7 Commissioning).
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9.2

Error Search and Correction

9.2.1

Error Search

Procedure
If the device indicated an error, then Siemens recommends that you proceed as follows:
If no LED on the operation panel of the device lights up, then verify as follows:
² Check whether the auxiliary voltage on the corresponding connections has an adequate amount and
correct polarity. You will find information about this in the overview plans in the appendix of the Device
manual.
²

If the device shows a fault via the red Error LED, look for the cause of the fault in the operational log. You
can do this directly on the device or with DIGSI 5.

²

If the Fallback Mode display appears in the device display, then reinitialize the device through DIGSI 5.
Look for the cause in the device-diagnosis log first. If a connection to the system cannot be established,
initialization takes place via the USB interface on the device together with DIGSI 5.

²

If the confirmation ID is queried, enter it for the device initialization.

The display first disappears in the device display. After successful initialization, the LEDs again indicate normal
mode and the default display goes back into the display. If the device-specific setting values were saved in the
PC during commissioning, they are again loaded into the device.
The device is ready for operation.
Additional Support
If these measures do not lead to the desired result, then call support.
The support employees will need the following information from you:
² Keep the serial number of the device ready.
²

Read out the version of the installed firmware.

²

Read the device diagnosis log of your SIPROTEC 5 device with DIGSI 5 so that the support employee has
all the necessary information.

Obtain the data via the operation panel of the device or with DIGSI 5.
Find the product code and the serial number as well on the nameplate on the device housing.
Operation Panel

[scdevinf-080413-01.tif, 1, en_US]

Figure 9-1
²
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Reading Device Information

With a device ready for operation, select Main menu → Test & Diagnosis → Device information →
Product code.
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DIGSI 5

[scgerdia-210311-01.tif, 1, en_US]

Figure 9-2
²

9.2.2

Reading the Device-Diagnosis Log

Read the device-diagnosis log of your SIPROTEC 5 device in DIGSI 5.

Measures for Error Correction
Limit work on the hardware to the necessary extent.

i

NOTE
Defective modules can be replaced only by experienced persons. Never open modules yourself.
The following software measures are possible:
• Initializing the system

•

i
9.2.3

If, for example, you would like to set a supervision function so that it becomes more insensitive since it is
responding sporadically in the operating state, change the parameterization.

NOTE
If these measures do not lead to the desired result, avoid further measures during operation.

Fallback Mode
If an error is detected in the device that cannot automatically be cleared (hardware components, software or
parameters), the device switches automatically into fallback mode. This can appear in system start or during
operation of the device. The fallback mode allows you a minimum procedure with error diagnosis and error
correction.
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i

NOTE
Ensure that the protection and control functions are deactivated in fallback mode.
Fallback mode is evident from the termination of the life contact, the Error LED, and the Fallback mode
header in the device display. In this mode the outputs of the device are brought to their initial state. Access to
the hardware is impossible. A limited operating menu is available for further actions.

Fallback Mode
You can select various information areas and have them displayed in the Fallback mode. The reason for the
fallback are shown in the lower part of the display as an indication (1 in Figure 9-3). When selecting the
softkey <More> on the right-hand side, a list of entries is displayed that was generated during the diagnosis of
the device (2 in Figure 9-3). Use the navigation keys to select the relevant entry or use the softkey <Details>
to open the currently selected entry. Precise information about the fallback will be displayed (3 in Figure 9-3).

[scfbmenudet-030914-01, 1, en_US]

Figure 9-3

Start Menu of Fallback Mode

The menu items are summarized and briefly presented below.
Fallback Mode Submenus
You can use the navigation keys to select the individual menu entries and branch them into the submenus.
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[scmbfb5ein-030914-01, 1, en_US]

Figure 9-4

Structure of the Fallback Submenu

•

Device information
The menu item Device information provides data about the SIPROTEC 5 device, for example, device
name, serial number, device type, and product key.

•

Hardware/software information
The HW/SW information menu item offers you additional information about the hardware and software
of the device (see Structure of the HW/SW Information Menu Item, Page 183).

•

Log
Information about the entries in the logs is available via the Logs menu item. This entry provides you
with all the information from the diagnostics, security and system start memory and you can display the
history.

•

Actions
By selecting the menu item Actions and clicking Restart Device, you can restart the device.

•

IP configuration
During operation or commissioning, the IP Configuration menu offers you system information, for
example the MAC or IP address of the device.

Structure of the HW/SW Information Menu Item
At this point, the submenu items HW/SW Informat. are explained in more detail.
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[schwswfb-020914-01, 3, en_US]

Figure 9-5
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Menu Items for HW/SW Information

•

Mainboard
This menu item informs you about the board type and the details concerning the version of the mainboard.

•

Communication
The menu item Communication displays information about the assignment of the communication ports
and their hardware information, for example, slot, version, and board type.

•

I/O modules
A list of the input/output modules being used can be found under the menu item I/O Modules. You can
select each individual printed circuit board assembly and, for example, have the slot or the terminal position displayed.
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•

Transformer modules
If using transformer modules, this menu item displays all available information about these modules (for
example, slot, board type or serial number)

Fatal Error, the Device Goes into the Fallback Mode
Certain fatal device errors lead to the device falling immediately into the fallback mode. Fatal device errors are
errors that cannot be resolved by a restart of the device. An indication displays the type of error. From this,
you can derive additional steps (for example, contacting the repair department). The device goes permanently
out of operation, a failure is avoided. In fallback mode, minimal operation of the device via the on-site operation panel and DIGSI 5 is possible. In this way you can still read information from the diagnostic log, for
example.
Life contact

is terminated in fallback mode

Red error LED

is activated in fallback mode

Group-Warning Indication
Pickup of the following supervisions with entry of the device into the fallback mode does not allow output of
normal supervision indications. The entry of the device into the fallback mode thus also does not lead to the
activation of the group warning indication.

9.2.4

Error Indicatons
If the SIPROTEC 5 device is outside a normal operating mode (for example, device in commissioning or simulation mode), this is shown by an indication. By default this indication is prerouted to LED 16 and makes the red
LED flash.
If you have exited one of the modes incorrectly (for example, by pulling out the DIGSI 5 PC), the red LED will
flash and after 4 hours the Device Ready indication will go.
This function is realized in the SIPROTEC 5 device via a predefined CFC chart. This means that you have the
ability to change this behavior in case of doubt. To do this, change or delete the CFC chart.

Overview of Errors
For each error indication on the on-site operation panel, a specific error code is issued additionally (see
Figure 9-3 (2)). This error code is helpful for further analysis by the repair service.
Diagnostic Log
Memory failure (recoverable): Reset initiated.
PCB link failure (non recoverable):
• Check the module configuration and interconnection.
• If the failure remains, contact the repair service.
Binary-output failure at module 1-12:
Contact the repair service.
Hardware failure at module 1-12:
Contact the repair service.
Wrong module 1-12 detected:
Synchronize the hardware configuration of the device and in DIGSI.
Wrong plug-in module detected at position E/F/M/N/P:
Synchronize the hardware configuration of the device and in DIGSI.
Hardware failure at measuring-transducer module plug-in position E/F/M/N/P:
Contact the repair service.
A faulty display configuration was detected.
Synchronize the hardware configuration of the device and in DIGSI.
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Diagnostic Log
Offset failure at a measuring input:
• Check for the affected module in the operational log.
• If the failure remains, contact the repair service.
A wrong display type was detected.
Contact the repair service.
CPU failure at base module:
Contact the repair service.
Communication-configuration failure:
• Reload the DIGSI device configuration.
• Update the device firmware or the DIGSI device configuration.
Port E/F/M/N/P: Communication module with incompatible firmware version detected.
Firmware update required.
Clock failure:
• Check time setting first.
• Change the battery if necessary.
• If the failure remains, contact the repair service.
A current terminal is missing.
Check your hardware and the connections!
FPGA hardware failure at the base module:
Contact the repair service.
The device is low on memory. Reduce the number of allocated functions, stages, and/or setting groups in the
configuration.
Configuration error:
The version of one or more functions is incompatible to the used firmware. Load a suitable DIGSI device
configuration.
Failed reading significant feature
Unknown significant feature
Failed reading bay type
Wrong hardware configuration:
Synchronize the hardware configuration of the device and in DIGSI.
Unknown bay type
Failed reading disconnector type
Unknown disconnector type
Maximum number of feeder bays exceeded
Maximum number of coupler bays exceeded
Maximum number of coupler bays with 1 CT exceeded
Maximum number of coupler bays with 2 CT exceeded
Maximum number of coupler bays without CT exceeded
Maximum number of bus section bays exceeded
Maximum number of bus zones exceeded
Maximum number of bus zones without measuring system exceeded
Maximum number of disconnectors exceeded
Maximum number of busbar disconnectors exceeded
Maximum number of line disconnectors to busbar exceeded
Maximum number of line disconnectors exceeded
Maximum number of transfer bus disconnectors exceeded
Maximum number of sectionalizing disconnectors exceeded
Maximum number of level 2 disconnectors exceeded
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Diagnostic Log
Maximum number of load breaking switches exceeded
Maximum number of bays exceeded
Auxiliary-power supply failure:
Check the external power supply.
Either 1 busbar disconnector or 1 line disconnector allowed
Maximum number of Busbar DC & Transferbus DC exceeded
Undefined bay type
Undefined disconnector type
At least one Feeder is necessary
Failure of device configuration:
Check the logs for reasons and upload valid configuration into device.
The voltage measured values indicate a failure.
There is no CFC logic available or a negative ID of measuring point is selected for Function block Voltage
measuring-point selection (1ph).
The voltage measured values indicate a failure.
There is no CFC logic available or a negative ID of measuring point is selected for Function block Voltage
measuring-point selection (3ph).
A non-existing voltage measuring point ID is selected for Function block Voltage measuring-point selection
(1ph). Please check your CFC logic.
A non-existing voltage measuring point ID is selected for Function block Voltage measuring-point selection
(3ph). Please check your CFC logic.
Failure in data structure:
Contact the repair service.
Firmware-version failure:
• Update the device firmware.
• If the failure remains, contact the repair service.
Bus link failure:
• Check the connection of the modules.
• Update the device firmware.
• If the failure remains, contact the repair service.
The IEC 61850 protocol could not be started up successfully. Too many protection functions might be configured leading to a memory leakage problem for protocol data. Protocol health set to alarm. Reduce the
amount of configured protection functions.
Error instantiating a GOOSE control block for subscription. Too many protection functions might be configured leading to a memory leakage problem for protocol data. Protocol health set to alarm. Reduce the
amount of configured protection functions.
Internal power supply failure:
Contact the repair service.
Module update failure:
• Check the module interconnection and carry out the update again.
• If the failure remains, contact the repair service.
Hardware failure:
Contact the repair service.
A failure could not be solved automatically:
• Check the previous entries of device-diagnosis log.
• If the failure remains, contact the repair service.
Signature failure:
Contact the repair service.
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Diagnostic Log
A failure occurred during the device startup:
Check the previous entries of device-diagnosis log.
If the failure remains, contact the repair service.

•
•

The device firmware could not be started:
• Carry out the update again.
• If the failure remains, contact the repair service.
Internal memory failure: .
• Stored data may be lost.
• Upload the firmware and the configuration again.
• If the failure remains, contact the repair service.
Data transfer time-out:
• Check the connections and repeat the upload.
• If the failure remains, contact the repair service.
Forced Fallback mode by local user.
Arc protection:
• The device hardware does not fit to the DIGSI configuration.
• Correct the configuration in DIGSI 5 and transfer a valid configuration to the device.
The maximum number of sampled measured value channels (SAV) is exceeded.
PQ Flicker does not support more than one Meas. point V-3ph. Route only one Meas. point V-3ph to function
group or remove PQ Flicker
PQ Flicker does not support the selected rated frequency. Use 50 Hz or 60 Hz.
PQ Flicker does not support selected connection type. Change the connection type of the voltage transformer.
Device-configuration failure:
The number of signals in a GOOSE dataset/application is too big. Reduce the number of signals in the related
dataset and upload a valid configuration.
Battery failure:
Change the battery.
Function-point violation:
No adequate number of function points. Upload a valid configuration or contact your local sales organization.
Measurement calibration failure:
Check the affected module in the operational log.
If the failure remains, contact the repair service.

•
•

CPU program-sequence failure:
If the failure remains, contact the repair service.
Time-synchronization masters failed:
• Check the external master clocks first.
• Check the external wiring.
• If the failure remains, contact the repair service.
CPU overload failure:
If the failure remains, contact the repair service.
CFC failure:
Check your CFC chart in DIGSI for reasons and reload the configuration.
PCB link failure (sporadic):
• Check the module configuration and interconnection.
• If the failure remains, contact the repair service.
The connection to the detached operation panel is disturbed. Check the connection.
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9.3

Replace Defective Device

9.3.1

Order and Install Replacement Device

9.3.1.1

Backup Device
If you cannot correct a defect reported by the device, you can replace this device with a backup device. The
base module is replaced if the error is in the base module. Expansion modules belonging to the device remain
in the backup device.
A backup device is available as a base module. The backup device has maximum functionality. If you replace
the defective base module, the backup device is configured with available project data from DIGSI.

i
9.3.1.2

NOTE
The device code of a backup device always consists of the letter E and the device code, for example, ESJxx.

Replacing Device

Removing the Defective Device

i

NOTE
You can add the wired terminal blocks of the defective device to the backup device.
If the device consists of a base module and expansion modules, then only the base module is replaced by a
backup module.
²

Shut down the device.

²

Remove all lines from the device.

²

Remove the device.

²

If needed, remove the defective base module from the expansion modules.

²

Pack the base module (see chapter 1.1 Unpacking, Repacking and Storing).

²

Return the device to the manufacturer.

Installing Backup Device
²

If needed, assemble the backup device with the expansion modules.

²

Mount the device (see chapter 3.1.2 Fitting Devices).

²

Place the device back in service (see chapter 7.3.1 Establishing Readiness for Operation State).
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9.4

Firmware and Parameter Set Update

9.4.1

General
You can use DIGSI 5 to update the firmware for your device. DIGSI 5 supports you in this process. No additional update tool is needed for this. After loading the firmware, you might need to upgrade a parameter set
and to initialize the device with it. When updating the firmware, use a connection with at least 1 Mbit/s.

9.4.2

Firmware Update
If you wish to use new functions or if the manufacturer provides an improved version of the firmware, a firmware update is necessary. You decide whether you execute the update on the basis of the release information
of the manufacturer for this firmware version. The files for the firmware update are digitally signed. This
prevents you from loading the device with any faulty files or firmware that is not suitable for the device.
If you have installed new communication modules in the SIPROTEC 5 device, check the firmware version of the
individual components. You can find up-to-date device drivers and communication protocols (*.DDD, DIGSI
Device Driver) in the Siemens download pool.
DIGSI 5 device drivers contain both the firmware and the configuration data. Both components are linked to
one another and both must be updated, if necessary.
Siemens recommends to perform the firmware update of the device on-site. If you would like to use the
remote control in order to start the firmware update, use a data line with a connection of at least 1 MBit/s.
• Load the drivers (DDD) required to update your SIPROTEC 5 device from the Siemens download pool:
http://www.siemens.com/siprotec

•
•

i

Click the link to the SIPROTEC 5 devices.
Follow the link Download Software & Documents to the SIPROTEC 5 device homepage.

NOTE
During updating of the firmware of communication modules or the device, the function of your SIPROTEC 5
device is deactivated.

Step 1

i

²

Select Product family, for example, SIPROTEC 5, in the download pool and then the device under
Product.

²

Under Downloads, select the entry Software and firmware.

²

Under Device driver, select the appropriate device driver.

²

Click the corresponding link of the driver to start the download.

²

Save the file(s) to any location on your DIGSI 5 PC (for example, C:\temp).

NOTE
Before you begin the update, take note of the following:
• Before doing a firmware update of your SIPROTEC 5 device or the communication modules, back up
the data and the parameter set of the device using DIGSI 5!

Step 2

190

²

Start DIGSI 5 on your PC.

²

Select the driver file saved earlier (device and protocol) in DIGSI 5 via the menu item Tools → Import
device drivers.
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²

Select the device driver (for example, in C:\temp).

²

In the open window, select the devices to be updated.

²

Click the Import button.

[scdddcom-220813-01, 1, en_US]

Figure 9-6

Selecting the Device Drivers

Once the procedure has run without errors, the following dialog appears:

[scsucddd-090413-01.tif, 1, en_US]

DIGSI 5 is restarted when you confirm by clicking the OK button.
Proceed as follows to complete the firmware update:
² Click the device in the project tree.
²

Open the context menu.

²

Select Load firmware to device.
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[scausfiw-220813-01, 1, en_US]

As an alternative, you can update the firmware for all the devices on the network at the same time.
² In the project tree, double-click Load firmware to devices.

[scmulaus-220813-01, 1, en_US]

192

SIPROTEC 5, Operation, Manual
C53000-G5040-C003-7, Edition 06.2016

Maintenance, On-the-Spot Assistance and Test
9.4 Firmware and Parameter Set Update

The following dialog allows you to select the devices to be updated and their firmware components.

[scfwupsd-090413-01.tif, 2, en_US]

Figure 9-7

Selecting Firmware Update

At this point, the different versions are displayed to you.
² Press the Update button.
²

Select the device or the communication module that must be updated.

²

In order to start the update, click Update device(s) in the top section.

After the data have been transferred successfully to the device, the firmware update starts automatically on
the SIPROTEC 5 device.

[scfwdvlo-220813-01, 1, en_US]

i

NOTE
The device does not perform any functions during the update.
In some cases, the update can take several minutes and may restart the device several times. Never switch
off the device during the update.
Following the firmware update of the device and the communication modules, all firmware components of
the device are updated:
² You will find more information on this under Structure of the HW/SW Information Menu Item, Page 183.
Special Features When Handling Protocols
The firmware of the communication modules consists of the base firmware and all available protocols. The
communication drivers depend on the device firmware and must be updated together with the firmware.
If a protocol is parameterized in DIGSI and the configuration is loaded into the device, the protocol firmware is
loaded automatically into the device, if necessary.
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9.4.3

Parameter-Set Upgrade
Following a successful firmware update of your SIPROTEC 5 device, you might also have to update the existing
device parameter set. Proceed as follows:

i

NOTE
Before you begin the update, take note of the following:
• Before updating the parameter set, use DIGSI 5 to backup your SIPROTEC 5 device!
²

Start DIGSI 5 on your PC.

²

Select the device in the project tree.

²

Right-click to open the context menu.

²

Select Upgrade the configuration version....

[scupgpar-220813-01, 2, en_US]

Figure 9-8
²
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Upgrading the Parameter Set

Select the desired device configuration and the matching communication configuration by selecting the
available version.
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[scupgcnf-220813-01, 1, en_US]

Figure 9-9
²

Version Selection

Click the Upgrade button to start updating.
DIGSI 5 starts updating.

[scaktolf-220813-01, 1, en_US]

Once the procedure has completed, the following dialog appears:

[scupginf-220813-01, 1, en_US]

Figure 9-10

Overview of the Upgrade

The 2nd tab provides information on possible errors and warnings.
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[scupgwrn-220813-01, 1, en_US]

Figure 9-11

Errors and Warnings From Updating

Finally, you must load the updated parameter set to the device. Proceed as follows:
² Select the device in the project tree.
²

Right-click to open the context menu .

²

Select the Load configuration to device entry.

[scupgpa2-130913-01, 2, en_US]

Figure 9-12
²

Transferring the Parameter Set

Enter the confirmation ID.

After the data have been transferred successfully, the device will restart.
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9.5

Test and Diagnostics

9.5.1

Establishing Test Mode

Safety Instructions

!

DANGER
Danger due to the execution of test functions
Noncompliance with safety instructions will result in death, serious physical injury, or considerable
material damage.
²

The execution of test functions requires a high degree of qualification and precise know-how of
system conditions.

Procedure
DIGSI 5 offers the possibility to start different test and diagnostic functions for a SIPROTEC 5 device in the
Online operating mode. In chapter 7.2.1 Test Functions you will find the description of the test functions that
the device and DIGSI 5 offer you.
Activate the test functions via the menu bar and via different functions that you reach via the list view of the
device.
² Open the device in the Online operating mode.
²

Open Test suite in the project tree.

[sctstsut-140211-01.tif, 1, en_US]

Figure 9-13

Test Suite

All subordinate test options appear in the data window. Select the desired test editor and start the test. If
configured, enter the confirmation ID. In some test functions the device switches to an operating mode that
first requires a system start of the device. Confirm this with DIGSI 5. The selected test function then becomes
available.
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i
9.5.2

NOTE
Depending on the device layout, not all test functions are always available. The execution of test functions
is protected by a confirmation ID.

Switching Test Mode On and Off

Procedure
If the test mode is switched on, indications transmitted via communication interfaces are labeled with an additional test bit, provided this is supported by the protocol. With this test bit you can determine whether an indication is generated in a test and all or individual functions of the device are in the test mode. In this manner
the reactions that are necessary in the normal mode due to an indication can be suppressed in other devices
that receive these indications.
• You can activate the test mode via a binary input. All functions in the device are hence in the test mode.

•

You can activate the test mode via a GOOSE indication from another device. This allows you, for example,
to bring several devices into the test state virtually simultaneously.

•

If you have activated a confirmation ID, this is queried by DIGSI 5 or the integrated control before start of
the test mode.

•
•
•

You can switch on the test mode via the integrated control.
You can activate the test mode via DIGSI 5. All functions go into the test mode.
You can bring selected functions into the test state. DIGSI 5 offers a test editor for this purpose.
The test editor shows you all protection functions in the device with the current states. The state of a
function is set systematically there to Test. An activated test mode is marked with a check mark in the
menu item.

[scsetsfk-160413-01.tif, 1, en_US]

Figure 9-14

9.5.3

Test Operation

Switching Block Monitoring Direction On and Off

Procedure
If block monitoring direction is switched on, no indications are output via the system interface(s) of a
SIPROTEC 5 device. Block monitoring direction can be switched on or off depending on the current state.
• Select block monitoring direction via the on-site operation panel.

•
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Enter the confirmation ID so that block monitoring direction can be activated.
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Figure 9-15

•
•

Block Monitoring Direction at the Device

Activate block monitoring direction via a binary input.
Activate block monitoring direction via DIGSI 5.
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[scmemspr-081015, 1, en_US]

Figure 9-16

Block Monitoring Direction via DIGSI 5

When switching block monitoring direction on or off, an indication is output in the left area of the status bar.
Bar segments inform you as well about the progress of the process.

i
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NOTE
The settings via the on-site operation, like the binary inputs, have no effect for the DNP3 protocol.
The >Block monitoring dir. signal is only provided for the IEC 60870-5-103 protocol.
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10.1

Security Design
Due to the increasing integration of bay units in Ethernet-based communication network, you must secure the
communication against internal failures and attacks from outside. The specifications published by the North
American Electric Reliability Council for critical infrastructure protection - NERC-CIP, for short - and the white
paper published by the German Association of Energy and Water Management (BDEW) contain requirements
for the safe operation of devices in critical communications infrastructure. These requirements are addressed
to manufacturers and operators.
Security must be incorporated into the design of devices right from the start. This is implemented consistently
in SIPROTEC 5. Measures in the hardware ensure the secure use of signed files. These are provided to protect
the firmware files and data records of the device. Secure storage of key material on the device makes secure
communication between DIGSI 5 and the device possible. The following items give you a high level of security
when integrating the SIPROTEC 5 device in the network:
• Protection against attacks from the network

•
•
•

Multi-stage safety concept in the operating state
Logging of authorized and unauthorized access
Logging of safety-critical actions

You can switch off unused Ethernet services. If, for example, the RSTP redundancy log is not being used, you
can switch it off using DIGSI 5. This gives a potential attacker no open interfaces and only utilized services are
activated in a network.

[scproest-230311-01.tif, 1, en_US]

Figure 10-1
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Switching off Unused Ethernet Protocols Using DIGSI 5
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10.2

Multi-Level Safety Concept
DIGSI 5 offers many useful functions for the configuration and testing of your SIPROTEC 5 devices. Constant
password prompts are not sensible during this phase. During operation, however, the focus is on the reading
of data. Reconfiguration and switching are safety-critical operations. These operations lead to failures in operation if they are carried out inadvertently or without authorization. After completion of commissioning, you
can activate a multi-level security concept in the device.
Before DIGSI 5 can communicate with the SIPROTEC 5 device via its Ethernet services, the device carries out
secure authentication. Only DIGSI 5 has the authorization for communication with the device. In addition, a
connection password that meets the strict rules of NERC-CIP can be configured. The password is securely
stored in the device. The password must contain upper case and lower case letters, digits and special characters and must be at least 8 to 24 characters long. It is queried before connection is established. A connection
to the SIPROTEC 5 device cannot be established until the correct password has been entered. You now have
read access.
All write-access rights to the SIPROTEC 5 device such as, for example, changing setting values or switching are
protected by other security prompts and confirmation IDs. If changes are done via the integrated operation,
these confirmation IDs are queried on the on-site operation panel. The confirmation ID contains only numbers
that must be entered at the on-site operation panel or in DIGSI 5.
The 3-level security concept consists of secure authentication, the connection password, and other confirmation IDs. This concept provides the highest possible degree of access protection during operation. Even remote
access to devices is protected. You can also use an Ethernet module exclusively for the communication with
DIGSI 5. Access by a substation control network with the unsecured IEC 61850 protocol and remote access
with DIGSI 5 are then carried out via completely separate networks. Even though the SIPROTEC 5 device
communicates with DIGSI 5 via an Ethernet module, communication between DIGSI 5 and the device is
encrypted using tap-proof technology.
Wrong password entries are identified and logged. An alarm can be triggered via remote link. Safety-critical
operations are also logged and cannot be deleted in the device. All files that can be loaded into the device
such as parameter files are signed and protected against falsification from outside. If files on the PC were
manipulated by malware (e.g. viruses), they cannot be loaded into the device.
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10.3

Security Settings
Enter the settings for each SIPROTEC 5 device by using DIGSI 5 only. The NERC-CIP-compliant connection password is not set by default. The confirmation ID for all sensitive device actions is set according to Table 8-8.
If you wish to create a security concept, you must change these values with DIGSI 5. Next, initialize the devices
with the new values. The connection password and confirmation IDs can only be set via DIGSI 5.
They can be initialized in the device via the following interfaces:
• USB interface

•
•

Mainboard (Port J)
Communication interface

The confirmation IDs then apply for on-site operation and for operation with DIGSI 5.
You can deactivate or reset the connection password at the on-site operation panel. You can change the
connection password with DIGSI 5 by entering the old connection password and then assigning a new password.
You can change the confirmation ID via the Ethernet network. Communication is encrypted and tamperresistant.
Proceed as follows for the security settings:
• Establish a direct connection from DIGSI 5 to the USB interface of the device.

•
•

i

204

Set and initialize the connection password.
Set and activate the confirmation ID in the device.

NOTE
If the battery of the device no longer functions or has been taken out, the connection password will be
deactivated after restarting the device. You can find more information in chapter 10.6 Using Connection
Passwords and Confirmation IDs.
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10.4

Conditions

10.4.1 Connection Password
The connection password is NERC-CIP-compliant. The password must contain lower case and upper case
letters, digits and special characters (for example, %, &, $, etc.). The connection password must be at least 8
characters long and may include a maximum of 24 characters. This rule is verified by DIGSI 5 during entry. The
connection password is not set by default. To enter a new password, the existing characters are concealed by
asterisks. You must enter the connection password twice to confirm. This confirmation prevents erroneous
entries. An empty text box is prevented. You can deactivate the query of the connection password in DIGSI 5
under Security in the Password for secure connection section by removing the check mark.

i

NOTE
Deactivation of the connection password means that a user has access to the device through DIGSI 5. If you
wish to hinder this, set the connection password in the device.

[scaktvor-210311-01.tif, 1, en_US]

Figure 10-2

Setting Window for the Connection Password and the Confirmation ID

After entering a new connection password, the password is automatically transferred to the device (an empty
text box will not be accepted). Initialization of the connection password is possible only via the front USB interface or via an Ethernet interface.
Further access to the device after connection is possible only if you have entered the connection password in
the DIGSI 5 dialog and communication with the device has been established. This procedure prevents unauthorized access. Siemens recommends that the connection password be checked after initialization.
A connection password is not copied from one device to another device. You must enter the password in
offline mode from DIGSI 5 for every individual device of a project.
You can change the connection password online via an Ethernet connection. After entering the previous password and entering and repeating the new password, the device accepts the change. This change is always
encrypted and tamper-resistant.

10.4.2 Confirmation ID
The confirmation ID consists of 6 digits, see Table 8-8. If DIGSI 5 is online with the device and you execute
safety-critical actions, the query also protects against undesirable actions during operation. Use only DIGSI 5 to
set the confirmation IDs. After initialization of the confirmation ID with DIGSI 5, the query is saved in the
device.
Change the confirmation ID as follows.
• Double-click the Security menu item in the project tree.

•

Click the Change button in the action column (see Figure 10-2).
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•
•

Enter the confirmation ID twice.
Confirm the process with OK or cancel it.

All entries are hidden by asterisks.

[scbstcod-210311-01.tif, 1, en_US]

Figure 10-3

Changing Confirmation ID with DIGSI 5

10.4.3 Confirmation ID for Local/Remote Switching Authority
Set the confirmation ID for the switching authority with DIGSI 5. During operation there is no dialog in DIGSI 5
for this setting. You can change the local or remote switching authority only via the on-site operation panel.
To change the switching authority, use DIGSI 5 to enter the confirmation ID that you have to enter at the onsite operation panel.
Enter the setting with the code (local or remote position) for devices with a key switch. There is no query at
the on-site operation panel for devices with a key switch. For devices without a key switch, set the local or
remote position status in the device using a parameter. Changing this parameter requires the entry of the
confirmation ID. If the local position has been set, you cannot execute any switching operations via a substation control protocol or with DIGSI 5.

10.4.4 Confirmation ID for Non-Interlocked Switching (Interlocking Off)

i

NOTE
This is a very critical operation.
Enter the setting of the confirmation ID with DIGSI 5. For devices with key switch non-interlocked switching is
possible through the Interlocking Off position. If no key switch is present, there is a confirmation ID in the onsite operation panel or in DIGSI 5 before non-interlocked switching is possible. If you have entered the correct
confirmation ID, non-interlocked switching is possible.

10.4.5 Confirmation ID for Unsynchronized Switching
Enter the setting of the confirmation ID with DIGSI 5. If the device has a synchro-check function, then
querying of the confirmation ID is available. During operation unsynchronized switching is possible only if you
enter the confirmation ID through the on-site operation panel or with DIGSI 5.

10.4.6 Confirmation ID for Switching Authorization with DIGSI 5
Execute normal switching operations with the on-site operation panel (key switches and push-buttons on the
on-site operation panel) or with a control-center system with teletransmission. During device testing (commissioning) you can also execute switching with DIGSI 5, for example, to test interlocking conditions. The requirement is that you set switching authorization with the key switch to teletransmission or on the on-site operation panel to remote. Before unlocked or interlocked switching is possible with DIGSI 5, check the confirmation ID. DIGSI 5 then has the approval to execute a test of switching operation.
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10.4.7 Confirmation ID for Other Safety-Critical Actions
Enter the setting of the confirmation ID with DIGSI 5. You need this confirmation ID for the following steps:
• Changing setting

•
•
•

Executing tests (apart from switching operation, for which there are other confirmation IDs)
Resetting meters
Executing other safety-critical operations that carry out a write access to the device, for example, deleting
of fault records and logs.
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10.5

Authentication, Connection Password, and Confirmation ID During
Operation
The 1st sequence between DIGSI 5 and the device is an authentication procedure in which secure codes are
exchanged between DIGSI 5 and the device. This procedure ensures that only DIGSI 5 can have technical
access to a SIPROTEC 5 device. If other applications wish to gain access without authorization, they are
blocked. If a protocol such as IEC 61850 is sent via the same Ethernet interface, this protocol is not blocked
and the specific security settings of the protocol are relevant.
If you access the 1st device online, the connection password is queried by the SIPROTEC 5 device, provided
that you have set the password within the device. Correct entries in DIGSI 5 allow you read access to the
device. Wrong entries are recorded in the security log of the device and a warning can be issued through a
contact. If you make 3 wrong entries, access to the device is blocked for several minutes. You must acknowledge other safety-relevant operations by entering the specific confirmation ID. These operations are recorded
in the device as well.
For 30 minutes a session manager in DIGSI 5 monitors all passwords and entries relevant for the identification.
If, for example, the following actions take place within this time, you need not reenter the connection password or the confirmation ID.
• If you switch another device online.

•

If you carry out the same safety-relevant operations for the same or another device.

The session manager prevents unnecessary entries with one or more devices during an online session. If you
isolate the devices from DIGSI 5, the session manager is deleted. A connection password or a confirmation ID
is not saved on the DIGSI PC.
If you trigger safety operations with the on-site operation panel (keyboard, key switch), the same confirmation
IDs as in DIGSI 5 are used for the same activities. Enter the confirmation ID via the device keypad of the on-site
operation panel. There is no connection password for the on-site operation panel.
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10.6

Using Connection Passwords and Confirmation IDs
Siemens recommends that the connection password and confirmation ID be kept close. This is organized in
the corresponding department of the power utility. You can assign different confirmation IDs to different user
roles for switching operations and other safety-relevant operations. Only authorized persons may have access
to this data.
The reset procedure exists for the rare case that you forgot the connection password. If the connection password query in your protection device has been activated, this means that you cannot establish a connection to
your SIPROTEC 5 device without entering the password. If the confirmation ID is also not present, you cannot
gain any write access to the device with DIGSI 5 or the on-site operation panel.

Resetting the Connection Password

i

²

Switch to the Device functions menu in the main menu of the device.

²

Select the Security → Password recovery menu item.

²

Confirm resetting of the password with the Ok softkey or cancel the operation with Esc.

²

Enter the confirmation ID 222222 and confirm it by pressing Enter.

²

Next, enter the following keyboard shortcut as recovery code:
<1>, <2>, <3>, <4>, <5>, <6>, <FN>+<1>, <FN>+<2>, <FN>+<3>, <FN>+<4>, <FN>+<5> and <FN>+<6>

NOTE
Always press the function key and digit simultaneously.
Please note that the time-out between key operations is 1 s.
If the device is in fallback mode or if it is a device without a display, proceed as follows:
² Isolate the device from the auxiliary voltage.
²

Remove the battery from the device.

²

Wait for about 2 minutes.

²

Insert the battery into the device.

²

Reconnect the device to the power supply.

The connection password is reset.
Proceed as follows if you want to deactivate the connection password on the device:
² Switch to the Device functions menu in the main menu of the device.

i

²

Select the Security → Password switch menu item.

²

Enter the confirmation ID 222222.

²

Deactivate the connection password.

NOTE
If the battery of the device no longer functions or has been taken out, the connection password will be
deactivated after restarting the device.
Using DIGSI 5 reset the confirmation ID for the offline configuration of the device as well (see 10.4.2 Confirmation ID).
² For this purpose, use the DIGSI 5 dialog Have you forgotten one of the confirmation IDs or the
connection password?
The device must now be initialized with the project data that was saved with DIGSI 5 for this device.
Because the connection password was deleted and the confirmation ID reset, the project data for this device
can be transferred easily.
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²

Repeat this procedure for all devices.

²

After the reset, set the connection password and the confirmation ID for the devices manually.

²

Initialize the connection password and the confirmation ID via the front USB interface, the mainboard
(Port J) or the communication module.
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Glossary
CB
Circuit breaker
Chatter Blocking
A rapidly intermittent input (for example, owing to a relay contact fault) is disconnected after a parameterizable monitoring time and therefore cannot generate any more signal changes. The function prevents the
system from overloading in the event of an error.
Continuous Function Chart
The Continuous Function Chart (CFC) is a programming language. It is used for programmable logic controllers. The programming language Continuous Function Chart is not defined in the standard IEC 61131-3, but
represents a current extension of IEC programming environments. CFC is a graphic programming language.
Function blocks are linked to one another. This represents an essential difference from conventional programming languages, where sequences of commands are entered.
Control display
The control display becomes visible for devices with a large display after pressing the Control key. The diagram
contains the switching devices to be controlled in the feeder. The control display serves for implementing
switching operations. Specification of this diagram forms part of configuring.
Data window
The right area of the project window visualizes the content of the area selected in the navigation window. The
data window contains for example, indications or measured values of the information lists or the function
selection for parameterization of the device.
DIGSI
Configuration software for SIPROTEC
Double Command
Double commands (DPC – Double Point Control) are process outputs which visualize 4 process states at 2
outputs: 2 defined states (for example, On/Off) and 2 undefined states (for example, disturbed positions).
DPC
IEC 61850 data type: Double Point Control
Drag and drop
Copying, moving, and linking function, used in graphic user interfaces. The mouse is used to highlight and
hold objects and then move them from one data area to another.
Folder
This object type helps when structuring a project hierarchically.
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Function group
Functions are brought together into function groups (FG). The assignment of functions to current and/or
voltage transformers (assignment of functions to measuring points), the information exchange between the
function groups via interfaces as well as the generation of group indications are important for this bringing
together.
General interrogation
The state of all process inputs, of the status, and of the error image are scanned on system startup. This information is used to update the system-side process image. Likewise, the current process state can be interrogated after data loss with a general interrogation (GA).
Generic Object-Oriented Substation Event
GOOSE. Protocol of IEC 61850 for communication between bay units.
GOOSE
Generic Object-Oriented Substation Event
Ground
The conductive ground whose electric potential can be set equal to 0 at every point. In the area of grounding
conductors, the ground can have a potential diverging from 0. The term reference ground is also used for
this situation.
Grounding
The grounding is the entirety of all means and measuring for grounding.
IEC
International Electrotechnical Commission
IP
Internet protocol
List view
The right area of the project window displays the names and symbols of the objects which are within a
container selected in the tree view. As the visualization is in the form of a list, this area is also referred to as list
view.
Metered value
Metered values are a processing function, used to determine the total number of discrete similar events
(counting pulses), for example, as integral over a time span. In the power supply utility field, electrical energy
is often recorded as a metered value (energy import/delivery, energy transport).
Navigation Window
Left area of the project window, which visualizes the names and symbols of all containers of a project in the
form of a hierarchical tree structure.
Object
Each element of a project structure is designated as an object in DIGSI 5.
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Offline
If there is no communication connection between a PC program (for example, configuration program) and a
runtime application (for example, a PC application), the PC program is offline. The PC program executes in
Offline mode.
Online
If there is a communication connection between a PC program (for example, configuration program) and a
runtime application (for example, a PC application), the PC program is online. The PC program executes in
Online mode.
Parameterization
Comprehensive term for all setting work on the device. You can parameterize the protection functions with
DIGSI 5 or sometimes also directly on the device.
Parameter set
The parameter set is the entirety of all parameters that can be set for a SIPROTEC device.
PLC
Programmable Logic Controller
Project
In terms of content, a project is the replication of a real energy supply system. In graphic terms, a project is
represented as a number of objects which are incorporated in a hierarchical structure. Physically, a project
consists of a series of directories and files containing project data.
Protection Device
A protection device detects erroneous states in distribution networks, taking into account various criteria, such
as error distance, error direction or fault direction, triggering a disconnection of the defective network section.
RSTP
Rapid Spanning Tree Protocol
SCD
See Substation Configuration Description
Single Command
Single commands (SPC - Single Point Control) are process outputs which visualize 2 process states (for
example, On/Off) at an output.
SIPROTEC 5 device
This object type represents a real SIPROTEC device with all the contained setting values and process data.
SIPROTEC
The registered trademark SIPROTEC designates the product family of protection devices and fault recorders.
SPC
IEC 61850 data type: Single Point Control
SPS
IEC 61850 data type: Single point status
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TCP
Transmission Control Protocol
Time stamp
A time stamp is a value in a defined format. The time stamp assigns a time point to an event, for example, in a
log file. Time stamps ensure that events can be found again.
UTC
Universal Time Coordinated
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D
Data transfer 79
Date and Time 154
Device diagnosis 91
Device Identification via the DIGSI 5 Project Tree 109
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Device mode 66
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DIGSI 5 operating software 74
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E
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Establishing a connection via
Ethernet 79
USB 79
Establishing connection to selected devices 109

F
Fallback Mode 181
Fault Definition 147
Fault log 121
Fault Recording 147
Fault records
Displaying 148
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Maintenance 178
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Menu dialogs 65
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O
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Offline Operation 110
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User-Defined Metered Values
resetting 144
setting 144
Using project 94

S
Safety concept 203
Secondary Tests 97
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Simulation mode 66
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